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Basics

Discontinuation of Windows 7 ®
Microsoft will cease the support for Windows by January 2020. Due to compability matters HiCAD 2020
SP2 and HELiOS 2020 SP2 will thus be the final versions of our CAD and PDM systems which support
Windows ® 7. The corresponding server operating systems (Windows Server 2008 R2 or older) will then
no longer be supported either.

Discontinuation of “old“ HiCAD itemisation
As of HiCAD 2019 the “old” itemisation, i.e. the itemisation that was used up to HiCAD 2017, will only be
available for model drawings that were already itemized with these functions. From HiCAD 2020
onwards, only the “new” itemization will be supported. The itemisation by assemblies (the Within
assembly, ... options in the old Itemisation dialogue) will only be supported by the new Standard Itemisa-
tion as of HiCAD 2019 SP2.

Service Pack 2 2019 (V 2402)

Improved performance
n Switch Drawing/AutoSave

Switching between large drawings with HCMmodels via Switch Drawing docking window has been significantly
improved with HiCAD 2019 SP2. This also applies to the AutoSave function.

In test cases, the following performance optimisations (duration in seconds) could be achieved for switching
the drawing to an empty one:

HiCAD 2302 HiCAD 2402

Example drawing with 4,800 parts 10 5

Parametric drawing with 3,400 parts 16 1

Which performance increase is ultimately achieved depends on the respective drawing.

n Waiting time when rotate view
The waiting time after rotating a shaded view could be reduced with SP2. In various tests, an increase in per-
formance of approx. 25% was achieved.

n Activating parts
The activation of parts in very large constructions has been accelerated.

n Drawings with many texts
Constructions usually also include many texts. These can be " regular" texts, dimensions, annotations and
BOMs. With SP2, zooming andmoving in constructions with many texts has been significantly accelerated, by
a factor of 4-20 depending on the construction, so that editing here is muchmore fluid.

n Sectional views
In drawings with more than 25,000 parts, sectional views are updatedmuch faster as of SP2, up to a factor of 3.

n Referencing assemblies
The performance when referencing assemblies has been increased by internal optimizations.

News Overview
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n Breaking up Referencing of parts/assemblies
The break up referencing of parts and assemblies function has been improved. In the test, performance
increases between factor 2 and 4 were measured, depending on the assembly.

n ICN Update
The update of the ICN representations in case of drawings modifications has been accelerated by internal
optimizations.

n Inserting referenced assemblies via Clipboard
The waiting time when inserting referenced assemblies via the clipboard has been reduced with SP2 - espe-
cially in large drawings. In test examples, an increase of acceleration by a factor of 60 was achieved.

Docking window panoramas
The Visual Effects docking window has been renamed to Panoramas.

ICN enhancements

ICN - Representation of user columns

From HiCAD 2019 SP2 the ICN representation of up to three user columns is supported for the 3-D part structure.
The representation can be switched on/off by activating/deactivating the checkbox.

The attributes displayed in the three user columns can be configured individually. The user columns are defined in
the HDB files ICN3D_USERn.HDB (for use without HELiOS) or ICN3D_USERn_DB.HDB (for use with HELiOS). n
is the number of the user column. The files are located in the HiCAD sys directory.
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The following user columns are predefined by ISD:

User
column

Attribute
File without
HELiOS

File with HELiOS

1. %06 Total num-
ber

ICN3D_
USER1.HDB

ICN3D_USER1_DB.HDB

2. §01 Weight ICN3D_
USER2.HDB

ICN3D_USER2_DB.HDB

3. $02 Designation
2

ICN3D_
USER3.HDB

ICN3D_USER3_DB.HDB

For instance, the number of the shipping item, that is, the item number of the uncut installation profiles (attribute
%PI), plays an important role in installation planning. However, the item number (attribute %02) is important for
substructures. By defining corresponding user columns, you can display both item numbers in different columns.

To change the default setting of a user column, click on the corresponding HDB file, e.g. the file ICN3D_USER1_
DB.HDB for the first user column:

The row highlighted in red defines the contents of the first user column. The ISD default setting is the attribute %06,
i.e. the total number. You can also enter the line more than once and mark the other lines as comments by placing
the character # at the beginning of the line. In the file shown above, this is already applied for the attribute %PI, i.e.
for the number of the shipping item. For example, you could delete the comment character in the %PI line and
place it before the %06 line instead. The shipping item number would then be displayed in the ICN in the first user
column.

See also HDX and HDB Files and Overview of HiCAD Attributes

When saving HDB files, please make sure that ANSI is selected as character encoding.
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ICN - Marking of invalid item numbers

In the Settings of the 3-D ICN you can define how invalid, i.e. not current, item numbers are to be marked:

n with an asterisk * or

n by a colour representation.
Select the desired colour in the list box. You can also change the font styles and variants by activating the but-
tons below. The fonts and variants boldface, italics und strikethrough are available as well as combinations of
these.

Please note that item numbers with no current status are only marked accordingly the parameter Set change mark
when changing parts is active in the Configuration Management under Compatibility > Itemisation up to HiCAD
2017 > Updating.
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ICN - Tooltip with 3-D part structure

If you point to a part symbol in the 3-D part structure of the ICN with the cursor, now a tooltip with the corresponding
superordinate structure is displayed. This can be especially helpful in large drawings with many parts.

ICN - Double click

The Part attributes dialogue window can be opened now by double-clicking on a part name with the left mouse but-
ton.
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Settings for surface approximation

With the Surface Approximation you define the number and determination of polygon points for 3-D quad-
rants. This setting is used, for example, when approximating polyhedra and shading 3-D models.

As of SP2, the ISD default settings in Configuration Management under Modeling > Part creation > Polyhedron
approximation have been changed as follows:

The settings shown above are also used in the Configuration Templates (CSV files) for mechanical engineering and
plant engineering included in the scope of delivery of HiCAD, which are loaded via the Parameter Configuration.
The steel/metal configuration template uses 4 division points per quadrant.

Settings for dimensioning

Bores/Boltings

In the Settings for Conventional Dimensioning for drawing derivation with regard to Bores/Boltings, the ISD
default setting for Multiple display of successive, identical dimension chains if distance greater thanhas been
changed from 30 to 1500. This has led to better results in practice.

The customer settings are preserved during update installations. If you want to use the new value as the
default setting, you must change the file STAB3DPAR.DAT accordingly or - if available - the file STW_
DIMSETTINGS.XML (parameter SUMUPEQUALDIST). Both files are located in the HiCAD sys directory.

22 / 386 What's new?

Basics



General - Hidden parts and processings

In the settings for "conventional" dimensioning, as of SP 2 it is possible to specify whether hidden parts and pro-
cessings should be ignored. The setting predefined by ISD is no . This corresponds in the file STW_
DIMSETTINGS.XML to the line </PARAM><PARAM Name="IGNOREHIDDENSUBPARTANDBORES" Typ="INT"
Value="0"> or in the file STAB3DPAR.DAT (new customers) to the entry ignore base points on invisible parts and
bores? 1:yes, 0:no

Please note that for drawing derivation this setting is only taken into account if the option Load drawing para-
meters from configuration is active.
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Drawing derivation

Drawing Derivation - Settings for shortened Views

In the Settings for Views window the texts for shortenings in drawing derivation have been improved.

Previously From HiCAD 2019 SP2 onwards

Show views of beams as shortened views Beams as single part without sub-parts

Show views of development as shortened views Developments

Show other views as shortened views Other parts and assemblies

The corresponding texts in the configuration management (Automatic drawing derivation > Production drawing >
Usage-dependent > ... > Views > Shortened view) have beenmodified analogously.
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Drawing derivation - Changed configuration for Steel Engineering

The HiCAD parameter configuration for steel/metal engineering has been changed. The objective was to make
workshop drawings in steel engineering easier to understand. For more information, see Steel Engineering - What's
New.
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Drawing derivation - Dimensioning rules

In the Dimensioning Settings, the Direction determined by 2 points option has been renamed to Determined by
base points in the Direction of dimension chain selection box.
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Drawing derivation - Dimensioning of sheets in sectional views

For dimensioning the flange length of sheets in sectional views, the following base point is being dimensioned:

n at an initial angle > or equal to 90°, the theoretical intersection of the flanges; and

n at an angle > 90° the tangential point at the edge of the bending zone.

The following graphic shows an example. The flange (1) was attached with an angle of 135°, the flange (2) with an
angle of 85°. In the sectional view, the tangential point is dimensioned for flange (1) and the theoretical intersection
point is dimensioned as the base point for tab (2).
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Drawing derivation - Improved placing of the annotation of standard processings

So far, the automatic placing of annotation for standard processings, e.g. threads, has often resulted in the leader
line running unnecessarily across the hole bore pattern. This behaviour has been changed with HiCAD 2019 SP2.
Now, the leader lines of standard processings always go to the nearest standard processing. In addition, the annota-
tions can now also be placed on the part and not just outside as before. This applies to both production and mount-
ing drawings. The settings are made via ConfigurationManagement. There you can find via

n Automatic drawing derivation > Production drawing > Annotations > Placing of annotation or

n Automatic drawing derivation > Mounting drawing > Annotations > Placing of annotation

the parameter Standard processing on part.

If the checkbox is active, the annotations of standard processings are located directly aside the processing - i.e. on
the part - if there is enough space. If there is not enough space, the annotation is placed further away.

If the checkbox is inactive, the annotations are - as before - placed outside the part. The leader lines now always go
to the nearest standard processing.

An example:

1. Placing of annotations in HiCAD 2019 SP1
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2. Placing of annotations as of HiCAD 2019 SP2 - Standard Processing on part: no

3. Placing of annotations as of HiCAD 2019 SP2 - Standard Processing on part: yes
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Mounting drawing

Overall drawing for sub-structures of element installation

The Automatic drawing derivation function supports creating usage-dependent production drawings. Thus, indi-
vidual dimensioning rules can be specified for different usages, such as girders, columns, certain beams, railings
etc.By contrast, the creation of mounting drawings is being independent of the usage for parts and assemblies.
Only the selected box is taken into account. In most cases this option is sufficient - the essential parts can be annot-
ated automatically and grids can be dimensioned automatically as well.

However, in order to enable overall drawings with automatic creation of relevant dimensions for substructures of
the element installation, dimensioning rule sets can also be defined in the Configuration management for mounting
drawings - albeit to a very limited extent.

Hence, only three IDs are available:

n No dimension (in most cases this is the recommended default setting)

n 2003: Profile sub-parts of an assembly without main part (recommended for sub-structures)

n 2004: Sub-parts of an assembly via named isolated point (recommended for wall consoles of sub-structures)

These dimensioning rule sets can be used to define what is dimensioned and how (dimension type, position, ref-
erence, etc.) and in which view.
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The following settings are recommended for sub-structures:

Dimensioning rule 1
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Dimensioning rule 2
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Dimensioning rule 3

Tip for sub-structures/consoles:

When configuring the assemblies with wall consoles, you have the option to define a dimensioning-rel-
evant point on the console assembly yourself. This point will be considered as decisive point (ID 2004).

This decisive point must be a designated point, e.g. with the name !.

Please also take note of the hints in the area of Sub-structure.
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An example:

The illustration shows a substructure with wall brackets (and dimensioning-relevant relevant point)
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If the mounting drawing is created with the settings listed above, the following example may result:

Settings for Sheet Metal Processing (ABWPAR.DAT / ABWCOL.DAT)
The basic settings for sheet metal processing, which were previously defined in the ABWPARDAT and
ABWCOL.DAT file, can now be set in configuration management. For detailed information, see Configuration Man-
agement - What's New.
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Itemisation

Itemisation by assemblies

As of SP2, HiCAD supports itemisation by assemblies with its new standard itemisation. For this, the tab General
has been enhanced accordingly. Under Mode, you can now select whether the itemisation is to be continuous for
the entire design or continuous within an assembly.

Example

In the following illustration, the factory settings have been used for the steel engineering.
(1) Without item numbers, (2) Itemised in the mode By assemblies, (3) Itemised in the mode Construction method

Consideration of processing direction of steel plates

As of HiCAD 2019 SP1, the Processing direction can also be selected as a distinguishing criterion for the search of
identical parts. Previously, this option was only available for sheet metal plates. From SP2 onwards, steel plates are
now supported as well.
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Setting time at which the item text is to be updated

Previously, item texts were updated after each modification to drawings. In large drawings, this can lead to per-
formance loss, especially if attributes from superordinate assemblies are used in item texts. For this reason, the
new parameter Update item text is from SP2 onwards available under System settings > Itemisationto set the time
for updating item texts.

n After each change (as predefined by ISD) or

n After itemisation.

Please note, however, that the setting After itemisationhas the disadvantage that it is not possible to recognize
whether an item text is invalid.

Information - Distance between two 3-D points
The previous functions

Information, Direct distance 2 points (3-D)

Information, X-distance 2 points (3-D)

Information, Y-distance 2 points (3-D)

Information, Z-distance 2 points (3-D)

Information, XYZ-distance 2 points (3-D)

have been combined to one function Information, distance 2 points (3D). The PullDown menu is therefore no
longer used from SP2 onwards.
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New icons for HiCAD file formats
From SP2 onwards, new icons are available for different HiCAD file formats, such as SZA, FGA, KRA, VAA, PAA.
These icons are taken into account in Windows Explorer and thus also in HELiOS result lists.

File format File type

.SZA HiCAD drawing

.KRA HiCAD 3-D part

.FGA HiCAD 2-D part

.VAD HiCAD variant of previous versions

.VAA HiCAD variant

.PAA HiCAD part archive

.RPA HiCAD P+ID scheme

.FIA HICAD P+ID module

What's new? 39 / 386

News Overview



New support request

The function New support request is now available in Help Topics and Information

Use this function to send a support request directly from HiCAD to our Support. After calling the function, simply log
in with your access data for my-ISD. Afterwards you will automatically enter the ISD support portal. Simply fill out
the form, attach files if applicable and then click on Create request.

The new ISD support portal will be available for customers in Germany from 1 October 2019. For
customers in other countries, the launch is scheduled for January 2020.
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Service Pack 1 2019 (V 2401)

Improved performance
n Visualisation of Bitmaps

As of SP1 Bitmaps in HiCAD drawings (for example logos in title blocks) are to be drawn in OpenGL for rep-
resentation on screen. Thus, the performance is improved particularly for large bitmaps. An improvement by
means of factor 60 could be targeted by testing with an example drawing.

n Switch drawing
By optimising intern routines as pitch of threads for polyhedral models and catalogue queries for thread textures
amongst others, the switch drawing could be accelerated.

n Rotating views
With HiCAD 2018 SP2 rotating shaded views had been accelerated significantly, for shaded views with edges in
particular. As of HiCAD 2019 SP1 the performance has again been considerably improved. (See also 3D -
What's new?)

n Multiple selection
These calculations have also been significantly accelerated by optimizing internal routines.

n Update referenced parts
From SP2 onwards, sketches with many thousands of lines can be editedmore quickly, even if HCM is not com-
pletely switched off. (see also Parametrics - What's new?)

n Accelerated graphic preview
From HiCAD 2019 SP1, the graphic preview in the ICN is always drawn via OpenGL. The OpenGL mode is used,
which most closely corresponds to the current view mode. This leads to a significant acceleration of the pre-
view.

Licensing
n Bothmodules Profile Installation and Element Installation are now also part of the Trial Edition as well as

HiCAD Trainee Suite.

n HiCAD ALUCOBOND Suite exclusive Standard and HiCAD ALUCOBOND Suite exclusive Premium are no
longer available. As of now, there are only two ALUCOBOND Suites, namely HiCAD ALUCOBOND Suite Stand-
ard and HiCAD ALUCOBOND Suite Premium.

Maximum number of layers
So far, the amount of possible layers could be set via configuration management System settings > 2-D lines with
the parameter Maximum number of layers. From Service Pack 1 onwards, this setting is not available. The amount
of possible layers has been set to 1000 (layer 0 to 999).

New display of 2-D Part structure in ICN
Like the 3D-Part structure tab in the ICN, the 2D-Part structure tab has had a redesign:

n Improved performance, notably with complex drawings

n Tabular, multicolumn representation

n Sorting by click on the column header

n Individual configuration of the representation

n Fast switching of the representation of HiCAD and HELiOS attributes
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In connection with the new representation of the 2-D Part structure, system files have been renamed as follows:

Up to HiCAD 2019 As of HiCAD 2019 SP1

BRW_2DTEILATT.HDB ICN2D_MULTIATTRVIEW.HDB

BRW_2DDBATTR.hdb ICN2D_MULTIATTRVIEW_DB.HDB

Saving/Loading to or from cloud directories
If available, cloud directories such as Microsoft OneDrive or Dropbox are displayed when loading or saving drawings
via HiCAD Explorer. These can be found in your user folder.

Display of installed Hotfixes in HiCAD Info window
In HiCAD Info window, numbers of installed Hotfixes are being displayed in addition to the current HiCAD version

number (including build number). To show the Info window, open Help Topics and Information and select
HiCAD.
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Drawing derivation - Shortened view of development
Views of developments of Sheet Metal can be created shortened as from now. The Settings for views window has
been enhanced accordingly.

The pre-settings can be defined for each intended purpose under ..> Automatic drawing derivation > Production
drawing > Usage-dependent > NAME > Views > Shortened view, with the name being the name for the respect-
ive intended purpose.

Drawing derivation - Dimensioning of the position of Sheet Metal
So far, only the position of Steel Engineering plates and beams has been dimensioned (as sub-parts). In practice,
simple Sheet Metal plates consisting of one flange are in use instead of Steel Engineering plates. As of HiCAD 2019
SP1 also Sheet Metal plates are dimensioned automatically as attached parts of a welded assembly.
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Drawing derivation - Dimensioning of Agrafes
If the construction contains sheets with agrafes, e.g. suspended ALUCOBOND® tray panels, the position of the
agrafes in derived drawings is only dimensioned if the checkbox Processings is active in the settings for sheet devel-
opment. However, agrafes are only dimensioned if the checkbox Planar representation for mouldingsis NOT
selected under Extended settings > Extended representation.

Start and end point of the agrafe are taken into consideration in dimensioning the outer contour.
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Drawing derivation - Usage-dependent configuration templates
The dialogue window Load usage-dependent configuration has been revised.

n On the left gap are the names of the available Configuration templates from the Configurationmanagement (in
Configurationmanagement under Automatic drawing derivation > Production drawing > Usage-dependent).

n The middle column shows the usage type from which the configuration template is used.

n The right gap shows for which usage type the Configuration template is used.

The selection can be filtered using the search field at the top right of the dialogue window. Filtering can be can-
celled by clicking on the delete icon.

The change affects the functions:

Drawing derivation and

Rules for automatic dimensioning in derived drawings for dimension type "dimensioning rules"
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Itemisation - Consideration of Processing Direction
For the Itemisation a further distinctive criterion, the Processing Direction, can be chosen for Identical Part Search.

n Only direction symbols on top facet of flanges are being considered.

n Relevant to the comparison of Processing Directions are only your (processed) directions and RTYP entered in
the catalogue (1: one-sided, 2: two-sided).

n Irrelevant to the comparison are thus the position of direction symbols (on which flange, where on the flange)
and its geometry in particular.

An example:

The image depicts three geometrically alike sheets with Processing Direction. For Sheet 1 and Sheet 3 Direction
symbol one-sided 40 mm was chosen, for Sheet 2 Direction symbol two-sided 50 mm was chosen. If the check-
box Processing Direction is unticked during Itemisation, all Sheets are assigned to the same Item number. If the
checkbox is ticked (despite different position of symbols on the flange), only Sheet 1 and 2 are assigned to the
same Item number. Sheet 3 is assigned to a different Item number because the Processing Direction is opposing.
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Itemisation - BOM-relevance of itemised parts
Previously, when the BOM relevance of a part was removed, the corresponding item data (item number, item text,
and so on) was deleted. The item number of the part was then set to 0. As of HiCAD 2019 SP1, this behavior has
been changed. If the BOM relevance of a part is removed, the item number is not removed, but only marked as
invalid. However, the other item data, such as the item text, is not retained. Invalid item numbers are represented
crossed out in the ICN.

If the BOM relevance is assigned to the part again later, the "old" item number is restored during automatic Itemisa-
tion, provided that the checkbox Preserve existing numbers where possible is active in the Itemisation settings.
However, the current settings are used for the item text and not those that were active when the BOM relevance
was canceled.

Use case:

In practice, it sometimes happens that parts lists are only created for a certain quantity of parts. To do this, you can
remove the BOM relevance of the unwanted parts, create the BOM and then reassign the BOM relevance. Then
start the automatic positioning again (with active checkbox Preserve existing numbers where possible).

Example:

(1) Original model drawing, (2) Remove the BOM relevance for the parts with item numbers 13 and 3. The item num-
bers 13 and 3 are therefore invalid. (3) BOM relevance is set again. (4) The new positioning restores the invalid pos-
ition numbers.
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Design Checker - new check for ALUCOBOND Sheets
An additional check is available for Sheet Metal in the Design Checker. The new check Sheet dimensions defined
by semi- fin. prod. (developed) checks the dimensioning for semi-finished products. For this, the table Sheet
dimensions (defined by semi-fin. prod.) under Factory Standards> Sheet dimensions is evaluated in the CATed-
itor. The table shows the maximum length and width of the semi-finished product as a function of the TableID of the
semi-finished product. The dimensions of the ALUCOBOND panels stored in this table are predefined by ISD.
However, you can extend this table as required for other semi-finished products.

Example: Sheet dimensions defined by semi-fin. product
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Multiple part selection
In previous versions, the selecting of parts in rectangle has behaved differently in shaded and non-shaded views as
well as in referenced and "regular" parts. As of HiCAD 2019 SP1, the conduct is standardised as follows:

To select all parts/assemblies within a rectangle for processing, draw a rectangle by simultaneously pressing the
left mouse button and the CTRL button. With regard to assemblies, the following should be observed:

n The behavior is independent of the representationmode.

n Referenced and non-referenced parts behave equally.

n If assembly points are assigned to one assembly and at least one of the assembly points lies within the rect-
angle, the complete assembly including all of its subordinate parts are being selected.

n If no assembly points are assigned to an assembly or none of the assigned assembly points lie within the rect-
angle, only those parts of the assembly are being selected which lie completely within the rectangle.

n A special treatment applies to sheets. If all flanges and bending zones of a sheet are in rectangle, the cor-
responding superordinate part is also selected.

n There is no special treatment for pipe parts.

Information window Collision check
The collision check functions now also display a message if no collision was found:

Article master sync when saving

With the function Article master sync when saving you can specify which HiCAD part attributes are to be
assigned to HELiOS article master when saving. These attributes are then compared each time they are saved. As
of SP1, this function is no longer available in the menu function under Drawing > Itemisation/Detailing < Attr....
Instead, the function is now available via the menu function HELIOS PDM under Others > Link....
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Selection of CS axis, plane and zero point in drawing
For functions that refer to axes, planes or the origin of the active coordinate system, it was previously always pos-
sible to select them via the context menu. Since HiCAD 2019 SP1, additional symbols are now displayed in the draw-
ing, which can be clicked directly for selection.

Only the symbols that can be used are displayed; if, for instance, a direction is queried, only the coordinate axes
and the origin (as start point of a direction) are available for selection:

You can specify the transparency with the option Transparency (Shaded representation) under Drawing
> Others > Extras > Settings, permanent > CS display .
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Major Release 2019 (V 2400)

New Module Profile Installation
The new module Profile Installation (optional) provides convenient options to place installation elements on walls
and roof surfaces within a short time.

You can find the functions on the Ribbon Profile Installation.

Improved performance
n The HiCAD function dialogues work significantly faster because of internal adjustments (this concerns body-

wise saving).

n The collision check works much faster by means of factor 3 as of HiCAD 2019.
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Itemisation
As of HiCAD 2019 it is automatically determined which mode is being used for Itemisation, i.e. it is not possible to
select the mode via Configuration Management.

It depends on the current drawing whichmode is active: 

n For drawings created with HiCAD 2019 or older drawings which have not been itemised yet, Standard Itemisa-
tion is being used (since HiCAD 2018).

n Conversely, the mode Itemisation up to HiCAD 2017 is only used for drawings created with a version before
HICAD 2019 and which have been -at least partially- itemised with the old mode.

Please note that the mode Itemisation up to HiCAD 2017 will not be available anymore by HiCAD 2020.
For converting Itemisations to the Standard Itemisation as of HiCAD 2018, the function Convert to stand-

ard itemisation is available.

New features for Textures
As of HiCAD 2019 Textures are
not any more assigned via the docking window Visual Effects. The following function is available instead (see also
HiCAD 3D -What's New?)

Texture - New (3-D Part list)
applies texture to active part or active
part list of a texture

via 3-D Standard > Tools > Attr... or in the context
menu of a part list via Properties

Texture - New (3-D Part)
applies texture to active part

via context menu for 3-D parts under Properties

Change texture, active part (3-D
Part)
changes texture of active part

via context menu for 3-D parts

New texture
create new textures/changes existing
textures

via Drawing > Others > Extras

In addition, HiCAD 2019 offers a multitude of textures. These are available in HiCAD Catalogue under Textures and
Colours > Textures.
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New Part Type 3-D Sketch

Planar sketches and 3-D sketches are different part types as of HiCAD 2019. Thus, Planar sketches and 3-D

sketches can be marked differently and the Part filters for the Toolbar can be set detachedly for Planar
sketches and 3-D sketches.
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Novice - Configuration - Sketch
The Novice configuration settings have been revised:

n The checkbox Default planes for new sketch is also applicable for 3D sketch. Here, a preview of the default
planes is shown. The desired plane can be easily selected with the cursor.

The setting (Yes) affects planar sketches only if the checkbox Query plane for new sketch is ticked.

n If you have chosen the Novice Configuration in the Extended settings of the HiCAD installation, or via the Para-
meter configuration (ParKonfigComp.exe / ParKonfigUser.exe), this will also influence the settings in the Con-
figuration Editor!
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New Part Structure Representation in the ICN
The Part structure representation in the ICN has been redesigned:

n Improved performance, notably with complex drawings

n Tabular, multicolumn representation

n Sorting by click on the column header

n Individual configuration of the representation

n Fast switching of the representation of HiCAD and HELiOS attributes

In context with the new representation of the 3-D Part structure, the following system files have been renamed:

Up to HiCAD 2018 As of HiCAD 2019

BRW_3DTEILATT.HDB ICN3D_MULTIATTRVIEW.HDB

BRW_3DDBATTR.hdb ICN3D_MULTIATTRVIEW_DB.HDB
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New 3-D Point option - Intersection of three planes

With the new function Intersection of three planes it is possible to determine an intersection - even in theory
- of three planes. This is often used for Element Installation to specify the origin of the Fitting CS in order to determ-
ine the exact fitting direction.

Example:

Here, the intersection of plane (1), (2), and (3) have been identified by selecting the respective area.

Free general access to PARTS4CAD
As of HiCAD 2019 you are granted with free access to more than 500 manufacturer's catalogues via the web cata-
logue parts4cad by Cadenas. The access to the extended catalogue range (DIN/ISO/EN… Norms + all 800 man-
ufacturer's catalogues) is fee-based.

Standardization of terms
The following term has been standardized as of version 2019:

Previously As of HiCAD 2019

Figur 2-D Part
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Advanced display in the title block
Furthermore, it is displayed whether a read-only file has been opened in the title block.

A file is considered as read-only file, if

n it has been opened with the HELiOS function Open, read only ,

n the Workflow status is indicated with released,

n if it has been opened with Open drawing, read-only via Explorer in HiCAD or

n you do not have the required user rights for opening the file.

Select superordinate part
For selecting a superordinate part in a drawing, click on the part with the left mouse button and hold it. Click addi-
tionally on the right mouse button. HiCAD automatically selects the closest superordinate part and marks it. Click-
ing again on the right mouse button enables further search for parts.

So far, this function has been enabled only for general selection of parts before calling a function. As of
HiCAD 2019, this is also possible when a part selection is started via a new function dialogue, for instance the defin-
ition of exploded views.
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QOMET-specific BOMs
HiCAD 2019 supports the export of QOMET-specific BOMs. QOMET is an ERP system specialised in steel andmetal
engineering.

The BOM can either be exported for the complete drawing or active part and contains particular columns of the
Excel BOM in Steel Engineering (hicad_Stahlbau.xlsc ) relevant for the QOMET system in particular. The file is expor-
ted as CSV.

The respective functions for exporting the BOM are available under Drawing > Save/Print > Save as...
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Drawing derivation - Sectional views of Sheet Metal parts
As of HiCAD2019 continous sectional views are only created if the bending zone is parallel or perpendicular to the
view CS.
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Drawing derivation - Enhanced dimensioning rules for Sheet Metal parts
In facade engineering, sheet metal is used as bent profile or tray panel. It is often requested that these sheet
metals are also to be dimensioned automatically in standard views when creating workshop drawings (top view,
side view, front view) and that the processings are taken into consideration next to the outer dimensions.

157 SHEETMETALBORES Processings in sheets

158 SHEETMETALBORES_
VERT

Processings in sheets incl. processings perpendicular to view

159 SHEETMETALOUTLINE Outer contours of sheets

160 SHEETMETALBORES_
SEPERATED

Processings in sheets, dimension chains separated according to
flanges

161 SHEETMETALBORES_
VERT_SEPERATED

Processings in sheets incl. processings perpendicular to view, dimen-
sion chains separated according to flanges

162 SHEETMETALOUTLINE_
SEPERATED

Outer contours of sheets, dimension chains seperated according to
flanges

The sheet metal is treated as superordinate part including its flanges and bending zones. The prerequisite for these
dimensioning rules is that an appropriate coordinate system has been defined with the functions via Alignment of
derived drawingsin the context menu for 3-D parts.
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Recommended settings rule 157 - 162
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Example:

The following picture shows a sheet metal with different bores. For the alignment of derived drawings the top view
has been placed in the flange surface (1). (2) shows the front view of the drawing derivation and (3) the top view.
The configuration DEFAULT (SHEETMETAL) has been used as template - enhanced by rule 157, 158 und 161.
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Drawing derivation - Settings for dimension type "conventional"
As of HiCD 2018 it was possible to determine whether the 90° bend angle should be dimensioned for drawing deriv-
ation in the sectional view of folded sheets. In order to disable the dimensioning of 90° bend angles the system data
STAB3DPAR.DAT (for new customers) and STW_DIMSETTINGS.XML had to be adjustedmanually so far.

As of HiCAD 2019 this function can be set via Dimensioning Settings . The dialogue window General has
been enhanced with the checkbox Supress 90° angles of bend zones in sectional views of folded sheets.
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Drawing derivation - Shortened view
As of HiCAD 2019, shortenings are displayed simplified.

The following depiction shows the difference:
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Loading usage-dependent configurations
The dialogue window for usage-dependent configurations has been rearranged more clearly. This concerns the fol-
lowing functions in particular:

n Drawing Derivation and

n Dimensioning Rules Editor

The first column shows the configuration. The second column shows the usage for the configuration.
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Customer feedback

Via the function Help > Customer feedback now also the Data protection notice: Collection of data for constant
GUI optimisation can be opened.

The same applies to the HiCAD installation for the setup step GUI optimisation .

TABPAR.DAT -> Configuration management
So far, this system file has contained settings for working with a tablet as input device as well as regulation for time
interval for double-click. This file will be cancelled as of HiCAD 2019 because tablets are not being supported as
input device. The parameter Time interval for double-click can be defined via System settings > Identification in
the configurationmanagement.

AutoSync of Part Attributes and HELiOS Article Master Data

With the new function Article master sync when saving you can specify which part attributes are to be syn-
chronized with which article master data. These attributes are synchronized automatically with each saving pro-
cedure.

Please note that the Transfer part attributes to HELiOS checkbox must be activated the
ISD Configuration Management via System settings > HELiOS.

You find the function via Drawing > Itemisation/Detailing > Attr...

ISD License Manager - New Tab "Server Monitor"
WIth the new tab Server Monitor you can look at available and occupied modules. By means of the listed licenses
you can easily find out which colleague blocks licenses and e.g. contact them in case if you need a license.

66 / 386 What's new?

Basics

https://help.isdgroup.com/helpdirect/1033/isd_feedback.pdf
https://help.isdgroup.com/helpdirect/1033/isd_feedback.pdf


2-D

Service Pack 1 2019 (V 2401)

Maximum number of layers
In previous versions the possible maximum number of layers in HiCAD could be set in the Configuration Editor at
System settings > 2-D Lines with the parameter Maximum number of layers. From Service Pack 1 onwards, this
parameter will no longer be available. The number of possible layers has now been set to constantly 1000. (Layer 0 -
999).

Translation tool - Ignore upper/lower case letters
In the Configuration Editor you can now also specify whether upper and lower case letters are to be taken into
account when localizing texts with the translation tool. The default setting is Consider.

You can find this option at System settings > Miscellaneous > Translation -Upper and lower case letters. For a
change of this setting to take effect, HiCAD needs to be restarted.

The setting will not be saved in the drawing or in the text; it is a pure system setting.
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Major Release 2019 (V 2400)

Delete annotation, in rectangle

The Delete tags menu of the Delete text function now features the new In rectangle option.

This function deletes all annotations the insertion point of which lies within one or several rectangles. The actual
deletion will only take place after a right-click.

One distinguishes between:

n Tags with item numbers (Itemize part)

n Tags with standard designations (Standard designation)

n Other designation tags (Text with leader line) and

n Text blocks.
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3-D

Service Pack 2 2019 (V 2402)

Views

Processing planes in shortened views

In previous versions, it was not possible to display shortened views in processing planes. From HiCAD 2019 SP2
onwards this will be possible, i.e. the switching of Processing planes in the dialogue window of the function Views >

Properties > Elements can now also be applied to shortened views. In particular, you can now hide and show
processing planes in shortened views of workshop drawings.

Exploded views - Combine transformations into set

In the Exploded views docking window you can now combine several transformations in succession into one group,
e.g. in order to get clearer and better structured explosion logs for complex exploded layouts. For this purpose the
following functions are available in the context menu of the explosion log:

Combine transformations into group

Use this function to combine several transformations in succession into a group. You can also move
other transformations into or out of this group by Drag & Drop.

A set can in turn contain other sub-groups.

Right-clicking a group opens a context menu with further functions:
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You can then change the name of a group, delete, arrange or break up a group again.

Break up group

Use this function to break up a marked group. Sub-groups contained in that group will be preserved.

Important:

If you delete a complete set of transformations, all transformations contained therein will also be deleted.
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Process / Model parts

Clean up

The Clean up function has been enhanced. It now offers the new Cut vertically checkbox.

n If the checkbox is activated, you need to determine the surfaces in relation to which the hole resulting from the
intersection is to be placed in a vertical position. This means that the function behaves as before.

n If the checkbox is deactivated, the selection of surfaces is also deactivated. In this case the result of the func-
tion corresponds to a subtraction with clearance.

In the image below shows the collision part (1) is a cylinder intersecting with a pipe. The outer (2) and the inner sur-
faces (3) of the pipe have been selected here. A shows the result with clearance, B, in comparison, the result of a
subtraction. A shows the result of a vertical cutting and clearance. The outer (2) and the inner surfaces (3) of the
pipe have been selected here. B shows the result without vertical cutting.
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Part properties - Weight calculation

The weight calculation option in Configuration Management under Modelling > Part propertiescontrols when the
weight of parts (based on geometry) are to be recalculated. If the weight of a part changes, then these changes
must be transmitted upwards in the parts structure, e.g. recalculation of the weight of superordinate assemblies,
etc. Up to now, this transfer potentially occurred more often than the update of weights based on the geometry
(manual entry of a weight, change of the BOM relevance, varying geometries etc). As of HiCAD 2019 SP2, this
transmission of weights is also controlled by the Weight calculation option in configuration management, which
can significantly improve performance in large drawings.

72 / 386 What's new?

3-D



Dimensioning

Heights above datum

The Create new height above datum, parallel to Z- axis function can now be found at 3- D Dimen-
sioning+Text > Parallel > Height....

The Create new height above datum function has beenmoved into the sub-menu.
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Placing of HCM dimensions in case of geometry changes

In older versions, HCM dimensions in sketches were placed with regard to their first base point. In case of geometry
changes, the new dimension was placed in such a way that the length of the projection line of the first base point
was identical to the length before the change, which frequently lead to unsatisfactory results. From SP2 onwards,
the placement logic is different. The length of the shortest projection line after the change is now identical to the
length of the shortest projection line before the change. In the process, cases may occur where the shortest pro-
jection line could be applied to different base points.

Example:

In the original sketch (1) the marked HCM dimension is changed from 140 to 170. (2) shows the result in HiCAD
2019 SP2, (3) shows the result in HiCAD 2018
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Annotations

Move / Clone annotations

In previous versions, it could happen that annotations were displaced in a chaotic manner when you moved/cloned
them in model drawings with several views, and accidentally selected a target point in a neighbouring view. This
behaviour produced unwanted results.

This behaviour has now been changed: The target point now always refers to the original view.

Example

The image below shows a 3-D model (1) containing a prism and a cuboid. Two list views have been created in the
Sheet area- one list view with the cuboid (2) and one list view with the prism (3). The list view for the prism contains
an annotation. If it is moved to the left (4), the behaviour is now different from that of previous HiCAD versions.
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Improved placing of annotations for standard processings

In previous versions, leader lines frequently ran straight through processings (e.g. bore patterns) when using the
automatic placing of annotations for standard processings. This effect has been corrected in HiCAD 2019 SP2;
now, leader lines of processings will always end at the nearest standard processing. Furthermore, leader lines can
now be placed either on or outside of parts. For this purpose the dialogue window of the Optimise arrangement

function (3-D Dimensioning+Text > Text > Part annotation with free text + leader line) now contains the
new Standard processings preferably on part checkbox.

If the checkbox is active, the annotations of standard processings are placed directly next to the processing, i.e. on
the part, if there is sufficient space. If there is not enough space, the annotation will be placed a little farther.

If the checkbox is deactivated, the annotations will be placed outside the part, as in previous versions. This is the
default setting.

Example

1. Arrangement of annotations in HiCAD 2019 SP1

2. Arrangement of annotations in HiCAD 2019 SP2
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Please note:

The behaviour of the arrangement of annotations can be set in the same way for automatically derived workshop
andmounting drawings. This can be set in the Configuration Editor at

n Automatic drawing derivation > Production drawing > Annotations > Placing of annotation and

n Automatic drawing derivation > Mounting drawing > Annotations > Placing of annotation, respectively,

by setting the parameter Standard processing on part accordingly.
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Automatic part annotation - Handling of hidden parts

The Automatic part annotation function has been modified to specify how hidden parts are to be treated in
the active view. This is required, for example, in Steel Engineering, for halls or structures in particular. For this pur-
pose, the Include hidden parts checkbox has been added in the dialogue window.

The Include hidden parts checkbox determines whether hidden parts are to be considered or not. Parts are con-
sidered as "hidden" if they are completely invisible in the active view.

n Representation types Glass model and HiddenLine dashed:
No hidden parts occur in these views

n Representation types Shaded and HiddenLine:
Hidden parts may occur here.
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An example:
The image below show the detail of a support structure. Let's take a look at the assembly with the item number
1.

The automatic part annotation will then produce the following result in the front view:

What's new? 79 / 386

News Overview



Referencing

Fitting CS

When referencing 3-D parts, a Fitting CS, which will also be entered into the Feature log, will be automatically
assigned to the parts. This applied to both the internal and the external referencing. In previous versions, fitting
coordinate systems that existed during referencing were deleted. This behaviour has now been changed. If a Fitting
CS already exists during referencing, the following message appears:

By activating of the desired option and confirming with OK you can either

n keep the existing Fitting CS, or

n replace the existing Fitting CS with the active CS.

Break up referencing of parts/assemblies

The breaking up of parts and assemblies has been speeded up. In tests, performance increases by factors between
2 and 4 could be achieved.
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Service Pack 1 2019 (V 2401)

Discontinued functions
The functions of the Assembling simulation toolbar will be no longer available with the release of HiCAD
2020. Simulations created with these functions can still be played, but no new assembling simulations
can be created any more.
From HiCAD 2020 onwards, the convenient simulation tool that was introduced with HiCAD 2014 can be
used for motion simulations and physical simulations.

Views

Performance for rotations

In HiCAD 2018 SP2 the rotating of shaded views could be speeded up significantly - especially for shaded views
with edges. In HiCAD 2019 SP1 the performance could be further increased. In a test we took a look at different
model drawings with 20.000 parts (some of which were highly complex, imported parts), 60.000 parts and 90.000
parts. Examined were, for instance, the following model drawings:

20.000 with large imported parts (Image: TGM Kanis Turbinen GmbH, Nuremberg, Germany)
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60.000 parts(Image: CAD Planung Arnold Matei, Mannheim, Germany)

Compared with HiCAD 2019 (Major Release) a significant increase of the frame rate (the number of images gen-
erated during rotating) could be achieved for the model drawings that we tested:

n Shaded with edges: Increased rotation speed by a factor of 4, and

n Shaded without edges: Increased rotation speed by a factor of 3.

Performance for sectional views, detail views and cut-outs

Thanks to the optimization of internal routines the generation of sectional views, detail views and cut-outs could be
speeded up further.
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Dynamic rotating with the mouse

When performing a dynamic rotation with the mouse without a defined rotation point (MMB/mouse wheel), such a
rotation point will be determined automatically. The position of this point depends on the part on which the cursor
currently points, i.e. which part is currently highlighted in a different colour.

If the cursor points on a solid, the rotation will take place about a point on this solid. The rotation point will be
determined automatically, by projecting the current cursor position perpendicular to the screen onto the next found
surface. In previous versions this did not work for sketches.

From HiCAD 2019 SP1 onwards, a "reasonable" rotation point will be determined for sketches, too; this point can
also be located on the frame of the sketch plane. The same principle applies to processing planes, i.e. you can also
rotate about a point on the frame of the processing plane.

Exploded views

n When changing or deleting mounting tracks of exploded views you can now right-click to open a context menu
with further selection functions:
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n Please also note that exploded views can now be considered as

l 3D-PDF (*.PDF)

l Universal 3D (*.U3D) and

l Product Representation Compact (*.PRC)

files for exports. The Configuration Editor and the export dialogue windows have been expanded accordingly for
this purpose.

In the export file the parts will be displayed in the exploded layout. The mounting tracks, too, will be exported.
While their colour will be exported from the model drawing, line type and font will not be considered.

n The name of the exploded view is now shown in the docking window. The name can be changed with the Views

> Properties > Rename function.

n Concentricity transformations can now be performed not just about an axis, but also about a point. For this pur-
pose, two buttons have been added to the dialogue window:

Concentric, about axis
Here the transformation takes place by selection of an axis. The moved parts will then be located on a circle
the centre point of which lies on the selected axis and runs through the centroids of the selected parts. This
means that the parts move within one circle plane, i.e. the transformation is two-dimensional.

Concentric, about point
If you choose this option, the parts will move on a straight line running through the selected point and the
centroid of the corresponding part, i.e. the transformation is three-dimensional.
The following example illustrates the difference between the transformation types Concentric, about axis and
Concentric, about point. The image below shows 8 neighbouring cuboids and one concentricity transformation
about a point:
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The next image shows the concentricity transformation about an axis:
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Switch visibility of textures on/off

With the functions

Shaded representation, active view and

Shaded representation, all views

the visibility of textures in the active views or in all views of a model drawing can be switched on or off. The menu of
these functions has been expanded accordingly for this purpose.

Switching off the visibility of textures can be helpful during the processing of large model drawings with many tex-
tures.
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Model and process parts

Lettering

The Lettering function dialogue window now always shows the last used settings.

Delete subtraction

The dialogue window of the Delete subtraction function has been slightly modified.

Click on Preview to check what the result of the function will look like. The highlighted bores/subtractions will be
removed when you click on OK.

Parametric cloning

If you choose the Clone parts, parametric function, the option Linear pattern, and, for distance determ-
ination,

n Up to reference, with distance or

n Up to reference, with number,

you can also choose an edge as end reference. In previous versions you were, after selecting an edge, always
asked to identify a second edge (to determine a surface in this way).

Furthermore, you can now also determine several start and end references by clicking on the symbol next to
the corresponding input field and selecting the desired element. The number of the selected elements will be
shown in the input field, e.g.:
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In this case, always the smallest distance resulting from the specified start and end references will be used. This dis-

tance can be shown by clicking on the symbol.

If you select an already selected element again, it will be removed from the list of references. To remove all start or

end references, click on the Delete symbol in the respective input field.

New for linear patterns is the option Up to reference, with max. indiv. distance. The distance between the original
and the last clone is determined here by the distance between the selected start reference and end reference.
From this value and the specified maximum individual distance HiCAD will calculate the number of clones in such a
way that their distance will not exceed the specified individual distance.

An example:

The cylinder shown below has been cloned with the settings shown in the dialogue window. The quad point (1) of
the cylinder has been chosen as the start reference, the highlighted edge of the cuboid (2) has been chosen as the
end reference, while the X-axis determines the direction:
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External references on facets

For the functions

n Add sweep, via translation,

n Subtract part, via translation or

n Trim to surface

the Feature setting Do not use external references was ignored in previous versions, i.e. external references were
always considered. This behaviour has been changed now (see also Feature Technology - What's New?): If one of
the above processings contains an external reference and is recalculated, while external references are deac-
tivated, the processing will keep the previous result.

An example:

The image below shows two cuboids (1). On the left cuboid a sweep based on the shown sketch was created, up to
the opposite surface of the right cuboid (2), i.e. there is an external reference here.

If you now move the right cuboid (3), and then perform a feature recalculation with the setting Use external ref-
erences, the sweep will be adjusted accordingly (4). If the setting Do not use external references has been
chosen, the original processing (3) well be preserved.
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Dimensioning

Changed context menu

The Move dimension context menu has been slightly changed.

This context menu will be shown when you have selected a dimension you want to move and then right-click.
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Changed dialogue texts for individual dimensions and structure dimensions

The user guidance texts in the info bar at the bottom left of the HiCAD screen have been improved and stand-
ardized in HiCAD 2019 SP1 and are now clearer and easier to understand.

Dimension /

Action
Old text New text *1, *2

General

Selection of base points

Select 1st geo-
metry element

Select base point (MMB = Cancel, RMB = Fur-
ther options)

Select 2nd geo-
metry element

Select base point (MMB = Cancel, RMB = Fur-
ther options)

RMB = Change
relocationmode

Drop dimension figure (MMB = Cancel, RMB =
Further options)

General

Expand structure dimension by
selecting of further base points

Select next point Select further base point (MMB = Cancel, RMB
= Further options)

Individual dimension: Diameter /
Radius

Choice of object to be dimensioned

Edge or surface Select circle, sphere, cylinder or torus (MMB =
Cancel, RMB = Further options)

Structure dimension: Angular
dimension

Set base point

Select 1st geo-
metry element

Select base point (MMB = Cancel, RMB = Fur-
ther options)

Structure dimension: Arc dimen-
sion

Select mid point Mid point Select mid point of arc (MMB = Cancel)

1st base point Start point on arc Select base point (MMB = Cancel, RMB = Fur-
ther options)

2nd base point End point on arc Select base point (MMB = Cancel, RMB = Fur-
ther options)

Variable dimensioning - Improvements

Since the Major Release 2019 the Variable dimensioning has been improved further with regard to the structure
dimensions:

n Arbitrary base points can now be chosen,

n Besides points you can now choose edges for base point determination.
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Sketches

Deriving of sketches

When deriving sketches from existing edges you can now, in certain situations, use reference edges that were cre-
ated in sectional views as a result of the cut. This is possible with the following functions:

Offset (via point and value)

Double-sided offset with end caps

Take over edges and

Directed projection.

Process sketches via Feature log

In the Process sketch dialogue that can be opened via the Feature log of sketches used for the processing of parts
(e.g. C-edge sweeps, extruded parts, revolved parts etc.) you can now also use the UNDO and REDO option, i.e.
you can undo and restore executed actions in the Process sketch dialogue. For this to happen, dialogues in
"deeper levels" must have been closed first.

An example: You fillet several corners of a sketch without leaving the Fillet function. After this, an UNDO cannot be
performed for the individual fillets, but only after ending the Fillet sketch function.

After applying the processed sketch, an UNDO will completely take back the previously executed processing.

For changes that are applied to the sketches in sectional views, detail views and cut-outs this is not pos-
sible.
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Standard parts/processings

New standard parts

HiCAD 2019 SP1 offers many new fasteners, e.g. acc. to ASTM Standard (American Society for Testing and Mater-
ials). Please also see What's New in The Catalogue Editor?

Processing direction

New in the Standard Processings menu is the Processing direction function. Use this function to indicate
the processing direction and processing side of a part, e.g. a Sheet Metal flange, to determine the direction of its
coating or texturing. This function was previously available on the Sheet Metal Ribbon tab.

Referencing

Updating of referenced parts

When you load a HiCAD model drawing, it can contain old indices of referenced parts. That is, the associated .KRA
file of a referenced part has a higher version number than the part in the model drawing, or a higher index of the
HELiOS document in the database may even exist, which requires the exchanging of this part against the part with
the most recent index.

In this case, a dialogue listing the old parts and suggesting their updating will be displayed upon loading of the rel-
evant model drawing. Upon confirming the updating as suggested, all parts in the model drawing will be updated to
their most recent state. Depending on the size of the model drawing this process may take some time. In HiCAD
2019 SP1, however, the updating process could be speeded up significantly.
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Textures

Setting the projection parameters

When assigning textures, you have now the option to set parameters for the selected projectionmethod

n Cuboid,

n Plane,

n Cylinder or

n Sphere,

e.g. the cylinder axis or an angle for seam displacement.

(1) Parameters,automatic, (2) Y-axis selected as axis, (3) Axis = Y-axis and additional point selected
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Change texture - Multiple selection

The Change texture function also allows multiple part selection. The following rules apply:

n If the same settings apply for the selected and already textured elements, these will be shown in the dialogue
window.

n If the settings differ, the fields containing different settings will either be displayed with a yellow border and

marked with the Different values symbol, or the text <Different values> will appear in the field (depending
on the field type).

New catalogue for user-defined textures

When defining your own textures with the New texture function, you can now save these to the catalogue
WERKSNORMEN (Factory standards) > User-defined textures. There, a table called Example textures already
exists. The texture image and the texture icon will be automatically saved to the HiCAD folder KATALOGE >
TEXTUREN > IMAGE. Please note that new textures can only be added to the catalogue with this function. Their
adding via the Catalogue Editor is not possible!
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Major Release 2019 (V 2400)

Performance

Middle mouse button - Faster working process

For many functions, pressing the middle mouse button allows not only the exiting of the function (as long as data
has been entered) but also enables a faster working process. For instance, chamfering or filleting 3-D solids or trans-
forming sketch elements can be applied with the middle mouse button, after all necessary data has been entered.
This means that switching to the dialogue window of the respective function and clicking on the Apply button will
no longer be necessary. HiCAD points to the according functions in the dialogue text, for instance: 

Currently, this function concerns the following 3-D functions:

n 3-D Standard > Process > Fillet

n 3-D Standard > Process > Chamfer

n 3-D-Standard > Process > Wall > Envelope

n 3-D-Standard > Process > Clone

n Sketch > Process > Fillet

n Sketch > Process > Chamfer

n Sketch > Transform > Move

n Sketch > Transform > Rotate

n Sketch > Transform > Mirror

n Sketch > Transform > Scal...

n Sketch > Transform > Move...

n Sketch > Clone > Move

n Sketch > Clone > Rotate

n Sketch > Clone > Mirror

n Sketch > Clone > Scal...

n Sketch > Process > Trim > By value

n Sketch > Process > Trim > To surface/line/point

n Sketch > Process > Trim > Number

n Sketch > Derive > Take...

n Sketch > Derive > Offset > Double-sided offset with end caps

n Sketch > Derive > Offset > Replace line
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Part properties

New textures

HiCAD 2019 offers a multitude of new textures, e.g. for architecture, metals and non-metals. These are available in
the HiCAD catalogue at Textures and Colours > Textures.

The previously available textures can be found at Textures and Colours > Textures > Textures HiCAD 2018.

Also, new functions are available for the assigning, creating and changing of textures.

New dialogue for assigning of textures

As of HiCAD 2019, textures are no longer assigned via the Visual effects docking window. Instead, you can use the
following functions:

Texture - New (3-D part list)
assigns a texture to the active part
or the active part list

at 3-D Standard > Tools > Attr. > ... or in the context
menu of a part list at Properties > ....

Texture - New (3-D part)
assigns a texture to the active part

in the context menu for 3-D parts at Properties > ...

Change texture, active part (3-D
part)
changes the texture of the active
part

in the context menu for 3-D parts
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New dialogue windows for assigning and changing of textures are available, e.g.:
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New Texture Editor

For creating of new textures and changing of textures that already exist in the catalogue the New texture

function is available at Drawing > Others > Extras > ... :

Delete material

At 3-D Standard > Tools > Attr. > ... you will now find the Delete material function that allows you to
delete the material assignment of the active part or the active part list. You can also find the function in the context
menu at Properties > ....
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Views

Pre-setting of the representation in model views and sheet views

The representation that is used when you create new drawings for model views and sheet views can be pre-set. One
distinguishes between

n manually created drawings, i.e. drawings created with the Drawing > New function, and

n derived drawings, e.g. drawings created with the Derive or Mounting drawing function.

Manually created drawings

The representation of views that are directly generated upon creation of a new drawing with the Drawing > New
function, is pre-set as follows:

n Model view
Via the HiCAD Start Centre

n Sheet views
Via the Configuration Editor at Drawing > Views with the parameter Representation of Sheet view. The default
setting is Hidden Line.

The pre-set representation will also apply to subsequently created views of the current model drawing - as long as
you choose a different representation. After this, the new representation will be the new pre-setting for the current
model drawing.

Derived drawings

The representation of the model view in external drawings created by means of drawing derivation can be specified
in the Configuration Editor at Automatic drawing derivation > Representation of model view. The default setting
here is Shaded with edges.

The representation for sheet view can be specified in the dialogue windows of the following functions:

Drawing > Itemisation / Detailing > Derive

Drawing > Itemisation / Detailing > Derive > Create

Drawing > Itemisation / Detailing > MntDrw

Drawing > Save/Reference > Part (Option Save as part)
In this case the parameters Representation of Sheet viewandRepresentation of model view will be
considered.
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Collinear sheet edges

As of HiCAD 2019, collinear sheet edges are no longer displayed in HiddenLine mode. The corresponding check-
box has been removed from the Show/Hide elements dialogue window and the Configuration Editor. When opening
model drawings created with HiCAD 2018 or older versions the representation that was set when the drawing was
saved applies. However, you have the option to update the handling of collinear sheet edges to the new mech-
anism with the new Update sheet edges function (Views > Properties > Elements > ...). After this, you can hide
collinear-tangential sheet edges with the HiddenLine representation. Collinear bent edges are always shown, and
collinear mergeable edges are hidden.

New options for exploded views

n Besides the Move and Rotate function, another transformation type for exploded views, Concentricity ,
is now available. Use this function to define concentric transformations in the Exploded view mode. This makes
sense if you want to transform parts that are arranged concentrically around a common centre, e.g. bolts
arranged on a polar or radial grid.

In the case of parts that are arranged symmetrically around a common centre, the centroids of the parts are loc-
ated on a circle. The Concentricity functionmoves the parts in such a way that their centroids will be located on
a circle that is concentric to the aforementioned circle.

n From now on, sectional and detail views as well as cut-outs can be transformed into exploded views.

n Cut-outs can be created and edited in an exploded view. The explosion will be temporarily removed. In this
case, an according notification will be displayed with the option to cancel the process.

n The functions of the user interface Exploded view and Delete explosion have been removed. As
of now, these functions are available via Views > Process > Expl...
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n The End function from the tab Exploded view tab is not available any more. Use the according button
from the drawing area while the Exploded view is active instead.

n The individual steps of the exploded view creation and the insertion position can be moved up and down in
theExploded view docking window via Drag & Drop.

n As soon as parts that belong to an exploded view are changed, the exploded view will be marked as "invalid".
Like in sectional and detail views, such invalid views are marked with a red cross, like in sectional views and
detail views. To update the exploded view, choose Views > Edit > Update.

As long as the part selection is active, you can right-click in the drawing area to open the following context
menu:

With the function Parts in rectangle you can then select all parts within a drawn selection rectangle.
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Captions in sectional views and detail views

n The name of a view can now be used in captions for sectional views and detail views.

n You can now also specify the number of decimal places for the Angle in view captions, as with annotations. Fur-
thermore, you can also show non-relevant decimal places, e.g. final zeroes, by activating the corresponding
checkboxes. If you choose Standard for Decimal places (i.e. no number of decimal places has been specified
in the FTD file), the setting from the Pos3DParNeu.dat file will be used for the number of decimal places
(Default setting 0).

n The behaviour of the scale output in view captions has changed in HiCAD 2400. The scale will now also be
shown if it is equal to the main scale.

l For new view captions created with HiCAD 2400, or view captions to which the scale has been added sub-
sequently, the scale will be output without a check for scale equality.

l The behaviour of scale outputs in already existing view captions (created before V 2400) remains
unchanged, i.e. the scale will only be output if it is not equal to the main scale.

To apply the new behaviour to already existing captions, proceed as follows:

l Edit the view caption and remove the scale.

l Apply the changed caption with OK.

l Edit the caption again and add the scale again.

l Apply the changed caption with OK. The new scale will then show the new behaviour.

What's new? 103 / 386

News Overview



Representation of section paths

When creating sectional views, you can now use the symbol to influence the representation of sectional
paths. The dialogue window has been expanded for this purpose.
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Example:

Dimensioning / Annotations

Using part filters for automatic part annotation

You have now the option to use part filters annotation templates for automatic part and part list annotation. Specific
annotation templates can be assigned to these filters via the Configuration Editor, which allows you to use different
annotation templates for beams, plates (Steel Engineering) and sheets (Sheet Metal). The filters that can be set in
then Configuration Editor correspond to the filters for part search on the transparent toolbar. In the paragraph Using
part filters for automatic part annotation explains how to use these filters.
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The assigning takes place in the Configuration Editor at Drawing > Annotations > Automatic annotation > Filter-
Annotation template assignment.

What's new? 107 / 386

News Overview



When you click on the symbol, the current assignment is displayed.

According to the ISD default setting, different annotation templates are used for sheets (Sheet Metal) and steel
plates (Steel Engineering), namely, the templates that are offered in the table. For all other parts, the annotation
template at the bottom of the window will be used.

Delete annotation, in rectangle

The Delete, In rectangle function has been added to the Delete annotation menu. Deletes all annotations
within one or several selection rectangles. The annotations will only be deleted after a right-click.
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Insert additional leader lines

Use the Insert base point function to add additional leader lines to a part annotation. These leader lines
have no own text block and always end at the text block of the selected part annotation. The function is only avail-
able in the context menu of part annotations.

Right-click on the part annotation for which you want to add further leader lines, and choose Insert base point.

Then, determine the reference point of the additional leader line. The line will be drawn from the text block of the
selected annotation to the selected point. The start point of the additional leader line depends on the orientation of
the selected part annotation (Reference/Insertion point), i.e. on the type of the selected complete frame.

Please note:

n When youmove a part annotation, the additional leader lines assigned to it will also be moved.

n When you delete a part annotation, the additional leader lines assigned to it will also be deleted.

n When you edit an additional leader line, the edits will affect the complete annotation, i.e. it is not possible to
change the line parameters of the additional leader line separately.

(1) Part with annotation; (2) Annotation with additional leader line, the base point is the centre of the frame; (3)
Changed annotation settings; (4) Moving of annotation

Dimensioning of quad points

In older HiCAD versions, selected quad points were ignored during dimensioning in various cases. Instead, the
quad point rotated 90° was used. From HiCAD 2019 onwards, quad points are handled like "real" point options, e.g.
mid-points or centre points.
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Apply parameters of reference dimensions

Use the functions of the Parameters from reference dimension menu to apply the parameters of existing dimen-
sions to other dimensions of your drawing.

The operation of these functions has been facilitated in HiCAD 2019. The fist step after function call is the iden-
tification of the reference dimension, i.e. the dimension whose parameters you wish to apply. Then, choose
(depending on the function) the dimensions to which you want to apply the parameters of the reference dimension.

Height above datum - New symbols for dimension line terminations

For heights above datum new, additional symbols for dimension line terminations are available:

Height above datum, Circle, with cross, unfilled, and

Height above datum, Circle, with cross, half filled.

The dimension parameters and the setting options in the Configuration Editor at Drawing > Annotations > Dimen-
sioning, 3-D > ... have been expanded accordingly.
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Dimension parameters - New options for 2nd dimension figure

From HiCAD 2019 onwards, new, additional dimension parameters are available. The Dimension figure tab has
been adjusted accordingly.

You can now also set the unit of measurement and the number of decimal places for the 2nd dimension figure. Addi-
tional settings such as superscripted decimal places or the conversion into fractures are taken over from the set-
tings for the main dimension figure. If you choose a different setting than None, the entered conversion factor will
no longer be considered and the 2nd dimension figure will be calculated via the selected unit.

You use the Position parameter to determine whether the 2nd dimension figure will be shown above or below the
main dimension figure.

The new parameters can be specified separately for general linear dimensions, heights above datum and angular
dimensions.
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If you want to display two dimension figures with the first one being placed above, and the other one below the
dimension line, you need to set the position of the dimension figure with regard to the dimension line accordingly in
the Position area of the Dimension figure tab, and, on the Further settings tab, deactivate the interruption of the
dimension line and body edges by the dimension figure.

Furthermore, the setting options for 3-D dimensions in the Configuration Editor at Drawing > Annotations > Dimen-
sioning, 3-D > ... have been expanded accordingly.
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Separate settings for projection lines of angular dimensions

The pre-settings for projection lines of angular dimensions can now be specified separately. The Dimension lines
tab of the Dimensioning settings dialogue window has been expanded for this purpose.

Variable dimensioning

The procedure for creating structure dimensions via variable dimensioning has changed. Now, you first need to spe-
cify all consecutive points before dropping the dimension.
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Referencing

Locking referenced parts in read-only model drawings against editing

When working in write-protected, read-only model drawings you have the option to lock referenced parts of the
drawing against accidental processing: In the Configuration Editor, the parameter Lock referenced parts if model
drawing is read-only at System settings > Referencing is available for this purpose. The ISD default setting is No.

If the parameter is set to Yes, please note the following:

n A file is considered a "read-only" file, if

l it has been opened with the HELiOS function "Open, read-only",

l it has the Workflow status "Released",

l it has been opened via the Explorer with the "Open drawing, read-only" option, or

l you have not the permissions required for an opening of the file.

n If you attempt to modify a referenced part in a read-only file, the following message will be displayed:

n If you attempt to manually save a referenced part in a read-only file, the following message appears:
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n During some operations you will only realize at the end that a referenced part was changed. In such cases the
following message will be shown:

During simultaneous use of HELiOS please note the following:

When working with HELiOS, the parameter Lock referenced parts if model drawing is read-only, as
well as the HELiOS setting Allow part exchange in drawings (HELiOS Options > Database > HiCAD)
will be considered during updating and saving of referenced parts in read-only model drawings. This set-
tings does not only affect the loading of a locked model drawing (referenced parts may not be updated
from the computer), but also the saving of changed referenced parts. For example, if the setting option
Not for released or read-only has been chosen, the message Save rejected (Drawing is locked)! has
always been displayed upon saving of referenced parts. This applies even in cases where the parameter
Lock referenced parts if model drawing is read-only in the Configuration Editor has been set to No.
The dialogue for the saving of referenced parts will not appear either, but the changing of referenced parts
will be allowed.

Dependent assemblies

At 3-D Standard > New > Assy. > ... you will find the new Dependent assembly function.

This function allows you to replace an entire assembly by a dependent assembly, according to the same principle
as with the Dependent part function.

This is only possible for original assemblies that are

n externally referenced and

n do not belong to a locked assembly.

Sketches

Point functions

As of HiCAD 2019 the Point functions on the Sketch tab are only available for planar sketches and 3-D sketches.
For other parts such as assemblies, solids etc. please use the Point functions at 3-D Standard > Tools.
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Undo

UNDO actions now do no longer distinguish between sketches with and without HCM constraints, i.e. you can now
use a step-wise UNDO on sketches with automatic HCM constraints. Also, the number of possible UNDO steps is
now unlimited.

This is true both for planar sketches and 3-D sketches.

New part type 3-D sketch replacing c-edge part

In previous versions, only planar sketches had a special representation and a special behaviour, which was partly
controlled by the purpose. It was geared towards creating and editing of parts and is very useful for this. For
instance, the following applies to planar sketches with the purpose Create/Edit:

n They are displayed with broader lines when they are active.

n They are not hidden in shaded views when they are active.

n In sectional views, details and cut-outs they are not represented as cut sketches.

As of HiCAD 2019, 3-D sketches also benefit from these advantages. Here's an overview of what's new for 3-D
sketches:

n 3-D sketches, too, can be assigned a purpose that influences their representation.

n 3-D sketches have, like other 3-D parts, a Part CS that cannot be modified.

n For 3-D sketches, too, the settings of the Novice configuration are considered.

n The context menus for planar sketches and 3-D sketches have been standardized.

Furthermore, one now distinguishes between the part types Sketch and 3-D sketch in HiCAD 2019. Planar

sketches and 3-D sketches are marked with different symbols in the ICN, and the part filters for the
Find function can now be used separately for planar sketches and 3-D sketches.

The new part type 3-D sketch replaces the C-edge parts (before HiCAD 2019). Where C-edge parts were
allowed you can now use 3-D sketches.

When you load model drawings that were created and saved with versions before HiCAD 2019, HiCAD
wil attempt to automatically convert the affected parts to 3-D sketches without changing the drawings, so
that you can still benefit from the advantages of the part type 3-D sketch. Notes on conversion can be
found here.

Convert part into 3-D sketch

At Sketch > New > 3-D Sketch > ... you can find the new Convert function. Use this function to convert parts
with lines into 3-D sketches. This makes sense if, for instance, you want to import parts via the 3-D interface.

As is the case when you create a new 3-D sketch, you will be prompted to select a plane for Part CS definition.
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3-D sketches - Selection of plane

For 3-D sketches, too, you can now determine a plane in which the sketch is to be placed. Also, the settings of the
Novice configuration are now considered for 3-D sketches.

If the World CS planes fro new sketch (also 3-D sketch) checkbox has been activated in the Novice con-
figuration dialogue window, you can just select one of the displayed default planes with the cursor.

If you do not want this, or if the selectable default planes are not displayed, you can determine the plane by select-
ing points, edges, planes or processing planes. Right-clicking opens a context menu with further functions.
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Deriving splines

Whan deriving splines from polylines it will now be checked whether the selected c-edge contains curves. If this is
the case, an appropriate message will be issued, e.g.:

When you confirm this message with Yes, only the start points and end points of the straight line will be considered
for the creation of the spline, as shown in the image below, where an Akima spline (including the arcs) has been
derived from the sketch on the left hand side.

If you select No, the function will be cancelled, and no spline will be created.

To convert these polylines in such a way that splines can be directly derived from them, you can choose between
the following options:

n Choose the Divide, Number function. Enter a suitable number of segments and activate the Convert
curves into straight lines option.

n Apply the Replace line function to each curve of the polyline, activating the Replace with straight lines
option.

n Directly convert the polyline with the C-edge -> NURBS function.
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Model and process parts

Point functions

As of HiCAD 2019, the Point functions at 3-D Standard > Tools are no longer available for planar sketches and 3-D
sketches. Instead, use the Point functions on the Sketch tab for these part types.

Clone part, parametric

The previous functions

n Clone, Parametric along c-edge

n Clone, Parametric grid

n Clone, Rotate - parametric

n Clone, Parametric with displacement

have been combined into one new, central function called Clone parts (parametric).
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Others

Preview mode during part creation

When creating 3-D parts, a preview of the new part is normally displayed. Some functions show this preview auto-
matically, others require a click on the Preview button.

In the preview mode the model drawing can also be rotated dynamically by clicking with the MMB on the drawing
area. Based on the current cursor position, the next surface beneath the cursor will be selected and the rotation will
be performed about this surface. Some newer functions will also recognize when the cursor points to the preview of
the new part to be created. In this case this preview can also be rotated. However, please note that the Apply imme-
diately checkbox must not be active here. This currently applies only to the following functions:

n Insertion of solid primitives,

n Glass from sketch,

n Newer functions for Sheet Metal parts, such as Create base sheet or Attach flange, and

n Plane selection for sketch creation in the Novice configurationmode.

Improved intersection routines

The internal routines for intersections between cylinders and cones have been revised, resulting in improved res-
ults, e.g. during Boolean operations.

In the example below the cone has been subtracted from the cylinder. In previous versions, 2 section curves with
286 and 301 control points (1), respectively, were created in the process. In HiCAD 2019, only 1 section curve with
58 control points (2) is created.
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Catalogue Editor

Service Pack 2 2019 (V 2402)

Change order of tables in catalogues
The order of tables in the catalogue structure tree can be now changed by means of the Move table function. This
affects both the display in the Catalogue Editor and the selection via HiCAD. For instance, this function allows you
to move frequently used tables to the top of the catalogue structure tree.

Proceed as follows to change the order:

n Move the cursor on the name of the table to be moved, mark the table with a click andmove the marked table
up or down with the shortcuts CTRL+Arrow key.

n Right-click the table to be moved, choose Move table in the context menu, open the sub-menu of the function
and choose the desired option:

Please note that tables, but not their sub-tables, can be moved.
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Additional BRUCHA panels for element/profile installation
At Factory standards > Series > Roof wall facade > Room-closing profiles > Brucha you can now find new panels
with different sizes by the company Brucha for element and profile installations.

Eternit® installation elements

HiCAD now also supports the installation of Eternit panels for element installations and sub-structures. These can
be found in the following catalogues:

n Factory standards > Installation Planning - Parts and Processings > Element installation > Installation ele-
ments > Eternit.

Available are:

l EQUITONE Tergo and

l EQUITONE riveted

n Factory standards > Installation Planning - Parts and Processings > Sub-structure > Installation elements
> Eternit

Available are:

l Riveted to L-profile

l Riveted to T-profile and

l Systea UBE 25/2
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Eternit® Standard Parts

New in the Factory standards catalogue are standard parts that are required for installing of Eternit panels / sub-
structures. These are various Eternit fasteners, Eternit sleeves and Tergo / Tergo+ undercut anchors and dowels.

Eternit® semi-finished product data

The semi-finished product data for Eternit panels can be found at Factory standards > Sheets > Eternit in the fol-
lowing tables:

n EQUITONE [linea ]

n EQUITONE [materia]

n EQUITONE [natura]

n EQUITONE [natura] PRO

n EQUITONE [pictura]

n EQUITONE [tectiva]

n EQUITONE [textura]

The semi-finished product-dependent part colours are defined in the tables at Factory standards > Surface treat-
ment > Profile and Element Installation > Eternit.

What's new? 123 / 386

News Overview



Eternit® undercut bores for Tergo / Tergo +

At Sheet tools > Moulding tools a new table called Undercut bore for Tergo and Tergo + is available.

The insertion in HiCAD takes place with the function Sheet Metal > Further Tools > Mould .

HILTI consoles for rear-ventilated facades
New in the catalogue Factory standards > Purchased/Factory standard parts > Wall consoles are (optional)
HILTI consoles for rear-ventilated facades. Further information can be found in the Wall Bracket topic of the Ele-
ment Installation Help chapter.
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Service Pack 1 2019 (V 2401)

Thread types - Changed order
For many parts, different types of threads are available, e.g. F (Fine thread), R (regular thread etc.). The sorting of
these tables also affects the order in the selection box that is displayed in HiCAD during insertion of objects. For
some of these tables the sorting has changed in such a way that the different types will be available in HiCAD in the
following order during part insertion:

This concerns the tables of the catalogues

n Threads,

n Outer threads,

n Thread runout, and

n Thread undercut.

Threads with other type groups (e.g. various JIS or UNC threads) have remained unchanged.
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Schrag profiles
n The profiles of the company Schrag at Factory standards > Series > Profile and Element Installation >

Schrag profiles have been updated according to the current description of the manufacturer.

n New are the Lightweight profiles at Factory standards > Series > Lightweight profiles > Schrag.
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Feather keys
In previous versions, no material was assigned to feather keys. From HiCAD 2019 SP1 onwards, the material
C45+C (unalloyed hardened and tempered steel) is assigned to the feather keys acc. to DIN 6885-1 A - D.

Other fasteners acc. to ASTM standard
As of HiCAD 2019 SP1 many new Fasteners acc. to ASTM Standard (American Society for Testing and Materials)
are available:

Table Catalogue

ASTM A193 / A193M Bolts+Screws\Hexagon head bolts

ASTM A307 Bolts+Screws\Hexagon head bolts

ASTM A325 / A325M Bolts+Screws\Hexagon head bolts

ASTM A354 Bolts+Screws\Hexagon head bolts

ASTM A449 Bolts+Screws\Hexagon head bolts

ASTM A490 Bolts+Screws\Hexagon head bolts

ASTM F593 Bolts+Screws\Hexagon head bolts

ASTM A193 / A193M Bolts+Screws\Cheese-head screws

ASTM F1554 Bolts+Screws\Anchor bolts

ASTM A194 / A194M Nuts\Hexagon head bolts

ASTM A563 Nuts\Hexagon head bolts

ASTM A320 / A320M Washers\Washers

ASTM F436 /F436M Washers\Washers
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Major Release 2019 (V 2400)

New textures
In HiCAD 2019 the functionality for textures has been revised completely. As of HiCAD 2019, textures are no longer
assigned via the Visual effects docking window. Instead, you can use the following functions (see also HiCAD 3-D -
What's New?):

Texture - New (3- D part list)
assigns a texture to the active part
or the active part list

at 3-D Standard > Tools > Attr. > ... or in the context
menu of a part list at Properties > ...

Texture - New (3-D part)
assigns a texture to the active part

in the context menu for 3-D parts at Properties > ...

Change texture, active part (3-D
part)
changes the texture of the active
part

in the context menu for 3-D parts

New texture
Definition of new textures / change
existing textures

at Drawing > Others > Extras > ...> Extras

Furthermore, a multitude of textures is now available, which are stored in the folder Textures and Colours > Tex-
tures. The previous textures can be found at Textures HiCAD 2018.
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DIN ISO 7379 Hexagon socket head shoulder screws
The Fasteners > Bolts+Screws catalogue now contains the new Hexagon socket head shoulder screws according
to DIN ISO 7379 in the Fitting screws table.

DIN 444-B - Eye bolts
In the Fasteners > Bolts+ Screws > Various bolts+screws catalogue, the new Eye bolts according to DIN 944 have
been added to the Various bolts+screws table.
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DIN 7500 - Thread-cutting screws
At Fasteners > Bolts+ Screws > Thread-cutting screws you can now also find the new Thread-cutting screws
according to DIN 7500.

New usages for BIM
New in the catalogue Factory standards > Usage > Civil Engineering > Steel Engineering is the table Con-
struction section.

Construction sections and structure assemblies with this usage can now even be transferred to HELiOS if they are
not BOM-relevant (see also What's New inManagement + BIM).

Other new catalogue parts / processings
n DIN 440 R Washers

As of HiCAD 2400, washers according to DIN 440, Form R will be available. You can find these washers at
Fasteners > Washers > Washers, in the table DIN 440 R.

n DIN 103 Threads
Furthermore, new left-handed threads according to DIN 103 (Type F-LH) are now available.

Dished ends - CUSTOM columns
In the tables that are used for part processing, e.g. the tables beneath Processings, general, Fasteners, Semi-fin-
ished products etc., you will find CUSTOM columns that allow you to assign customer-specific information to the
corresponding parts.

These have now also been made available for Dished ends. This enhancements applies to all tables of the cata-
logues Dished ends and Factory standards > User-defined dished ends.
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Catalogues/tables for profile installation
Depending on the catalogue to which they belong, tables can be assigned to a particular category. For profile install-
ation, the category Parts is available.

When you create a new table for this category, the corresponding table columns will be generated automatically.

The tables that are supplied with HiCAD and can be found at Factory standards > Installation planning - Parts
and Processings > Profile installation have already been assigned to this category.

ALUCOBOND® SZ-20 sub-structure
In previous versions the ALUCOBOND® SZ-20 sub-structure was available as a hat profile in the catalogue Factory
standards > Installation Planning -Parts and Processings > Sub-structure > Installation elements and the table
ISD Example.

From HiCAD 2019 onwards you will find it in the table ALUCOBOND of the same catalogue instead.
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Feature Technology

Service Pack 2 2019 (V 2402)

Weight in dependent assemblies
When creating dependent assemblies it is now also possible to transfer the "Weight" attribute. In this case the
weight will be automatically fixed in the dependent parts.

Dependent assemblies with internally referenced parts
You can now also create a dependent assembly if it contains internally referenced parts. These parts will be con-
verted into dependent sub-parts when the dependent assembly is created.

However, the original assembly still needs to be externally referenced.
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Switch off updating of dependent assemblies
The updating of dependent assemblies can now be switched off temporarily or permanently. For this purpose the
context menu of the new options Switch Update off and Switch update off, permanent have been added to the
context menu.

Switch Update off deactivates the updating only temporarily - after selecting this option an updating of the depend-
ent assembly will be prevented, the corresponding Feature log entry will be renamed to Dependent part (Deactiv-
ated) and in the context menu the option Switch Update on will be offered.

Switch Update off, permanent also deactivates the updating, but permanently, i.e. this step cannot be undone
(except with the UNDO) function. The corresponding Feature log entry will then be renamed to Dependent part
(Switched off), and the context menu entries for updating will no longer be displayed.
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Fitting CS for referenced parts
3-D parts will automatically be assigned a Fitting CS when being referenced, which will be recorded correspondingly
in the Feature log. This applies to both internal and external referencing. In previous versions, fitting coordinate sys-
tems that already existed during referencing were deleted. From HiCAD 2019 SP2 onwards, this behaviour has
changed: If a Fitting CS exists when a part is being referenced, the following message appears:

By activating the desired option and confirming with OK, you can either,

n keep the already existing Fitting CS, or

n replace the existing Fitting CS with the active CS.
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Service Pack 1 2019 (V 2401)

Context menu for comments
Each Feature log entry in the ICN contains a sub-entry called Comment. Here you can enter a comment on this fea-
ture which will be shown next to the name of the feature. If you right-click this entry, a context menu will be dis-
played:

Edit formula opens a Formula Editor, allowing you to edit the comment you entered. The Formular Editor can also
be opened with a double-click on the Comment entry. Copy copies the comment to the Clipboard, enabling you to
Paste in into another feature by chosing the same-named function. Clear deletes the comment. Copy text copies
the text of the comment to the Clipboard, allowing you to paste it in a different program (i.e. not HiCAD).

Clone processing: Edge selection after distance determination via "Up to reference..."

If you call the Clone processings function and, in the dialogue window, choose Linear pattern and determ-
ine the distance via Up to reference, with distance or Up to reference, with number, you can now also choose an
edge as end reference.

In previous versions, the identification of a second edge (for the definition of a surface) was always required after
choosing an edge.

Undo/Redo during processing of sketches
In the Process sketch dialogue, which can be called via the Feature log of a sketch used for the processing of parts
(e.g. C-edge sweep, Extruded part, Revolved part, Add part etc.), the Undo and Redo option will now be available,
allowing you to revoke or restore processings.

For changes of sketches in sectional views, detail views, cut-outs or for created c-edge sweeps this will not be pos-
sible.

Clone processing: Up to reference, with maximum individual distance

The Clone processings function now offers the new option Up to reference, with max. indiv. distance.
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Here you need to specify two reference points and the desired maximum distance. If desired, you can specify an
offset for the distance of the reference points. Specifying a number of clones is not necessary.

Based on the distance of the two reference points, as many clones as required will be created, with their distance
to each other being smaller than the specifiedmaximum distance.
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Enhanced "Dependent assembly" function
The dialogue window of the Dependent assembly function has been revised and enhanced:

n You can now specify whether article master assignments are to be taken over into the derived assembly and
updated.

n Beneath Exceptions for attributes and properties you can now search for specific properties via full text
search, select or deselect all properties at once, save the currently active selection as a favourite and load it
again later. Also, only the attribute names, but no longer the internal designations and data types are now dis-
played here.

n When changing nested dependent assemblies you can now choose whether the changed settings are also to be
taken over into the contained dependent assemblies.

n Dependent assemblies are marked with the symbol in the ICN.

n A special handling of the transfer of item numbers has now been introduced.

n If desired, the dependent assembly can now be created in addition to the base assembly instead of replacing it.
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n Dependent assemblies now offer the option to load the base part or (under certain conditions) exchange it with
a different base part.

n Plant Engineering attributes will only be shown in the attributes list if the Plant Engineering module has been
activated.

n The sheet thickness is dealt with separately: If the sheet thickness is calculated, the attribute will not be trans-
ferred; otherwise, it will always be transferred.

External references to facets
In previous versions, when using the processings Add sweep, with translation, Subtract part, via translation or
Trim to surface (all on the 3-D Standard Ribbon tab) and specifying a surface (facet) as external reference the set-
ting Do not use external references was ignored, i.e. external references were always considered.

This behaviour has been changed now: If one of the above processings contains an external reference and is recal-
culated, while external references are deactivated, the processing will keep the previous result.

When opening old drawings, the facet parameter External references in processings will always be set to Use for
affected processings. This happens to ensure that the behaviour known from older HiCAD versions will be pre-
served in these cases.

If you want to use the new behaviour in model drawings that were created with an older hiCAD version, you need to
perform a feature recalculation.
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Major Release 2019 (V 2400)

Dependent assemblies
In addition to the already existing Dependent part function, HiCAD now also offers the Dependent assembly func-
tion. You can use this function to replace a referenced assembly in the model drawing with a dependent assembly.

The difference between a dependent assembly and a referenced assembly is that the dependent assembly is only
synchronized in one direction. That is, only changes to the original assembly will be taken over into the dependent
assembly, and not the other way round. This can be useful if, for instance, you need to modify a part to enable its
mounting, e.g. by applying bores to it. Referenced parts would also apply the bores in other model drawings, which
is not the case when you use them in a dependent assembly. However, if the original drawing is changed, (e.g. by
applying bores, but also ba adding or deleting parts), these changes will be taken over into the dependent
assembly.
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Parametrics (HCM)

Service Pack 2 2019 (V 2402)

Effect of HCM on assemblies
In previous versions, isolated points in assemblies were interpreted as movable points, so the HCM attempted to
move the HCM assembly containing the HCMmodel as soon as such points occurred in constraints. This behaviour
has now been changed.

The geometry of parts, in particular isolated points of assemblies, will be interpreted as "fixed" by a HCM model
existing in a contained part. Constraints between these geometries and the part coordinate system of the contained
part can no longer be set. Already existing constraints will, of course, be preserved.

However, constraints between the geometry and its sub-parts can still be set, which allows you to determine the
position of the sub-parts.

Sketch HCM: Configuarble use of external references
In the Sketch HCM the constraints will now take into account whether the use of external references has been activ-
ated or deactivated. An external reference exists if a HCM constraint refers to a part that does not belong to this
sketch.

In existing sketches the use of external references is active by default, in order to keep the existing behaviour of
these sketches. Created new sketches behave according top the settings specified in the Configuration
Editor: The value chosen at System settings > Sketch HCM > Use external references determines your default
value. After new installations, external references are not used by default.

If you right-click on the empty area of the HCM window of the ICN, a context menu with the options External ref-
erence: Use or ... do not use, respectively, will be displayed, which shows you the current setting for external ref-
erences. After choosing this option, a dialogue window will be displayed, allowing you to choose between the
settings Use and Do not use.

Point option M in new positional and dimensional constraints in sketches
When defining new positional or dimensional constraints in sketches or 3-D sketches, the point option (M) Mid-
point of edge will now no longer be suggested by the Autopilot, as this point option is only rarely used in practice.

However, it is still possible to select this point optionmanually.
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Redesigned HCM window in the ICN
The HCM window for the display of constraints in sketches and 3-D assemblies in the ICN has had a redesign, now
featuring a new, modern Look & Feel and a multi-column display.

Also, you can now use filters such as Deactivated constraints or Constraints with external references, or the new
function Zoom to constraint.
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Placing of HCM dimensions in case of geometry changes
In older versions, HCM dimensions in sketches were placed with regard to their first base point. In case of geometry
changes, the new dimension was placed in such a way that the length of the projection line of the first base point
was identical to the length before the change, which frequently lead to unsatisfactory results. From SP2 onwards,
the placement logic is different. The length of the shortest projection line after the change is now identical to the
length of the shortest projection line before the change. In the process, cases may occur where the shortest pro-
jection line could be applied to different base points.

Example:

In the original sketch (1) the marked HCM dimension is changed from 140 to 170. (2) shows the result in HiCAD
2019 SP2, (3) shows the result in HiCAD 2018.
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Changing HCM constraints while dialogue window is open
Youcan now change HCM constraints directly in the model drawing even while a dialogue window is open. This con-
cerns, for example, the dialogues of the functions Extruded solid , Revolved solid , C-edge sweep, Subtract or
Add.
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Automatic assigning of HCM constraints for isolated points in sketches
If the HCM setting Enter constraints is active, positional constraints will be automatically set when creating isol-
ated points in planar sketches or 3-D sketches. These depend on the chosen point option:

n Snap point (I) and Centre (Z): Coincidence

n Online to edge through point (O) and Online to edge through point (D): Coincidencewith the relevant edge

n Mid-point of an edge (M): Mid-point and Coincidence

n Quad point (Q): Equal distance to X-and Y-axis and Coincidence with circle

Performance
n Recalculations in model drawings containing parts created with older HiCAD versions are now performedmuch

faster: In tests we couldmeasure a speed increase of more than 30%.

n The performance has also been increased for working with sketches with thousands of graphical elements
while the HCM is activated.

Selection order for constraints
When creating a constraint that has not yet been fulfilled at the time of its creation, graphical elements or parts
need to be transformed.

A good example for this would be a Parallel constraint between 2 non-parallel edges. In previous versions, one
could not tell which of the two affected parts needs to be rotated in order to fulfil the constraint (except for cases
where one of the parts has been determined by further constraints).

This behaviour has now been changed in such a way that the first selected element will not be transformed if pos-
sible.

For Symmetry constraints, HiCAD will attempt to preserve first the symmetry axis, and then the first selected ele-
ment.

For Mid-point constraints, the order of the queried elements has been changed: First, two elements, and then the
mid-point will be requested. Accordingly, the mid-point instead of the selected elements.
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Service Pack 1 2019 (V 2401)

Highlighting of HCM constraints
When you select a HCM constraint in the ICN, the sketch elements affected by it will be highlighted in your draw-
ing. If the display of constraints has been deactivated, the concerning constraint will be displayed. If the constraint
refers to an axis, plane or the origin of a coordinate system, these will also be displayed.

Example: The constraint "Parallel" between the line and the XZ-plane has been selected.

The highlighting will remain until you choose a different constraint or a different part.

Position of symbol for parallelism constraints of circles and ellipses
When the display of positional constraints for sketches has been activated, the symbol for parallelism of circles and
ellipses placed parallel to a plane is no longer shown in the centre, but next to the circle/ellipse. This concerns both
full circles/ellipses and arcs.

Excluded here are ellipses in planar sketches, if the parallelism refers to the main axis. Here, the symbol for the pos-
itional constraint will still be shown at the centre of the ellipse.
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Editing of HCM constraints via "Process sketch" Feature in ICN
The editing of HCM constraints in sketches of a Feature step is now also possible if the editing of the sketch has
been started by choosing Edit sketch for a Feature in the Feature log.

In previous versions this was only possible if the editing of the sketch was started by the opening of the dialogue win-
dow of the feature, and choosing Sketch > Process sketch.

HCM calculations on mirrored parts
In previous versions it could happen in certain constellations that the HCMmodel reacted in an unexpectedmanner
when perfoming mirrorings on one of its parts.

This behaviour has now be corrected, so that this problem no longer occurs.

Displayed references to Sheet Metal parts in the ICN
If you use HCM constraints in conjunction with Sheet Metal parts, references will often refer to flanges or bend
zones. In older versions, the reference was often displayed as "Sheet flange" or "Bend zone" in the HCM window of
the ICN.

Now, such reference are always displayed as "Sheet Metal", i.e. the entire sheet:

Marking colour for HCM dimensional constraints configurable
Selected HCM dimensional constraints are now highlighted in the drawing by the special colour Marking 5 (default:
Orange).

You can change this colour via the Colour Editor if desired.
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Message displayed if functions were not applied
If the functions Automatic positional constraint or Automatic dimensional constraint have not created any con-
straints, an appropriate message will be displayed:

Rotatory degrees of freedom moved to mid point of graphical elements
While the display of degrees of freedom in sketches is active, rotatory degrees of freedom will now always be shown
on the mid point straight lines, circular arcs or elliptic arcs.

Performance
Through various optimizations the performance of HiCAD with regard to the loading of model drawings containing
very many HCM constraints could be increased significantly.

Automatic positional constraints: Also on Part CS

The Automatic positional constraints function for planar sketches and 3-D sketches now contains, beneath
the Parallel option, the additional Also on Parts CS option.

If this option has been activated, line elements running parallel to an axis (or, in 3-D sketches, also parallel to a
plane) of the Part CS, will be assigned a Parallel constraint with regard to it. If you deactivate this option, HiCAD will
show the same behaviour as previous versions, i.e. no parallelisms with regard to axes or planes of the Part CS will
be considered, just parallelisms of lines.
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Sketch HCM: Align to CS axis
The positional constraints for planar sketches and 3-D sketches were expanded by the new constraints Align to CS

axis . This constraint replaces the previous constraints Align to X-/Y-/Z-axis.

If you apply this positional constraint to a straight line of a sketch, HiCAD determines to which CS-axis the straight
line has the smallest angle. A Parallel constraint will then be applied to this axis.

For planar sketches you can also apply this constraints to 2 points. In this case the angle between a virtual straight
line running through these 2 points and the CS axes will be considered. An Equal distance constraint with regard to
this CS axis will then be applied for the 2 points.

Preserve chirality
When changing dimensions, this could result in an unwanted switching of the chirality in previous HiCAD versions.
In other words: While the positional and dimensional constraints were preserved, the direction of measurement
could change unexpectedly.

This effect can be demonstrated by way of a very simple example of the two panels shown below:

The left panel has been fixed. Both panels are kept on one plane by means of Coincidence constraints, and a
Distance constraint defines a fixed distance between the edges on the borders of the 2 panels.
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If you increased the width of the left panel by 200mm in older HiCAD versions, the result looked as follows:

Formally speaking, this is still "correct" - the two edges still have a distance of 100 mm. However, this isn't usually
the intended result.

From HiCAD 2401 onwards, it will be attempted to preserve the chirality after applying changes to the HCM system
- here, the intended result looks as follows:
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Display positional constraints with references to CS axes and planes in sketches
Positional constraints containing a reference to an axis or plane of the coordinate system will now be given par-
ticular attention: For instance, a parallelism constraint referring to the X-axis of the Sketch CS will not just be listed
as Parallel in the ICN, but as Parallel to X.

Also, the symbols of the positional constraints will be displayed both in the ICN and (if the display of positional con-
straints in sketches has been activated) and in the sketch:

In this sketch you can see immediately that in this 3-D sketch the circle, for instance, has been fixed to the X-axis
via a tangential constraint, and the lower line runs perpendicular to the YZ-plane.
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Major Release 2019 (V 2400)

Selective automatic assigning of constraints in the sketch HCM
If the Enter constraintssetting has been activated in the Sketch HCM, no distinguishing was made between "nor-
mal" constraints and constraints with external references in previous versions. To avoid errors in the design it may
help in some cases not to work with constraints with external references. In this case the automatic assigning of
constraints during drawing of sketches could not be used.

HiCAD 2019 offers the new option Use external references:

If this checkbox is deactivated, constraints that would contain external references will no longer be automatically
created. This option is deactivated by default, which would be identical to the behaviour of HiCAD before Version
2019.

References to immediately superordinate parts or assemblies are not regarded as external references and will there-
fore be created even if the Use external references checkbox has been deactivated. An example of this is a sketch
for a subtraction: If this sketch is located immediately beneath the part to which the subtraction is to be applied, it
can still automatically obtain distance constraints to the edge of the part, e.g. when using the Offset function.
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Switching of coordinate system during processing of 3-D sketches
When assigning constraints to a 3-D sketch, the Sketch HCM has always referred to the Part CS of the 3-D sketch.
However, the active coordinate system was still displayed in the process, which could be rather confusing.

This has been changed now, so that the Part CS will automatically be displayed on a 3-D sketch when you choose a
function that normally uses this type of coordinate system. After applying the changes, the display will switch back
to the previously used coordinate system.

The behaviour of the Part HCM and the constraints has not changed; this change refers only to the display of the
coordinate system during assigning of constraints.

Consistent display of parametric dimensions
In previous versions the configurations available via the ParConfigComp.exe tool contained different configurations
for the display HCM constraints and symbols. These inconsistencies have now been removed, so that the same set-
tings are now used in every configuration:

n Font size for HCM constraints: 2.5

n Size of symbols for positional constraints: 20 pixel

n Decimal places for other dimensions: 2

Automatic updating
You have now the option to automatically update HCM models of superordinate assemblies when you apply
changes to a part. This function can be activated or deactivated in the 3-D Part HCM Settings dialogue window.

After new installations this function is activated by default; after update installations, in contrast, it will be deac-
tivated in order to keep the behaviour known from previous versions.

Improved UNDO in sketches with HCM model
When using the UNDO function on sketches, HiCAD no longer distinguishes between sketches with and without
HCM constraints, i.e. a step-by-step UNDO is now also possible for sketches with automatic HCM constraints. The
number of UNDO steps is unlimited.

This applies to both planar sketches and 3-D sketches.
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Display of degrees of freedom in model drawings

The 3-D Part HCM and the Sketch HCM now offer the new Toggle visibility of degrees of freedom func-
tion. This function allows you to switch the display of the degrees of freedom in the current HCM system in a draw-
ing on or off.

If the display has been activated, arrows indicate how many and which axes are still available for possible move-
ments and rotations.

Extensive descriptions of these functions and the meaning of the displayed arrows can be found in the relevant
Help chapters for the Sketch HCM and the 3-D Part HCM.
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Revised display of HCM constraints in the ICN

The HCM window in the ICN has been revised with particular focus onmore user-friendliness. The changes include:

n New symbols for constraints.

n Geometries are shown in the same order in which they are shown in the part structure.

n Parts that are fixed or fully defined are marked with a corresponding symbol in the listing.

n Entries like "Condition fulfilled" or "Fully defined" are no longer explicitly listed.

n Constraints can be deleted via the DEL button. The shortcut CTRL+A selects all constraints.

n The toolbar now contains a button that allows you to switch between the "Sort by geometry" and "Sort by con-
straints" mode.

n Constraints with external references are indicated by a red "e" on their icon.

n The indication of errors in the HCM and in the Feature log have been standardized.

n You can now fix parts and assemblies via context menu function.

The changes for sketches are described here.

Positional constraint "Equal distance" also available for 3-D sketches and assemblies

The positional constraint Equal distance can now be applied not only to planar sketches, but to 3-D
sketches as well.

The Equal distance constraint is now also available in the 3-D Part HCM.
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Redesigned HCM function groups
The structure of the Ribbon tabs has been optimized, so that the most frequently needed HCM functions are now
directly available and need no longer be called from sub-menus.

You have now direct access to functions for dimensional constraints in X-, Y- and Z-direction (with the latter, of
course, being not available for 2-D parts), as well as to Coincidence, Parallelism, Right angle and Fixing con-
straints.

Display of AutoConstraints in ICN
Positional constraints that have been created via the Automatic positional constraints function can now be found
beneath an item called AutoConstraints. If desired, you can move these constraints out of this item via Drag &
Drop , or choose the context menu function Remove from AutoConstraints to move the constraint out of the
AutoConstraints item and list it among the "normal" constraints instead.
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Positional constraints for free-form curves removed
The positional constraints for free-form curves, i.e. Equal parameters, Equal direction, Equal 1st/2nd derivation
and Equal bend have been removed.

Comments for HCM constraints
You have now the option to specify Comments for HCM constraints in composite edges and in 3-D assemblies.
These have no influence on the model; their purpose is to describe the meaning of individual or all constraints, espe-
cially in larger model drawings.
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On the HCM tab of the ICN, expand the individual constraints and double-click the Comment entry. You can then
specify a text for the Comment, which will then also be displayed after the designation of the constraint.

To delete a comment text again, double-click the Comment again and remove the text in the dialogue window and
confirm with OK.
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Configuration Management

Service Pack 2 2019 (V 2402)

Settings from ABWPAR.DAT and ABWCOL.DAT moved to Configuration Editor
The settings from the system files ABWPAR.DAT and ABWCOL.DAT have beenmoved to the Configuration Editor.

You can now find the settings from those DAT files in the following directories:

ABWPAR.DAT Sheet Metal > Sheet development

Sheet Metal > Default setting

Compatibility > Sheet development up to HiCAD 2016

ABWCOL.DAT Compatibility > Sheet development up to HiCAD 2016 > Extended settings

Reset all values in a node
In the Configuration Editor you have now the option to reset changed values for a defined node within the tree struc-
ture in one step.

For instance, if you have modified the default settings of the dimensioning rules in various directories, you can right-
click the Usage-dependent entry, choose Reset, and, after confirming the security prompt with, restore the mod-
ified settings to defaults again. If you confirm with Yes , a backup ([Installation directory] > Configuration >
HiCAD.cfgdb.[Date]) will be created, in case you may require the modified settings later again. If you choose No,
the values will be reset without creating a backup.
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Service Pack 1 2019 (V 2401)

User-friendlier catalogue selection option
The entries for Material selection at Steel Engineering > Default material > Table ID for default material and Item
ID for default material have been replaced by a more convenient catalogue selection option.

Sorting of the ICN
The settings for the sorting of the ICN entries are no longer relevant for the new 2-D and 3-D ICN. The cor-
responding setting options have therefore be removed from the Configuration Editor.

All entries can now be directly sorted in the new ICN.
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Major Release 2019 (V 2400)

Settings of TABPAR.DAT moved to Configuration Editor
The settings from the TABPAR.DAT file for a working with a tablet computer as input device and the specification of
the time interval for double-clicks have been moved to the Configuration Editor (ISDConfigEditor.exe). The file has
been withdrawn with the release of HiCAD 2019, since tablet computers as input devices are no longer supported.
The Time interval for double click parameter can now be specified in the Configuration Editor, namely, at System
settings > Identification.
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Bill of Materials / Report Manager

Service Pack 2 2019 (V 2402)

New parameters for section schemas in BOMs
In the Configuration Editor at Steel Engineering, two new parameters for section schemas in BOMs are now avail-
able:

Cutting angle reference in section schema

Here you can choose to which leg a specified angle in the section schema is to refer:

n Cross-section or

n Beam axis

Do not show cutting angle in section schema if cut surface

Use this parameter to specify the conditions under which no cutting angle is to be shown in the section schema,
since the total length does not correspond to the trimmed length:

n The cut surface has been processed.

n The cut surface has been processed on one outer side or on both outer sides.

What's new? 161 / 386

News Overview



Service Pack 1 2019 (V 2401)

Plant Engineering BOMs
In Plant Engineering BOMs you can now find the new Pipeline (Attribute: %PipeLineName) column that indicates
the pipeline to which the respective part belongs. The default template for plant Engineering BOMs, Anlagenbau_
ohne_DB_SZN.rms (HiCAD sys directory) and the corresponding EXCEL template in the BOMTemplates folder
have been adjusted accordingly.
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Major Release 2019 (V 2400)

Further Excel templates for P+ID BOMs
More templates for BOMs based on P+ID projects are now available.

Loose parts and bar lists in BOMs via product structure
You have now the option to configure the behaviour of Excel BOMs created on the basis of HELiOS product struc-
tures with regard to so-called "loose parts", i.e. parts that belong to no assembly: You can either show these parts as
individual parts, or combine them into one set. You have also the option to change the name of such a set.
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Also, the new Report Manager template PRODUCT_ ISD_ HiCAD has been added to the existing template
PRODUCT_ISD. The new template contains table sheets for bar lists and bar list summaries.

QOMET-specific BOMs
HiCAD 2019 supports the output of COMET-specific BOMs. QOMET is an ERP system developed specifically for use
in the field of Steel andMetal Engineering.

The BOMs can either be output for the entire drawing or only for the active part, and have special columns in the
Excel Steel Engineering BOM (hicad_Stahlbau.xlsc ) that are relevant to the QOMET system. The BOMs will be out-
put in the CSV format.

The function for the output of these BOMs can be found at Drawing > Save/Print > Save as.. > Further...:

also see HiCAD Basics - What's New?

Pre-mounted assemblies in BOMs
When working with pre-mounted assemblies in practice, you sometimes want only the assemblies, but not their
sub-parts to be shown in BOMs. This can be achieved via the article attribute COMPONENT_PREINSTALLED,
which needs to be assigned to the article master of the pre-mounted assembly.

also see HiCAD Management + BIM -What's New?
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Variant Editor

Service Pack 1 2019 (V 2401)

Changing the part type ID during automatic deriving of variants
From HiCAD 2019 SP1 onwards, you can also change the part type ID, and thus also the classification of a VAA and
a PAA file when automatically deriving variants.

The attribute assignment file (attribute_assignment.csv) supports the pseudo attribute VAREDIT_KEEP_DB_IDS
for this purpose.

If this attribute has the value 1, the previous HELiOS IDs will be preserved during automatic deriving. i.e. no "actual"
deriving takes place. From a HELiOS perspective, the resulting VAA or PAA file refers to the same parts. This is help-
ful for the adjustment of existing VAAs or PAAS, especially in conjunction with VAREDIT_MOVE_ON_SUCCESS.

Also, it is now possible to map the attribute ARTSCHLUESSEL (Type key) to a column in the file customer_list.csv.
In this column the part type ID of the VAA or PAA file must then exist in the format AAAAA_BBBBBBB, with AAAAA
being the coding for the industry according to anbtlken_top.dat and BBBBBBB the ID according to anbtlken.dat.

If the format should not be correct, the message

Classification not in the format AAAAA_BBBBBBB, with A = Industry and B = ID

will be issued in the output column.
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VariantenEditor.exe - Revised file dialogue windows
The file dialogue windows of the Variant Editor for VAA files have been adjusted to Windows 10. This concerns the
following Editor functions:

n Derive new,

n Open,

n Import,

n Export and

n Select graphic preview.

The relevant dialogue windows now corresponds to the file dialogue windows in HiCAD.

A detailed description of the Open variant file dialogue window can be found in the Dialogue for Opening
and Saving of Files topic of the HiCAD Basics Help.

166 / 386 What's new?

Variant Editor



Attribute assignments - Take over attributes for all languages
When you changed attribute assignments via the A button and confirmed with OK without adjusting the attribute in
all languages in HiCAD 2018 (or older versions), the Variant Editor issues an appropriate message and entered the
text <text_input> into the corresponding fields.

From HiCAD 2019 onwards, changed attribute assignments can be automatically be taken over to the other lan-
guages. If any attributes are missing, the following message will be displayed:

If you choose Yes, the attribute from the first language, in which has a value, will be transferred to the cor-
responding fields of the other language, if these are empty; otherwise, the current content of the field will remain
unchanged.

If you choose No, the text <text_input> will be entered in the corresponding fields of the other languages.
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Use of existing attribute masters of variants with varying sub-types
In cases where Plant Engineering variants with existing HELiOS article masters had to be used for the deriving of
variants with varying sub-types, HiCAD 2018 only provided the possibility to enter, for each sub-type, a matching
HELIOS URL directly during part data synchronization. This process is not only very tiresome, but also requires the
necessary permission to create article masters in HELiOS at all.

The latter, in particular, may prove problematic in configurations in which HELiOS obtains the article masters "down-
stream" by other ERP systems. To provide help in such cases, the mechanism for automatic deriving has been
enhanced in HiCAD 2019. The Head IDs can now also be directly provided in the customer_ list.csv (=cu-
ustomerlist.csv) file.

For this purpose the new pseudo attributes

n VAREDIT_SUB_ID

n VAREDIT_GENERAL_ID and

n VAREDIT_MOVE_ON_SUCCESS

are available.

An example:

The following CSV file describes two VAAs, each with three sub-types. The sub-types are identified by their Type_ID
here , i.e. through the HELiOS attribute HEL_TYPNAME. For each sub-type, one Head ID is provided for the gen-
eral type, and one Head ID for the sub-type itself.

VAA name Derived Type_ID Customer_GENERAL_ID Customer_SUB_ID

Pipe Pipe_derived 001 B0YHQHXIS0LVFL00003J7M B0YHQHXIS0LVFL00003J7P

Pipe Pipe_derived 002 B0YHQHXIS0LVFL00003J7M B0YHQHXIS0LVFL00003J7Q

Pipe Pipe_derived 003 B0YHQHXIS0LVFL00003J7M B0YHQHXIS0LVFL00003J7R

Elbow Elbow_derived 001 B0YHQHXIS0LVFL00003J7N B0YHQHXIS0LVFL00003J7S

Elbow Elbow_derived 002 B0YHQHXIS0LVFL00003J7N B0YHQHXIS0LVFL00003J7T

Elbow Elbow_derived 003 B0YHQHXIS0LVFL00003J7N B0YHQHXIS0LVFL00003J7U
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In the attribute mapping file attributzuordnung.csv (=attributemapping.csv) these data can be mapped to the VAA
attributes as follows:

VARED IT_VERBATIM_MARKER ;# ;

VARED IT_BASE_VAA ;VAAName;

VARED IT_DER IVED_VAA ;D er i ved ;

VARED IT_OVERWR ITE_EX ISTING_VAA ;#1 ;

VARED IT_ LANGUAGE_CODE ;#1031 ;

VARED IT_BASE_D IR ;#Pat h \ t o\ P lan t Pa r t s ;

VARED IT_DER IVED_D IR ;#Pat h \ f or \ der i ved \ VAAs;

VARED IT_STOP_ON_UTO_ERROR ;#0 ;

VARED IT_ LST_FILE_NAME;#Aut oD er i ved ;

VARED IT_OUTPUT_FORMAT;#SYLK ;

VARED IT_CLUSTER ING_KEY ;VAAName

VARED IT_SUBTYPE_KEY ;HEL_TYPNAME

HEL_TYPNAME;Typ_ ID

VARED I T_SUB_ ID ;C ust omer_SUB_ ID

VARED I T_GENERAL_ ID ;C ust omer_GENERAL_ ID

The pseudo attribute attributes VAREDIT_SUB_ID and VAREDIT_GENERAL_ID ensure that the Head IDs from the
customer_list.csv file are transferred into the VAAs.

The pseudo attribute VAREDIT_MOVE_ON_SUCCESS ensures that, after successful generation of all files, these
files will be moved from DERIVED_DIR to BASE_DIR. For files that already exist in BASE_DIR, a backup with the
file extension .bak will be created.

To transfer the VAA files prepared in this way to HELiOS, the tool DBPlantDataImport.exe must be called with the
parameter /X. This allows a Plant Engineering compliant adjustment of existing article masters.

n It is assumed that document masters may be created. These are created for each VAA.

n The links between the article masters and to the document masters will be added.

n Article attributes will be overwritten. The values for attributes that are not relevant for Plant Engineering will
remain unchanged.

The DBPlantDataImport.exe tool allows the removal of already transferred variants. When DBPlant-DataIm-
port.exe is called with the parameter /X, only the document master will be removed. Article masters will remain
unchanged.
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Interfaces

Service Pack 2 (V 2402)

IFC Import/Export - ZIP files
HiCAD 2019 SP2 supports the import and export of zipped IFC files (file format .IFCZIP).

IFC Import/Export - Consider coordinate system
IFC data are often located far away from the origin of the coordinate system. However, HiCAD and other CAD sys-
tems require coordinates that are close to the origin. The necessary coordinate system transformation can now be
realized for both import and export. For this purpose a corresponding checkbox has been added to the dialogue win-
dows:

n Import - Transform IfcSite to origin
If this checkbox has been activated, IfcSite (top element icl. sub-elements) will be transformed to the origin.
The original coordinate system will be saves as Fitting CS with the name IfcSite in the Feature of the IfcSite
assembly.

n Export - Consider IfcSite CS
If this checkbox has been activated, the data model will be transformed to the Fitting CS with the name IfcSite
saved in the Feature of the IfcSite assembly (top assembly), if any.

IFC Import/Export - Show report
For the import and export of IFC files a report listing possible errors, warnings and other information can now be dis-
played. For this purpose a corresponding checkbox has been added to the dialogue windows.
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Click on an entry in the report to view further information on an object. Click on the Save report button to save the
report as CSV file.

SketchUp export
The export of HiCAD drawing to the SketchUp format (.skp) could be speeded up significantly in HiCAD 2019 SP2.
In test examples the time required for exports could be reduced from several hours to less than one minute.
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DSTV-NC export to CAM format
For the export of the DSTV-NC data to the CAM format, an API-based solution in conjunction with the existing DSTV-
NC interface is currently available.

This solution is currently only based on a script and has not been made generally available yet.
After a successful test phase the CAM export is to be made a standard functionality. If you would
like to take a look at the script in advance, please contact our Consulting team.

The configuration of the attribute output takes place directly in the API script. The DSTV-NC export parameters, too,
can be set in the script. The script works as follows:

n Creation of the DSTV-NC files

n Creation of the header data (attributes and part structure)

n Merging of files into one CAM file
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Cadenas PartSolutions and BIMCatalogs
The insertion dialogues that you can use directly on Cadenas Parts4cad or BIMcatalogs.net have been revised and
improved.

The corresponding windows always show the current status of the catalogues on the external server.

With an additional option under Extended settings at the bottom of the dialogue window, you can also specify
whether you want direct real-time access to the Web service or local intermediate storage in your HiCAD system
(recommended).

3D PDF, Universal 3D, Product Representation Compact - Export of exploded layouts
Exploded layouts, too, can now be considered for export as

n 3D-PDF (*.PDF)

n Universal 3D (*.U3D) and

n Product Representation Compact (*.PRC)

files. The Configuration Editor and the export dialogue have been expanded accordingly for this purpose. In the Con-
figuration Editor at Interfaces the Consider exploded layouts checkbox is available for the above formats.

The same checkbox is available in the corresponding export dialogue window: 
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The parts will be shown in an exploded layout. Mounting tracks, too, will be exported, their colour will be taken from
the model drawing. Line type and layer, however, will not be considered.

Performance for IFC export
A performance increase by a factor of up to 5 could be achieved for IFC import and export.

Furthermore, a downsizing of exported files by a factor of up to 8 compared to older HiCAD versions could be
achieved.

For drawings with many identical parts you can use the option Output identical parts as referenced parts when
exporting, which combines the same parts as referencing and thus reduces the amount of data.

STL

The insertion of STL files in an active HiCAD Drawing via Drawing > Insert Part > STL Format has been adap-
ted to the current algorithm and functionality of the import dialogue for STL files.

At this point, you can also use the Separate parts option to insert separate parts instead of a coherent solid prim-
itive.

In addition to an increase in performance, it is also possible to insert binary STL files into the drawing.

174 / 386 What's new?

Interfaces



Major Release 2019 (V 2400)

Update to CADfix 12
With the update to CADfix 12 the following format versions will now be available to HiCAD:

n CATIA V5 2018

n NX 12

n SolidWorks 2018

n Creo 5.0

n JT v9.0

STL Import

Previously, ASCII based STL files have been applied via Drawing > Insert Part >  STL Format in HiCAD.

As of HiCAD 2019 you are able to read ASCII based as well as binary STL files via the import dialogue window Draw-

ing > New/Open > Open > Step, Iges

Select STL files (*.stl) as format.

Further import options are available by clicking on the respective checkbox to either activate AutoOptimise or
insert Separate parts instead of coherent solids.
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IFC
HiCAD 2019 supports the IFC4 format for import and export.

The IFC format version (IFC2x3 or IFC4) can be chosen in the Configuration Editor at Interfaces > IFC > Interface
version

Furthermore, the performance of the IFC export has improved significantly.

The export in IFC format has been enhanced with the option to export displayed parts only instead of the whole draw-
ing.
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NCX Export of saw cuts
The NCX Export has been enhanced with two options for the optimum handling of saw cuts:

In order to avoid undesirable outcome, it is possible to prefer the bottom plane when exporting by activating the
checkbox

It is also possible to export cut angles for flat sheets as such. (In previous versions, cut angles have been exported
in 90° and the deviating real cut angle has been realized as saw cut afterwards)
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Save 2-D part in DWG format
Apart from saving in DXF format, you can save 2-D parts in DWG format by clicking on Drawing > Save/Print

> Save as... > 2-D part DXF/DWG and select AutoCAD (*.dwg) in the following dialogue window.
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QOMET-specific BOM
HiCAD 2019 supports the export of QOMET-specific BOM. QOMET is an ERP system specialised in steel and metal
engineering.

The BOM can either be exported for the complete drawing or active part and contains particular columns of the
Steel Engineering Excel BOM (hicad_Stahlbau.xlsc ) that are relevant for the QOMET system in particular. The file is
exported in the CSV format.

The respective functions for exporting the BOM are available under Drawing > Save/Print > Save as... > Fur-
ther > ... .
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Free general access to PARTS4CAD
As of HiCAD 2019 you are granted with free access to more than 500 manufacturer's catalogues via the web cata-
logue parts4cad by Cadenas. The access to the extended catalogue range (DIN/ISO/EN… Norms + all 800 man-
ufacturer's catalogues) is fee-based.

Export of Sheet Metal parts
The functions for data exchange available at Sheet Metal > Sheet development have been optimized in HiCAD
2019. The following functions are available here:

Export individual development

Develop and export sheets

Export sheet developments

You can choose between the following formats:

n DXF/DWG,

n XML for CADMAN-B (from Version 7.5) by LVD and

n GEO for ToPs GEO

Extensive information can be found in the HiCAD Sheet Metal Help.
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DSTV-NC
n From HiCAD 2019 onwards, DSTV Interfaces can be activated with any module that is based on HiCAD creator

or HiCAD solution.

n When carrying out exports via DSTV-NC interface, rectangular subtractions running diagonally through the part
will also be considered:
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Sheet Metal

Service Pack 2 2019 (V 2402)

Settings from ABWPAR.DAT and ABWCOL.DAT moved to Configuration Editor
The settings from the system files ABWPAR.DAT and ABWCOL.DAT have beenmoved to the Configuration Editor.

You can now find the settings from those DAT files in the following directories:

ABWPAR.DAT Sheet Metal > Sheet development

Sheet Metal > Default setting

Compatibility > Sheet development up to HiCAD 2016

ABWCOL.DAT Compatibility > Sheet development up to HiCAD 2016 > Extended settings

Sheet corner Design Variant
The two Design Variants Sheet corner with stiffener (riveted) and Sheet corner with puzzle piece have been
revised and combined into one function. This also allows the insertion of sheet corners without stiffener.

The insertion of these Sheet Metal Design Variants takes place via the Civil Engineering functions docking window

at Sheet Metal > Sheet corner with stiffener or puzzle piece . In the displayed dialogue, you can then
choose between clicking on the Stiffener or Puzzle piece icon.
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Sheet
corner
with
stiffener

Use this Design Variant to create a sheet corner with or without stiffener between 2 sheet flanges.
The flanges can have different lengths and different bend angles.

For insertion, identify the two front sides of the flanges. Activate the Use stiffener checkbox if you
want to create a riveted connection. From a multitude of available fasteners (e.g. SFS or Tit-
gemeyer) select the one you need.

Sheet
corner
with
puzzle
piece

Use this Design Variant to create a sheet corner with a puzzle piece between 2 sheet flanges. The
flanges can have different lengths and different bend angles.

For insertion, identify the two front sides. The connection will be applied to the last identified
flange. If you want a laser cut-out, activate the corresponding checkbox and enter the laser beam
diameter for the cut out. If required, change the parameters of the puzzle piece.

After entering all required data you can create the connection. Click Preview to check and, if required, modify the
connection. If you click Apply, the sheet corner will be created, and the dialogue window remains open, allowing

you to change the data or to switch to the other sub-variant, i.e. Puzzle piece or Stiffener . the data
to other sheet corners. If you click OK,the connection will be created, and the window will be closed. Clicking
Cancel closes the dialogue window and discards the data without creating the connection. .

Incorrect inputs are marked with this symbol . When you move the cursor over the symbol an error message will
be displayed.

If the function cannot be executed with the entered data, this symbol will appear at the OK button. When you
move the cursor over the symbol an error message will be displayed.

Sheet corner with stiffener

What's new? 183 / 386

News Overview



Sheet corner with puzzle piece
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Folding with milling edge zone
Composite sheets, such as ALUCOBOND panels, are folded along milling edges. The resulting milling edge zones

differ geometrically from the cylindrical bend zones. Therefore, the Fold flange function now offers the addi-
tional option to choose milling edge zones andmilling tools.

The following options are available:

Bend zone

The bend zone has the specified bend radius.

Milling edge zone

Bend zone with the selected tool (milled inside).

Milling edge zone inverted

Bend zone with the selected tool (milled outside).
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(1) Fold line defined by sketch, milling edge zone with groove form 90°

(2) Fold line on straight line (mid point of flange), milling edge zone with groove form 135°
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Bend zone ends suitable for milling
Some CAM systems (e.g. CobusNCAD) do not support arcs at bend zone ends. To create bend zones suitable for

milling, you can now use the Trim corner function to trim transitions with two or three milling edge zones in
your sheet metal drawing. First activate the icon for the number of milling edge zones to be trimmed and then
identify the milling edge zones. This creates 2 straight lines as an extension of the flange edges converging in the
milling edge zone.

The ALUCOBOND SZ 20 cassettes were edited with the new Trim corner function having bend zone ends suitable
for milling.

Trim corner, 2 milling edges

(1) Original situation

(2) View of original situation in the bending simulation (top view)

(3) Trimmed milling edge zone (top view)

Trim corner, 1 milling edge zone

(1) Original situation

(2) View of original situation in the bending simulation (top view)

(3) Trimmed milling edge zone (top view)
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Corner processing/Mitre
With composite panels (e.g. ALUCOBOND) it is often necessary to process the edges in such a way that a milling
edge occurs. For this reason, it is now possible to finish these flanges in Corner processing/Mitre within one sheet

or between different sheets .

With the modes Mitre cut and Mitre cut, with neighbours you are allowed to select the option Sheet edge as

milling edge for fitting parameters. For the Groove form you can choose the matching milling tool from the
Composite panels, groove form catalogue.

(1) Composite panels before processing

(2) After processing, mode Mitre cut, flanges with milling edges

(3) After processing, mode Mitre cut, with neighbours, flanges with milling edges, milling edge zone linear
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Sheet from circular arc

When using the function New sheet along sketch for the creation of a sheet from only one circular arc, one
short, tangentially connected straight line element needed to be added at one end of that circular arc.

To simplify things, this element will now be added by HiCAD automatically as a flange (double tolerance, i.e. 0.002
mm) at the start of the circular arc.

(1) Tangentially connected flange, 0,002 mm
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Development

Visualisation of direction arrow when cutting ALUCOBOND trays to size

In previous versions the direction symbol for the processing direction was not visible in the DXF export if it was loc-
ated on the rear side of the sheet development. On facade trays (e.g. ALUCOBOND trays) the direction symbol is
often located on the front side of the trays. The development will then be carried out from the rear side in order to
display the milling edges. Here, too, the direction symbol would not be visible in the export.

To visualize the direction symbol on the other sheet side, choose Sheet development > Update> Default setting
and then, in the opened dialogue window, click on the Extended settings icon. In the next dialogue window, open
the Extended representation tab and activate the Always show direction symbol on both sheet sides checkbox to
copy the symbol to the other side of the sheet.

Favorites for developments

If you choose Sheet alignment: Automatic in the Create sheet development dialogue window and select
the Favourite COBUSNCAD, the option Invert upper side: About x-axis will now be set.
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Changes to Favourites only affect initial installations; Favourites remain unchanged. Existing Favourites in an
update installation remain unchanged.
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Eternit
HiCAD now also supports the placing of Eternit panels .

Eternit semi-finished product data

The semi-finished product data for Eternit panels can be found in the Catalogue Editor, at Factory standards >
Sheets > Eternit, where you will find the following tables:

n EQUITONE [linea ]

n EQUITONE [materia]

n EQUITONE [natura]

n EQUITONE [natura] PRO

n EQUITONE [pictura]

n EQUITONE [tectiva]

n EQUITONE [textura]

The semi-finished product dependent part colours are defined in the tables of Factory standards >Surface treat-
ment > Profile and Element Installation > Eternit.

Eternit Tergo / Tergo+ undercut bores

In the Catalogue Editor at Sheet tools > Moulding tools you can find a new table called Undercut bore for Eternit
Tergo und Tergo+ undercut bores.

Insertion in HiCAD takes place in the same way as the other moulding tools (e.g. beadings or vents), i.e. via the

function Sheet Metal > Further Tools > Moulding tools .

(1) Undercut bore

(2) Undercut bore with bolting

Sheet Metal parts with identical cross-sections
The settings for Sheets with identical cross-sections are now available as a sub-entry of Sheet Metal.
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Service Pack 1 2019 (V 2401)

New Z-fold
The new Z-fold function allows you to attach 2 flanges to a sheet with one single working step. As soon as your
inputs are sufficient, a preview of the new flanges will be displayed. That is, if you choose a connecting edge, the
possible Z-fold with the standard values will be displayed. If you have activated Width via point(s), the new flanges
will only be shown after identifying a point and the width, or 2 points, provided that you have chosen the connecting
edge. Furthermore, you will directly seethe change if, for instance, you switch from Shorten, outer to Shorten,
inner. If the Apply immediately checkbox has been activated, the Z-fold will be immediately attached if the value
inputs are sufficient andmake sense, and can then be changed via the Feature log.

The selection of the connecting edge is decisive for the direction of the new Z-fold. After selecting the outer con-
necting edge, a preview of the new flanges will be displayed, provided that you have not activated any options that
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require further value inputs. If the Apply immediately option has been activated, the Z-fold will be inserted imme-
diately. Changes can then be carried out the via Feature log.

If you want to identify a different edge, click on the icon in the Outer connecting edge area and identify the
edge.

If you activate the option for the 1st point , the width of the new folding can be freely selected - irrespective of
the connecting edge. After choosing the 1st point in your drawing, you can set the Width and the Orientation ;

alternatively, you can identify a second point. If you want to choose a different point selection, click on the
icon and identify the point. If the points are located on an edge, this edge will become the connection edge,
provided that you have not identified the connecting edge yet.

If you have activated the Relief groove option, the Fitting mode will only refer to the flange area. If the option has
been deactivated, the Fitting mode (e.g. with shortening of the connecting flange) will refer to the complete con-
necting edge.
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Parameters for Z-fold

If this option has been chosen, you create the Z-fold by specifying
Height and Length. The Radius is loaded from the semi-finished
product in this example. Deactivate the checkbox to change
the Radius.

Here you define the Z-fold by entering an Angle. The first Radius
here is enteredmanually, the second Radius will be loaded from
the semi-finished product.

Here you create the Z-fold via an offset by the sheet thickness.
The Radius will be loaded from the semi-finished product.
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General parameters

The Fitting mode determines the processing of the existing flange.

Shorten, outer

The connecting flange will be shortened if you use this mode. The outer flange surface intersects
with the plane of the front surface before the shortening.

Shorten, inner

The connecting flange will be shortened. The inner flange surface intersects with the plane of the
front surface before the shortening.

Without shortening

The connecting flange will remain unchanged.

For the Mode option you can choose between Bend zone and Milling edge zone. Milling edge zones are in prac-
tice used for composite panels. If you choose Bend zone, you can subsequently assign an Allowance method. If
you choose Milling edge zone, you can subsequently choose a Groove form.

For the Groove form you can choose the matching milling tool from the Composite panels, groove form catalogue

 .

If you have activated the checkmark here, the tool will be assigned automatically.
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Clearance/Relief groove

A Clearance will be created if you attach a flange between 2 points, requiring a shortening of the connecting sur-
face due to the fitting mode. If you right-click on the input field you have the option to pick the clearance from the
drawing.

If the flange is larger or smaller than the connecting edge, and the fitting mode shortens the connecting edge, it
make sense to insert a Relief groove. Enter a Width and a Depth for the relief groove.

Apply/discard inputs

After entering all required data you have the following options: If you click Apply or press the MMB, the new Z-fold
will be inserted into your drawing, but the dialogue window will remain open, allowing you to make adjustments if
required. If you click OK, the Z-fold will be inserted and the window will be closed. If you choose Cancel, the win-
dow will be closed and the specified settings will be discarded. If you have activated the Apply immediately
checkbox, the parameters will be applied on the spot.

Example

(1) Z-fold with length, height and Feature log

(2) Z-fold with angle, width via points and relief groove

(3) Z-fold with offset by sheet thickness
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Sheet along sketch, with non-tangential transitions
The Sheet along sketch function now also considers non-tangential transitions between a straight line and a an
arc. Where the line bends, a bend zone or a milling edge zone will be inserted:

Trim flanges, with negative clearance
When using the Trim functions on flanges or planes you have now the option to enter a negative value for the clear-
ance.

(1) Trimming the plane, Clearance 2 mm

(2) Trimming the plane, Clearance -2 mm
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Bending simulation in sectional views and detail views
When performing bending simulations you can now also identify the edge for the base sheet in the sectional view or
detail view. The bending simulation will then be performed in the original view. This will invalidate the sec-
tional/detail view, which needs to be updated.

If you have selected an edge that was caused as a result of the cut, an error message will be displayed.

(1) Edge for base sheet

Please note:

The identification will not work if the sectional view has been created with the options Unfolded or Only cut sur-
face.

What's new? 199 / 386

News Overview



Development

Line parameters for developments

When you click on the Extended settings button of the Sheet development parameters dialogue window and
open the Edges and lines tab, you will now find new checkboxes for the element types Crosshairs, Embossing
lines, Direction symbols and Powder marking lines.

If the respective checkbox has been activated, the parameters set here will be considered for development. If the
checkbox is deactivated, the pre-setting will be used.

Free edges

If two flanges abut when performing a development without clearance, a new line representing a separating cut will
be inserted in the development. If the front surface of a bend zone directly abuts on a flange, here, too, a sep-
arating cut line will be inserted.

If you do not want to show separating cut lines between flanges, or between flanges and bend zones, deactivate
the corresponding checkbox Extended representation tab.

(1) Separation cut line between flange and bend zone

(2) Separation cut line between flanges
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Representation of sheet developments

You can now select via the Sheet development parameters how a created development is to be displayed: Open
the Extended settings dialogue window, go to the Extended representation tab and choose the desired rep-
resentation from the Displayed as: selection list. The default value is Hidden Line.

The default setting for the sheet development and the changing of the Favourites also affects drawing derivations

for sheets, the export of developed sheets as DXF files and the settings in the Configuration Editor
(Sheet Metal> Sheet development > Default setting).
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Invert axis direction for upper side

When milling composite panels the coated side is normally the bottom side. With the Invert upper side option you
can rotate the upper side to the X- or Y-axis when creating the development.

(1) Sheet metal main part

(2) Upper side inverted, rotated about Y-axis

(3) Upper side inverted, rotated about X-axis
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Export sheet developments as STEP files
The functions for data exchange of sheet developments have been enhanced. Besides DXF/DWG, XML and GEO
you can now also export STEP files.

Export indi-
vidual devel-
opment

This function exports an individual development - either completely or as a section con-
tour.

Develop and
export sheets

Use this function to export the section contour or the complete development of Sheet
Metal parts or Steel Engineering plates. In the process, a temporarily created devel-
opment for the export will always be output.

Export sheet
developments

Use this function to export multiple developments with different parameter settings, e.g.
LVD and Bystronic, of one or different Sheet Metal parts.

For the export of STEP files you have the following options:

Transfer
layers

The layer on which the edge is located (e.g. bend lines on Layer 2) will be transferred during
export.

Transfer
colours

The colour will be transferred during export. If you have deactivated this option, you cannot use
the Export fits information via surface colour option (see below).

Export fits
information
via surface
colour

By activating or deactivating this checkbox you can determine whether fits information are to
be exported by means of a surface colour. For this to happen, the Transfer colours checkbox
(see above) needs to be deactivated. The diameter of the corresponding bore will then be high-
lighted in a different colour in the imported STEP part. In the SYS directory of your HiCAD install-
ation you find the configuration file FITINFO_COLOR.DAT, in which it is determined which RGB
value are to be assigned to which fits information.

Export free
points

By activating or deactivating this checkbox you can determine whether the exporting of free
points in the model drawing should be allowed or suppressed (if they could cause problems in
other places).

Export free
edges

By activating or deactivating this checkbox you can determine whether the export of free edges
in the model drawing should be allowed or suppressed (if they could cause problems in other
places).

Thread
body

Choose As separate parts or United with parent part if you want thread bodies to be exported
as individual parts or united with their superordinate part, respectively, in the model drawing.
Choose Do not transfer if you do not want the thread bodies to be exported.

Referenced parts during export
When carrying out exports using the functions

n Develop and export sheets and

n Export sheet developments

a warning message will be displayed if older versions of referenced sheets exists.

Processing direction

The Processing direction function is not only relevant for Sheet Metal parts, but also for identifying the install-
ation direction of tray panels in the Element Installation module. Therefore, this function has been moved, to the
Standard processings function group of the 3-D Standard Ribbon tab.
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Allowance method and bend radius from semi-finished products
The bend radius and the allowance method can be taken from semi-finished products in the dialogue windows of
the following Sheet Metal functions:

n Attach flange

n Flange along sketch

n Z-fold

n Fold

The value will be shown in the dialogue window.

Standardized spelling of punching tools
The spelling of the punching tools (alias names) in the catalogue (at Factory standards) in HiCAD has been stand-
ardizes, which you will see when selecting the Punching tools function.

Cut off corner - 3 milling edge zones
Sheets for Element Installation panels will now be assigned notchings that are suitable for production when applying
the Cut off corner function.
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Major Release 2019 (V 2400)

Flange along sketch

You can use the completely revised Flange along sketch function to attach several flanges to a sheet in one
step. As soon as your value inputs are sufficient, a preview of the new flanges will be displayed, i.e. when you
choose a sketch and a connecting edge, the possible flanges are will be shown on the Sheet Metal part. If you have
activated Width via point(s) , the new flanges will only be shown after identifying a point and the width, or two
points, provided that you have selected the connecting edge. Furthermore, you can immediately see the change if,
for instance, you switch from Shorten, outer to Shorten, inner . If the option Apply immediately is active, the
flanges will be attached if the value input made sense, and can then only be changed via the Feature log.

You can also click on the button at the top of the window and choose New sketch in plane to draw a new
sketch using the Sketch functions. Then, click on the Apply sketch button. To change the sketch, click on the Pro-

cess sketch button. This function can also be accessed via the button, The toolbar with the Sketch function
and the dialogue window for Sketch processing will be displayed. When you end the processing of the sketch via
the dialogue window you will get back to the Flanges along sketch dialogue window.

If you want to identify a different sketch, click on the icon in the Sketch area and chose the new sketch.

The selection of the connecting edge is decisive for the direction of the new flanges. After selecting the sketch and
the connecting edge, a preview of the new flanges will be shown. If the Apply immediately option is active, the new
flange will be inserted. Changes can then take place via the Feature log.

If you want to identify a different edge, click on the icon in the Connecting edge are and choose the different
edge.
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Flange

When you activate the option for the first point you can freely choose the width of the new flange, independently
from the connecting edge.

After selecting the 1st point in the drawing, you can set the width and its orientation; alternatively, you can identify a
2nd point.

If you want to change the selected points, click on the icon for identification.

Parameters

Here you enter the bend angle of the first new flange.

For the Mode option you can choose between bend zone and milling edge zone. The milling edge zone is used in
practice for compound sheets.

For the milled side, which will only be evaluated if the milling edge zone mode has been chosen, the direction of the
sketch is decisive. The setting is used as the default setting for the complete Sheet Metal part and can, in the Bend
zones area, or via the Feature, changed individually for eachmilling edge zone.

The bend radius will only be evaluated if the Bend zone mode has been chosen.
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Bend zones

In the Bend zone area you can assign individual values to each bend zone.

In the expanded table you can choose between a bend zone or a milling edge zone for Mode. Depending on the
chosenmode, you can then change the value for the bend radius or the milled side.

Depending on the processing type, the allowance method can be selected for each bend zone.

Relief groove

If the flange is smaller than the connecting edge and the fitting mode shortens the connecting sheet, it makes
sense to insert a so-called relief groove. Enter the width, the depth and the type of the relief groove.

Apply or discard changes

After completion of your data input you can attach the new flanges. If you click Apply or press the MMB, the
flanges will be attached, and the dialogue window will remain open, allowing you to change the data and apply
them to a different connecting edge. Clicking OK attaches the flanges and closes the dialogue window. Clicking
Cancel discards your value inputs and changes, without attaching the flanges. If the option Apply immediately is
active , the data will be applied directly.

Speed up design processes via MMB
In many functions, the middle mouse button (MMB) cannot only be used to cancel a function (as long as the
entered data has not been confirmed yet), but also to speed up design processes. For instance, after creating a
new base sheet, you can directly apply the data you entered in the dialogue window to another base sheet by press-
ing the MMB, without having to open a new dialogue window and pressing the Apply button again. This is possible
with the following functions:

n Create base sheet

n New sheet from sketch

n New sheet along sketch

n Attach flange

n Corner/Mitre

n Trim

n Fold flange

n Develop sheet
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Revised Sheet Metal Ribbon tab
To further improve the user-friendliness of the Sheet Metal tab, some functions were combined into new function
groups andmoved to the first, immediately visible level of the UI.

Sheet Metal functions

New

Attach

Bend zone

Process

Change length Corner/Mitre

Flange

Sheet

Trim

Process

Further Tools

Sheet development Development

Update

AllMet

Export

Further functions

Docking window Design Variant

Cost calculation
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Export
The data exchange functions have been optimized further. With the following three functions you can output

n DXF/DWG files

n XML files for CADMAN-B (from Version 7.5 onwards) byLVD or

n GEO files for ToPs GEO
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Functions Description

Export indi-
vidual devel-
opment

This function exports a development - either completely or as section contour if
you have chosen the DXF/DWG output.

Also, you can export the sheet developments from HiCAD as XML file for
CADMAN-B (from Version 7.5 onwards) by LVD. A prerequisite for the output of
LVD data is the assigning of bending tools to the bend zone with the Bend zone

tooling .

If you have chosen GEO as output format, the development will be exported
from HiCAD to the ToPs GEO file format. The GEO data can be directly loaded
into the individual modules (Laser etc.) of the ToPs family.

The configuration of the file name takes place via the file SheetToDXF.FTD. You
can customize this file in the Annotation Editor if desired. If this does not result
in a proper name, the name will be "Sheet".

Export

Develop and
export sheets

Use this function to export the section contour or the complete development of
Sheet Metal parts or Steel Engineering plates if you have chosen the DXF/DWG
output. In the process, a temporarily created development for the export will
always be output.

Also, you can export the sheet developments from HiCAD as XML file for
CADMAN-B (from Version 7.5 onwards) by LVD. A prerequisite for the output of
LVD data is the assigning of bending tools to the bend zone with the Bend zone

tooling .

If you have chosen GEO as output format, the development will be exported
from HiCAD to the ToPs GEO file format. The GEO data can be directly loaded
into the individual modules (Laser etc.) of the ToPs family.

The Close & Report button activates the Report Manager and creates a BOM.

All attributes will be transferred to the Report Manager (as with drawing creation)
and, additionally, the file name and the file path of the export. You can configure
a RMS file with the Report Manager, determining which data are to be written.

Export sheet
developments

Use this function to export multiple developments with different parameter set-
tings, e.g. LVD and Bystronic, of one or different Sheet Metal parts.

You can choose between the following formats:

n DXF/DWG,

n XML for CADMAN-B (from Version 7.5) by LVD and

n GEO for (ToPs GEO)

A prerequisite for the output of LVD data is the assigning of bending tools to the

bend zone with the Bend zone tooling .

If you have chosen GEO as output format, the development will be exported
from HiCAD to the ToPs GEO file format. The GEO data can be directly loaded
into the individual modules (Laser etc.) of the ToPs family.

The Close & Report button activates the Report Manager and creates a BOM.

All attributes will be transferred to the Report Manager (as with drawing creation)
and, additionally, the file name and the file path of the export. You can configure
a RMS file with the Report Manager, determining which data are to be written.
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Enhanced context menu for bend zones
The context menu for bend zones has been expanded, now offering new Subtract and Divide functions. This allows
you to apply straight cuts to or divide bend zones without having to switch to the functions on the 3-D Standard tab.

Right-click on a bend zone to open the context menu.

Attach long flange to short flange, with relief groove
When attaching flanges a relief groove is now applied to the new flange if it projects beyond the connecting edge.
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Handling of collinear edges
Collinear sheet edges can no longer be shown in the HiddenLine representation. Therefore, the following setting
options have been removed:

n in HiCAD at Views > Properties > Show/Hide elements > Show collinear sheet edges and

n in the Configuration Editor at Drawing >Views > Hiding and overlapping of edges > Hide collinear sheet
edges.

For model drawings from 2018 and older you can no longer show collinear sheet edges in the HiddenLine rep-
resentation. For these legacy drawings, the settings valid at the time of their saving apply. However, you have still
the option to update the handling of collinear sheet edges in these legacy drawings to the new mechanism.

To do this, use the Update sheet edges function. After applying the function you can hide collinear-tan-
gential sheet edges in the HiddenLine representation if desired. Collinear bent edges will always be shown, while
collinear mergeable edges will be hidden.

212 / 386 What's new?

Sheet Metal



Preserve bend zone texts in shortened views
Bend zone texts will now be preserved in shortened views of sheet developments.

Lengthen flange or sheet
To improve user-friendliness, the user guidance texts for the lengthening of flanges and sheets in the info bar at the
bottom left of the HiCAD screen have been revised.

Previously: 1st point; New: Vector of lengthening: Start point

Previously: 2nd point; New: Vector of lengthening: End point
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Allowance method and bend radius in Feature log - Indicate semi-finished product
In some Sheet Metal function dialogue windows you can activate a From semi-finished product option for bend
radius and allowance method. If you have selected these options, you can see the relevant value in the Feature log.

This is possible for the following functions:

n Attach flange

n Sheet along sketch

n Flange along sketch

Outer contours of sheets, dimension chains separated according to flanges
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Steel Engineering

Please note:

The functions of the Itemisation/Detailing function group on the Drawing tab are available in all
HiCAD suites andmodules.
From HiCAD 2018 onwards you will therefore find the descriptions of these functions in the Basics >
Itemisation/Detailing topic.

News regarding these functions can be found in the Basics - What's New? topic, accordingly.

Service Pack 2 2019 Patch 1 (V 2402.1)

Railings on curved beams
Curved segments with equal radius and mid point are now handled like aligned, straight beams. That is, if there are
several curved beam segments with equal radius and mid point in succession, the railing elements of these beams
will be combined into one segment assembly. In this way, continuous hand rails and knee rails will be created on
these beams, too. The updating and modification of existing railings (before Version 2019 SP2 Patch 1) with such
areas continues to take place with individual segment assemblies, i.e. non-continuous, "interrupted" hand rails and
knee rails.

In the image below a railing along two curved beams (1) and (2) has been created. A shows the result with a version
before 2019 SP2, Patch1, B shows the result with Patch 1.
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Service Pack 2 2019 (V 2402)

Configuration / Settings

Changed parameter configuration for Steel Engineering

The HiCAD Parameter configuration for Steel/Metal Engineering have been changed, with the aim to make Steel
Engineering workshop drawings clearer and better intelligible.

The following modifications have been applied:

BOMs

Setting previous as of SP2 Parameters

Insertion of BOMs Quantity
list in
view
group

Quantity
list in draw-
ing frame

Changed in Configuration Editor for all Usages
Automatic drawingderivation >Production drawing>Usage-dependent
> ... >View group > Insert BOM

Position of BOMs in
drawing frame

bottom
right

bottom left Changed in Configuration Editor for all Usages
Automatic drawingderivation >Production drawing>Usage-dependent
> ... >View group >BOM: Position in view group

Display of columns
DSTV, Part type,
Designation

yes no Changed in the hicad_stahlbau.rms in the HiCAD dir-
ectories sys and sys/BOMTemplates.

During installation the template sys/BOMTem-
plates/hicad_stahlbau.2400.0.rms will be copied to
sys/hicad_stahlbau.rms.

Font size

Setting previous
as of
SP2

Parameters

Item numbers of sub-
parts

5 3.5 Adjusted in the templates ofthe FTD file for annota-
tions

Height of weld symbols 3.5 2 Changed in Configuration Editor
Drawing>Annotations >Weld symbols >Symbol height

Identificatiopn of sections 5 4 Changed in Configuration Editor

Drawing>Views > Ident >Sections >Font height in original view

View shortening

Setting previous
as
of
SP2

Parameters

Minimum width of
shortening area

20 50 Changed in Configuration Editor for all Usages except for Steel
Engineering plates
Automatic drawingderivation >Production drawing>Usage-dependent > ... >
Views >Shortened view >Minimumwidth of shortening area

Distance to relevant
geometry

5 15 Changed in Configuration Editor for all Usages except for Steel
Engineering plates
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Setting previous
as
of
SP2

Parameters

Automatic drawingderivation >Production drawing>Usage-dependent > ... >
Views >Shortened view >Distance to relevant geometry

Shorten other parts
and assemblies

ja Changed in Configuration Editor for all Usages except for Steel
Engineering plates
Automatic drawingderivation >Production drawing>Usage-dependent > ... >
Views >Shortened view >Other parts and assemblies

Dimensions

Setting previous
as
of
SP2

Parameter

Distance between
dimension line and
geometry

10 9 The data are created from the file STW_DimSettimgs.xml in the
HiCAD sys directory. This file will be created by HiCAD if it does
not exist yet (i.e. during a new installation).

In the created new file the values will be initialized as shown here.
For update installations the parameters will remain unchanged,
i.e. as defined by the user.

Distance between
dimension lines

8 7

New parameters for section schemas in BOMs

In the Configuration Editor at Steel Engineering, two new parameters for section schemas in BOMs are now avail-
able:

Cutting angle reference in section schema

Here you can choose to which leg a specified angle in the section schema is to refer:

n Cross-section or

n Beam axis

Do not show cutting angle in section schema if cut surface

Use this parameter to specify the conditions under which no cutting angle is to be shown in the section schema,
since the total length does not correspond to the trimmed length:

n The cut surface has been processed.

n The cut surface has been processed on one outer side or on both outer sides.
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Connections

Cross-bracing (2601)

The previous Cross-bracing (1601) has had a redesign (analogous to Cross-bracing (2602)) and has been replaced
with the new Cross- bracing (2601) . Use this Design Variant to insert cross-bracings as stabilizing elements
between 2, 3 or 4 beams or plates.

When connecting profiles, you also have the option to mount the cross-bracing to already existing plates on the
beams. This can make sense if, for instance, you want to insert two cross-bracings between 2 beams, and the
second cross-bracing is to be mounted to the gusset plates of the first cross-bracing. Also new is the possibility to
insert cross-bracings between plates (without assignment to any beams.
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On the left hand side you can see a cross-bracing inserted between two beams. The gusset plates here were cre-
ated together with the connection. Then, as you can see on the right hand side, another cross-bracing was inserted
between the beams, mounted to the right gusset plate of the first cross-bracing (C).

The Usage attribute of the resulting assembly will be automatically initialized with Cross-bracing.

Base plate + Anchor plate (2101)

On the Weld seams tab of the Base plate + Anchor plate (2101) dialogue window you can now choose the weld
seam type for welded on plates. The tab has been expanded accordingly for this purpose.
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Cross-bracing (2602)

In previous versions,only plates could be selected as connecting plates. FromHiCAD 2019 SP2 onwards it is also
possible to generate flat steels and wide steels.

Stabilizing pipe

n As with the cross-bracings, you have now the option to use plates as gusset plates that already exist on a beam
for stabilizing pipes, or to create a stabilizing pipe connection between two existing plates (that do not belong to
any beam). The tab has been expanded accordingly for this purpose.

In the image below the two beams (1) und (2) were identified first. Then, in the dialogue window beneath Plates,
checkbox A was activated. The gusset plate (3) on the first beam has been chosen as the plate and, as point,
the mid point of the gusset plate edge. Next, it was proceeded likewise for Sheet B (4).
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n As with the cross-bracing, the selection box for connecting plates has been expanded, i.e. here, too, con-
nections on flat steels and wide steels can be generated.

n The insertion of gusset plates can now be deactivated if the stabilizing pipe is to be directly connected to the
flange.
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n For stabilizing pipe connections, a vertical alignment of gusset plates to the beam is now even possible if the
beams have been offset to each other.
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Stairs and railings

Dividing handrails

From SP2 onwards, handrails can be divided, e.g. in order to insert plug-in profiles or flat steel joints in long railings.
For this purpose, an additional checkbox has been added on the Handrail-Handrail tab.

If the checkbox is active, the variant for handrail division and the division of the handrail can be specified by seg-
ments.
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The divisions can be defined either by specifying the distance from the segment start, or by specifying a division
point.

New division

Click on this symbol to add a new division, e.g.:

Enter the distance of the division from the segment start in the input field.

New division at selected point

Click on this symbol do define the division by specifying a division point.

Divisions can be deleted at any time by clicking on the symbol at the top right next to a division.

The following variants for handrail division have been predefined:

n Straight cut,

n Plug-in profile and

n Flat steel joint.
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The image below shows a railing with divided handrails.

(1) Variant: Plug-in profile, (2) Variant: Flat steel joint, (3) Variant: Straight cut
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Curved railings

From SP2 onwards, HiCAD allows the creation of curved railings in a plane. This applies to both railings along
beams and railings along composite edges. However, this is only possible for curved beams or curved lines of a
sketch. Curved beams placed along composite edges are currently not supported yet. The division can be defined
either by specifying the distance from the segment start, or by specifying the division point.

Curved railing, created on the basis of arcs

Curved railing, created along a curved beam
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Glass insertion
The previous functions "Glass" and "Glass along sketch" have been combined into a new function called Laminated
glass, which allows the creation of both glass panes in glass fields and the creation of glass panes from sketches.

The Laminated glass dialogue window

Nested sketch-based series profiles
User-defined, sketch-based series beams and profiles consisting of several parts may now be nested arbitrarily in
assemblies and dummy parts (exception: CUTOUT, CONTOUR and GLASS) - these must always be contained in
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the uppermost element.

Nested beam structure and the resulting beam
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Service Pack 1 2019 (V 2401)

Connections

Cross-bracing (2602)

The Cross-bracing (2602) has been further enhanced. In previous versions, the connection automatically supplied
the gusset plates. From HiCAD 2019 SP1 onwards you have the option to use already existing plates on the beams
as gusset plates. This can be useful in situations where you want to insert two cross-bracings between two beams,
andmount the second cross-bracing to the gusset plates of the first cross-bracing.

Also new is the option to insert a cross-bracing between plates (which are not assigned to any beam).
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An example:

On the left hand side you see a cross-bracing inserted between two beams. The gusset plates here were created
together with the connection. Then, as you can see on the right hand side, another cross-bracing was inserted
between the beams, mounted to the gusset plates of the first cross-bracing (A and D).

Furthermore, additional options are available for rectangular gusset plates, which influence the position of the con-
necting plate in relation to the gusset plate.
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Stabilizing pipe

The Fixing tab of the Stabilizing pipe connection has been revised. Beneath Stabilizing pipe you can now determ-
ine whether the gusset plate is to be mounted to the front or back of the connecting sheet or T-profile, respectively.
Also, you can rotate the connecting plate and T-profile 90° by activating the corresponding checkbox.

The image below shows a stabilizing pipe connection inserted perpendicular to the beam without (left) and with
(right) 90° rotation of the gusset plate, the T-profile and the pipe.
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Stairs and Railings

Railings - Offset between post and handrail

For all posts you can now specify a lateral offset to the handrail. For this purpose a new checkbox has been added
on the Post tab.

Please note that specifying an offset currently only makes sense if Variant: Console has been selected
on the Post-Handrail tab.

Example:
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Editor for customer-specific railing variants

Railing components such as posts, handrails, transition infills, corner infills or the Post-Handrail connection can
now also be saved as customer-specific variants. These variants will then be available in the Railing Configurator,
allowing an individual composition of railings.

The creation of such variants requires the following steps:

n Construction of the desired railing component

n Parameterisation of the railing components by assigning ISD variables (mandatory) and free variables (optional)
and - if desired - assigning of HCM constraints.

n Definition of the Fitting CS, and

n Saving of the variants with the Variant Editor for Railings that is available in the Civil Engineering functions at
Steel Engineering > Stairs+Railings > Railing.
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Other new features

Tracking of catalogue changes

If you have selected the default template Steel/Metal Engineering in the HiCAD Parameter Configuration (ParKon-
figComp.exe) in previous versions, the tracking of catalogue changes was automatically switched on in the Con-
figuration Editor at System settings > catalogue. From HiCAD 2019 SP1 onwards, the tracking will be switched off
by default.

Specify default material

In the Configuration Editor at Steel Engineering you can specify a Default material for Steel Engineering parts.

In previous versions, the ID of the required table of the Material catalogue and the ID ofthe data record needed to

be specified. From HiCAD 2019 SP1 onwards, the selection can be achieved much easier: Simply click on the
symbol and choose the desiredmaterial from the Materials or User-defined materials catalogue.
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Major Release 2019 (V 2400)

Attached parts

Loading of the current article master of semi-finished products in attached parts

In previous versions, existing article masters of semi-finished products were not transferred to HiCAD when insert-
ing attached parts such as Steel Engineering connections, stairs, railings, element installations, profile installations
etc.

From HiCAD 2019 onwards this behaviour can be changed via a setting in the Configuration Editor: At PDM >
HiCAD-HELiOS Interface you can find the parameter Add semi-finished product article when loading. The ISD
default setting is No, i.e. the article master of semi-finished products will not be transferred.

For example, when transferring article masters of semi-finished products from user-defined catalogues, set the
parameter to Yes.
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Example:

In this example a new model drawing was created and entered into the database. Then, two IPE-beams were inser-
ted and mounted together using the Beam to web, with 2 plates and stiffener (1211) connection. The plates Bl
15 and Bl 10 were chosen from the semi-finished products catalogue, and also have an article master in the
HELiOS database. The image below shows, by means of the ICN structure, the difference between the different set-
tings in the Configuration Editor:
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Stairs and railings

Enhanced Staircase Configurator dialogue window

The Calculation tab of the Staircase Configurator is now much more intuitive. The different types of stair starts and
ends can now be chosen via symbols. The info graphic of the staircase in the dialogue window will be automatically
adjusted in the process.

Also new is the Check standard conformity checkbox. If it is active, HiCAD will check on the basis of the specified
parameters whether the staircase can be constructed, taking the calculation rules into consideration. If this is not

the case, the symbol will be displayed at the OK button. If you move the cursor over the symbol, the tab and the

input fields containing incorrect values will be marked with the symbol. Move your cursor onto this symbol to
obtain further information and correct the staircase parameter. You can also click on the Set parameters accord-
ing to standard button to correct the wrong values automatically.

What's new? 241 / 386

News Overview



Concrete stairs

Concrete stairs can no longer be inserted as sub-parts. The corresponding checkbox has been removed from the
dialogue window.

Connections

Free plate (1103) - Part structure

n If the part that is active when you call the Free plate (1103) function is already a sub-part to an assembly, the
plate will be inserted as a sub-part to this assembly. Otherwise, the plate will be inserted as a main part in the
drawing.

n The Insertion as sub-part checkbox has been renamed to Insertion as attached part. If this checkbox is act-
ive, HiCAD will proceed as follows with regard to the part structure:

l If the active part already belongs to a BOM-relevant assembly, the plate will be assigned as a sub-part to
this assembly.

l If the active part does not belong to a BOM-relevant assembly, a new BOM-relevant assembly will be cre-
ated, to which the active part and the and the plate will be subordinated.

Cross-bracing (2602) - Position of connection of gusset plate

If you choose a rectangular plate as gusset plate on the Fixing tab of the Cross-bracing (2602) dialogue window,
various selection options on the Connecting point tab will be available to you, allowing you to influence the position
of the connection on the gusset plate.

This enables you to determine the centre of the connecting sheet and place the bore in the middle of the gusset
plate more easily.
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Standardized UNDO
The UNDO behaviour of all Steel Engineering connections has been stabilized and standardized. If a connection is
inserted multiple times, i.e. without exiting the function, one UNDO step will refer to the last inserted connection,
i.e. the insertion of one connection will be regarded as one step.

Process beams

Exchanging beams created along composite edges

From HiCAD 2019 onwards beams created along composite edges can be exchanged.
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Glass insertion

DXF export of multi-layered glass panes

When carrying out DXF exports via Sheet Metal > Sheet development > Export > Sheets glass panes will
also be considered for export as of HiCAD 2019. If there are multi-layered glass panes, the individual glass layers
will be exported.

For annotation purposes and file name composition the attributes of the total glass pane can be used. In this con-
text, please observe the information given in the Attributes of superordinate parts paragraph of the Attributes in
annotation tags topic.

For instance, if you want the name of the DXF file to be composed of the item number of the complete pane and the
article number of the glass pane, this can be achieved in the manual settings for the file name by using the fol-
lowing text blocks:

Series

Sketch-based series

User-defined series can now not only be created from 2-D parts, but also from 3-D parts that contain assemblies
and sketches.
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Steel Engineering - Management + BIM

Service Pack 2 2019 (V 2402)

Remove project-dependency

New in the menu Management+BIM > Extras > Information is the Remove project-dependency func-
tion. .

Use this function to deactivate the project-dependency of the active assembly. This means that the article attribute
STAHLBAUAUTO (Project-related checkbox) will be set to No, for both the assembly and all its sub-parts.

In this way, the assembly will be defined as a part for reuse. As a result, it will keep its the article master, even if it is
inserted in other projects.

Checkup and Release of production drawings
Checkup and Release can now take place directly in the production drawing. In previous versions these options
were greyed out if a production drawing had been loaded.
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Article attributes for drawings with several parts
As with detail drawings, you can now also transfer article attributes of individual parts to document attributes of
drawings with multiple parts. For this purpose the new parameter Article attributes for drawings with multiple
parts has been added at PDM > Management+BIM > Production drawings.

There, click on the symbol and define the desired assignments. Each assignment must be defined in one row,
in the following format:

Article attribute;Document attribute

For instance, if you want to assign the article attribute NORMBEZEICHNUNG (Standard designation) of the parts to
the document attribute BEMERKUNG (Comment) of the drawing, the assignment must look like this:

The article attribute NORMBEZEICHNUNG (Standard designation) of the parts will then be assigned to the doc-
ument attribute BEMERKUNG (Comment) of the drawing, separated by a semicolon. Identical article attributes will
be transferred only once in the process.
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An example:

The model drawing consists of the 4 displayed beams with the indicated standard designations shown below.

If you now create a workshop drawing containing all parts, the following string will be assigned to the document
attribute BEMERKUNG (Comment) of the drawing:

Please note that the attribute BEMERKUNG (Comment) that was used in the example is not contained in the dia-
logue masks by default, but needs to be added via the HELiOSMask Editor if required!
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Rework of drawing
When saving drawings that were created via Management+BIM, you have the option to execute an individual script
for automatic reworking. For this purpose the new parameter Rework of drawing has been added at PDM > Man-
agement+BIM > Production drawings.

There you can choose between detail drawings, drawings containing multiple parts, mounting drawings and cus-
tomer drawings. Mark the corresponding entry in the listbox to determine for which drawing types a rework via script
is to be carried out, e.g.

The scripts that need to be executed must have certain names. The scripts that are supplied together with HiCAD
have already been predefined as follows:

Drawing type Name of script Active part

Detail drawing UpdateSingleWSD.cs Part or Assembly

Drawings containing multiple parts UpdateMultiWSD.cs Main assembly

Customer drawings UpdateCUD.cs Main assembly

Mounting drawings UpdateMTD.cs Main assembly

The directory that is assigned to File group 2 in the FILEGRUP.DAT file has been preset as the path of the scripts.
By default, this is the HiCAD directory MAKROST3D.
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The file UpdateSingleWSD.CS:
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These script templates can be expanded by any API commands. For example, you could insert a bitmap with a cor-
responding bar code into all detail drawings in this way:
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Please note however that a very good knowledge of the API is required for the creation of such individual scripts,
and that the scripts (when they are activated) will be run upon every saving of the drawing, i.e. upon manual saving,
creation and updating of the drawing, and its checkup and release. An appropriate message will be displayed in
HiCAD after drawing creation, e.g.

Please note:

A very good knowledge of the API is required for the creation of the individual scripts.

As far as the example with the bar code is concerned: It will not be sufficient to merely add the
insertion of a bar code in the script. Instead you need to ensure that the script also contains a
check for an already existing bitmap and replace it. Otherwise the bitmap will be contained mul-
tiple times. HiCAD will not perform any such check.
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Service Pack 1 2019 (V 2401)

Changed settings in Configuration Editor
n The parameter Create part document in the Configuration Editor at PDM > Management + BIM is no longer

available.

n New at PDM > Management + BIM are the parameters Transfer non-BOM-relevant construction sections
and Updating of referenced parts.

Non-BOM-relevant construction sections and product structure
HiCAD model drawings in Steel Engineering are often split into so-called construction sections, e.g. frameworks,
platforms, columns, platform support structures etc. These construction sections are normally non-BOM-relevant
structure assemblies, which were previously not transferred to the HELiOS product structure. From HiCAD 2019
SP1 onwards, the new usages

n Construction section or

n Production section

are available. Construction sections/structure assemblies can now also be transferred to the HELiOS product struc-
ture if they are not BOM-relevant. For this to happen, the parameter Transfer non-BOM-relevant construction sec-
tions in the Configuration Editor must have been set to Yes.
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No updating of drawings while production documents are open
If an external production document, e.g. a PDF file, has been opened in HELiOS, a drawing that is linked to it can-
not be updated in HiCAD.

n In such as case HiCAD will issue the message shown below and list the documents in another window:

In this situation you have the option to end the editing by choosing (Extras > Show workspace ) and click-

ing on the symbol in the HELiOS workspace dialogue window. When you then perform an update, the
opened external document, too, will be updated in the background. When you open this document again, all
changes will then be visible.
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Updating of models with old referenced parts
Like production drawings, you can now also manage construction sections (i.e. referenced part models) in HiCAD.
For this purpose, the new links Model up to date andModel not up to date have been introduced.

In the Configuration Editor at PDM > Management+BIM you will find the parameter Updating of referenced parts
that enables you to specify whether the updating of BIM-managed, referenced parts is to take place in all models.

If you select Yes, HiCAD will offer you the additional function Update models with old referenced parts .
This function enables you to update all models containing old referenced parts in one step.

When you call the function, all models containing old parts will be listed.

Choose the requiredmodel and click on OK.
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Major Release 2019 (V 2400)

New functions for linked documents

The Linked documents function now has a pull-downmenu with further functions for linked documents:

Model drawing with part

Opens the model drawing containing the active part. For instance, if you work with referenced part
drawings and call this function in the original model drawing, the corresponding part model drawing
will be opened.

Production drawing

Opens the production drawing of the active part.

Production drawings

Displays a list with all production drawings in which the active part occurs, i.e. also the assembly
drawings. Choose the desired documents and close the window with OK.

Mounting/customer drawings

Displays a list of all mounting drawings and customer drawings in which the active part occurs.
Choose the desired documents and close the window with OK.

Itemised source model

Opens the itemised source model of the active part, i.e. the model in which the part has been
itemised.
see also: ITEMISATIONMODEL attribute

Derive, active assembly(-ies) without sub-parts

The Derive, active assembly(-ies) with sub-parts function now has a pull-downmenu with the Derive,

active assembly(-ies) without sub-parts function.

Here, too, the active assembly will be copied, but with the following difference:

n The article masters, indices and item numbers of the sub-parts are preserved.

n The Workflow status of the sub-parts remains unchanged.

n The links of the sub-parts to the drawings are preserved.

This function can make sense if you insert a released assembly a second time, and want to add just another beam
there, without changing the sub-parts.

What's new? 255 / 386

News Overview



When itemising the derived assembly, only the item numbers of the assembly will be continued; the sub-parts will
retain their original item numbers.

Please note that this function will only make sense if in the Configuration Editor the setting PDM > Man-
agement + BIM > Production drawings > Consider total number in producton drawing has been set
to No. Otherwise the following message will be displayed when you save the model drawing:

After clicking on OK, the corresponding sub-parts will be listed for your information. For these sub-parts of
the copied assembly a revision index would have to be created, or the Workflow status would have to be
reset, which would, in principle, be contrary to the function's purpose.

Set workflow status for active assemblies back, without sub-parts

Use the new Active assembly(-ies) without sub-parts function to reset drawings and all their sub-parts
from the Workflow status Checkup to the Workflow status In progress again. Drawings for sub-parts of the
assembly will not be considered here.
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Change details of mounting/customer drawings - New context menu functions

The context menu for the changing of box dimensions of the Detail function has been adjusted to that of
the Mounting drawing function on the Drawing tab. This means that you can now select new boxes, or delete
boxes in mounting drawings and customer drawings that have been created via the Management + BIMmodule.

If you delete boxes in a mounting/customer drawing, the associated mounting/customer plan will be
removed from HELiOS, too. In this case the Update drawing function will not be required.
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Automatically create/update drawing for active assembly
New in the pull-down menu of the Management + BIM > Workshop > Drawing function is the Active assembly(-

ies) with sub-parts function.

You use this function to

n automatically create workshop/detail drawings and

n update workshop/detail drawings after modifying the assembly models. Mounting drawings and customer draw-
ings cannot be created with this function, but updated. However, such updating is only possible if the drawings
are In progress. In this context, please also read the information given in the topics Customer Drawings - Revi-
sion index, Change Released Drawings andMounting Drawing - Revision index.

either for only the active assembly or for a selection of several assemblies.

The settings for drawing derivation (i.e. for the drawing sheets, view groups, views etc.) will not be specified in the
dialogue here, but loaded from appropriate pre-setting files instead. This means that the Drawing derivation dia-
logue window will not be displayed when you call this function, which speeds up the drawing creation process.

Otherwise, the function largely works in the same way as the Management + BIM > Workshop > Drawing
function - with the difference that here, non-existent drawings will be generated immediately without any further
queries. Only then will HiCAD check

n which drawings - also mounting drawings and customer drawings - are no longer up to date, and

n whether parts for which a drawing existed had been deleted in the model drawing.
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New setting options in the Configuration Editor
In the Configuration Editor at PDM > Management + BIM additional parameters are available.

PDM > Management + BIM

Update
pro-
duction
drawings

Via this parameter you can determine whether production drawings are to be loaded and updated
upon Checkup and Release. The default setting is Yes.

Choosing No can make sense if only the Workflow status of an assembly, but not the content of
the drawing is changed. When you choose this setting, the drawings will, for instance, not be
loaded/updated if the Workflow status changes from Checkup to Released , or if the index
changes.

This also applies if, after a release of drawings, the index is changed with the functions available
at Management + BIM > Workshop > Change, but then it is decided to make no changes.

In this way the waiting times in connection with the updating are reduced.

Product
structure
transfer

This parameter determines the conditions for a product structure transfer to HELiOS.

n Only if model drawing is valid (green)
The product structure will only be transferred if the BIMmodel drawing is valid, that is, if a cor-
responding article exists in the HELiOS database for each part. A valid model drawing is

marked with the symbol in the ICN. This is the default setting.

n Upon each saving with BIM
The product structure will be transferred each time you save with the Management + BIM
module - even if the model drawing has not been completely passed on to HELiOS yet.

PDM > Management + BIM > Production drawing

Pro-
duction
drawings
for
glasses

When creating production drawings for glasses you distinguish between rectangular glass panes
andmodelled glass panes (i.e. non-rectangular and/or unprocessed glass panes).

If you set the parameter Production drawing for glasses to Yes, production drawings will be cre-
ated both for rectangular panes andmodelled panes. This is the default setting.

If you choose the setting Only for modelled glass panes instead, rectangular glasses will not be
considered for production drawing creation.

Please note:

This parameter only applies to glass panes from the HiCAD catalogue, i.e. from the cata-
logues Factory standards > Glass panes and Factory standards > Multi-layered
glass panes!

All other glass types, e.g. from LogiKal, are automatically considered modelled glass
panes with production drawing.

Rearrang-
e views
when
updating
pro-
duction
drawings
and
mounting

Use this parameter to specify for external, PDM-managed drawings whether you want the views
to be rearranged automatically in production drawings or mounting drawings upon updates.
Switching this option off makes sense if, for instance, you have deliberately moved some views
and want to keep their new position.

The default setting is Rearrange.
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drawings

PDM > Management + BIM > External production documents

Article
attributes
for CAM
doc-
uments

Here you determine which article attributes are to be assigned to the CAM document attributes
when the CAM data are created.

To transfer article attributes of the semi-finished product to CAM document attributes, click on

the button and define the desired assignments. Each assignment must be written in one line,
as shown below.

Article attribute;Document attribute

For instance, if you want to assign the article attribute DESIGNATION of the semi-finished
product to the CAM document attribute COMMENT, youmust do it like this:
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Pre-mounted assemblies in BOMs
When working with pre-mounted assemblies in practice, it is sometimes required that only the assemblies, but not
their sub-parts are displayed. This can be achieved with the article attribute COMPONENT_PREINSTALLED, which
needs to be assigned to the article master of the pre-mounted assembly.

To ensure that the attribute is shown in the HELiOS article masks, you need to adjust the masks in HELiOS accord-
ingly, i.e. the attribute COMPONENT_PREINSTALLED must be added as a new data field in the mask, creating a
new checkbox in this way. If you activate this checkbox in the article master mask of an assembly, this assembly is
regarded as "pre-mounted".
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Metal Engineering

Service Pack 2 2019 (V 2402)

Glass insertion
The previous functions Glass and Glass along sketch have been combined into a new function called Laminated
glass, which allows the creation of both glass panes in glass fields and the creation of glass panes from sketches.
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Major Release 2019 (V 2400)

Toggling between exact and contour representation
The buttons for toggling between exact and contour representation that could previously been found at Metal Engin-
eering > Others have beenmoved.

You will now find them in the Civil Engineering functions docking window at Civil Engineering, general.

Taking over of U-values of LogiKal glasses
When importing glasses from LogiKal, the U-value (thermal transfer coefficient) of the glasses will be taken over
into the System attribute §26.
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Element Installation

Service Pack 2 2019 (V 2402)

The Dialogue Editor for customized installation elements
HiCAD offers the optionto create customized installation elements for facades (Element installation and Sub-struc-
ture). The dialogue which is shown when selecting these customized installation elements can in turn also be cus-
tomized. Excluded from customization are the areas Sketch, Type and Joint width towards sketch line.

In previous versions, the XML file for the dialogue had to be created manually. From HiCAD 2019 SP2 onwards, a
convenient tool,the HiCAD GUI Creator, will be available for such tasks. Just run the EXE file to start the tool.

HiCADGUICreatorApp.exe

in the HiCAD EXE directory.

After calling the Editor, the HiCAD GUI-Creator dialogue window will be displayed.

The HiCAD GUI Creator in this version supports only dialogues for Element Installation. In future ver-
sions, the Editor will become a universal Dialogue Editor.

Mounting drawings for sub-structures
You have now the option to automatically derive mounting drawings for sub-structures.
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Prior to this, a one-time configuration of the dimensioning rules will be required.
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ALUCOBOND riveted with sub-structure
Bores and rivets connecting element installations to sub-structures will now be adapted to the sub-structure in vis-
ibly riveted ALUCOBOND panels.

Left: ALUCOBOND riveted, with connected sub-structure; Right: ALUCOBOND riveted, without sub-structure
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Shortening of sub-structures
When inserting sub-structures, you can now define, for each graphical element, a separate shortening for the start
and the end of beams.
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Creation of wall brackets
Use the Wall bracket function to automatically create wall brackets for sub-structures.

These can be created not only on walls, but also on roofs, e.g. when inserting attics.

Via the Position to profile setting you can mount the bracket in centred position under the sub-structure beams
(e.g. for U-shaped brackets), or can be aligned to the beams on the left or right (e.g. for L-shaped brackets).

One of the brackets will be used as Fixed point, the other brackets as Sliding points. You can choose whether the
top bracket or the bottom bracket is to be the fixed point, or whether the fixed point is to be located near the middle
of the beam.

For the top and the bottom wall bracket a specified Distance to the end of the beam is used. The other brackets are
evenly distributed in such a way that a Maximum distance is observed.
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You can create your own wall brackets, save them to the catalogue system and insert them automatically after-
wards. These brackets can be conveniently created from wall consoles in the catalogue, e.g. from the new Hilti con-
soles for rear-ventilated facades.

For a horizontal positioning of the wall brackets to the beams the new Wall bracket usage function usage has been
added, which allows you to determine the distance of the wall brackets to the beam axes. In the Create Own Pro-
files for Sub-structures topic you can see a concrete example of how to use this function.
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Eternit® installation elements

HiCAD 2019 SP2 supports the installation of Eternit panels. These can be found in the following catalogues:

n Factory standards > Installation Planning - Parts and Processings > Element installation > Installation ele-
ments > Eternit

Available are:

l EQUITONE Tergo and

l EQUITONE riveted

n Factory standards > Installation Planning - Parts and Processings > Sub-structure > Installation elements
> Eternit

Available are:

l Riveted to L-profile

l Riveted to T-profle and

l Systea UBE 25/2

EQUITONE Tergo, Fixing type Tergo+

Since EQUITONE Tergo elements must be installed according to certain static requirements, the new Create
sketch for sub-structure function has been introduces, which automatically creates a sketch serving as the basis
for a Tergo element installation.
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ALUCOBOND® sub-structure: Reinforcing bracket for rear attic flange
The new Insert reinforcing bracket option can be applied to ALUCOBOND suspended and ALUCOBOND SZ 20
sub-structures.

If this option is active, and the sub-structure is mounted to a matching element installation, additional reinforcing
brackets will be automatically riveted to the rear attic flange:
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ALUCOBOND® riveted
Riveted ALUCOBOND tray panels can now be placed on any rectangular and polygonal sketch areas. However, the
setting options for vertical and horizontal section are greyed out here.

On the Global settings tab you can specify the diameter of the fixed point bores. The corner distances of the bores
for rivets can now be specified on the Extended settings tab.

For the visibly riveted ALUCOBOND tray panels the processings on the panels result from the mounting to the sub-
structure. These processings can then be changed on the the Extended settings tab.
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From SP2 onwards, these parameters can even be set if no sub-structure is used for the element installation.
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ALUCOBOND® Tray panel SZ-20

ALUCOBOND SZ 20 tray panels can now also be placed on triangular sketch areas.

Please note:
To ensure that a placing on triangular sketch areas will also work with attics and outer corners etc.,
HiCAD will assume that the hypotenuse at the "top" and the side on the left / right will be the shortest dis-
tance. This means that a placing on equilateral triangles is not possible.

Furthermore, milling-oriented bend zone ends are now created for ALUCOBOND SZ 20 tray panels with the help of
the new Sheet Metal function Trim corner.

(1) Bend zone ends in HiCAD 2019 SP2, (2) Bend zone ends before HiCAD 2019 SP2

Also new is that the tray panel depth can now be set on the Extensions for SZ-20 Standard tab. The specified
value applies to all sides.
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ALUCOBOND® suspended
For suspended ALUCOBOND tray panels you can now specify the height and width of agraffes. This setting must
take place in the table Agraffes of the catalogue Factory standards > Bore patterns. In this table two data records
have been predefined that you can use as a basis for further sub-types.

Please note that only agraffes based on the part ISD_AGRAFFE_01-Y.KRA, i.e. agraffes of the Type Y-, are allowed
here.

The agraffes defined here will then be available on the Extended settings tab.
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Customer-specific installation elements - Clearance
For customer-specific installation elements the clearance can be preset in the appropriate catalogue table. When
choosing the corresponding installation element in the Element installation dialogue, the clearance will be set to
this value.

The pre-setting of the clearance takes place via the table columns

n GAPMODE and

n GAPDEFAULT.

You enter the required value for the clearance in the GAPDEFAULT column. If you want to activate this value as the
default value, set the column GAPMODE to 1. When choosing the corresponding element in HiCAD for the element
installation the value for the clearance will be automatically set to the value entered in the GAPDEFAULT column.

To deactivate this pre-setting, set the column GAPMODE to 0.

The tables in the ISD Examples catalogue that is supplied with HiCAD already contain these columns.
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Service Pack 1 2019 (V 2401)

ALUCOBOND® Tray panel SZ-20
n From HiCAD 2019 SP1 onwards, all reinforcement plates will be riveted.

n For the lateral type of attic connections, HiCAD 2019 SP1 will offer additional options on the new Extensions for
SZ-20 Standard tab. For instance, you can specify here whether flanges are to be attached and if so, on which
side, and whether the corner attics are to be created with or without clamping profile.

Example:

The image below shows a SZ-20 tray panel. Horizontal section: Connection, top. Attic, long; Vertical section: Con-
nection, right. Outer corner with folded sheet. The left tray panel has been created with splice sheet and clamping
profile, the right one without these elements.

(1) Splice sheet, (2) Corner attic with clamping profile
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n When connecting an element installation of the type SZ-20 to a sub-structure while the connection type End,
bottom has been chosen, the "base profile" will be considered and displayed correctly.

n When connecting an element installation of the type SZ-20 to a sub-structure, while the connection type Win-
dow connection, Parapet has been chosen, not just bores, but also rivets will be created.
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ALUCOBOND® suspended
n For this panel type you could previously specify the length of the folding via the Tray panel height parameter on

the Extended settings tab. Since this parameter name was misleading and applies only to the setting Con-
nection, top: Standard, the setting can now be specified on the Global settings tab in the Length field:

n An additional tab called Extensions for standard for attic connections is now available for suspended tray pan-
els.
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n On the Extended settings tab you can now specify

l the edge distance of the top agraffe,

l the edge distance of the bottom agraffe, and

l the maximum distance of agraffes.
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(1) Edge distance of top agraffe; (2) Distance between 2 agraffes; (3) Edge distance of bottom agraffe

n When connecting a sub-structure to elements of the connection type Attic, long, the corresponding con-
nections, too, will now be correctly visualized.
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New test for ALUCOBOND sheets in Design Checker
In the Design Checker a new test for Sheet Metal parts is now available. The new test Sheet dimensions defined
by semi-fin. product (developed) checks the dimensions for the Material ALUCOBOND. For this purpose the table
Sheet dimensions (defined by semi-fin. prod.) at Factory standards > Sheet dimensions in the Catalogue Editor
will be evaluated. Based on this table the maximum length and width depending on the TableID of the semi-finished
product will be calculated.

Renamed system variables for element installations and sub-structures
The variables for element installations and sub-structures for the creation of user-defined installation elements and
profiles have bee renamed as follows:

Element installation old new

Width width i_l

Length height i_h

X-, Y-distance to origin of Fitting CS x0, y0, ... i_x0, i_y0, ...

Number of corners pointquantity i_nr

Sub-structure old new

Length length i_l

Variants that have been created with the old variable will still work.
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Major Release 2019 (V 2400)

Please note the following:
If you have started an element installation with ALUCOBOND tray panels in an earlier HiCAD version
and want to process this installation further in HiCAD 2019, you can only use the new connections and
options for ALUCOBOND tray panels if you click on the Create New button in the dialogue of the func-
tion. However, please note that in this case, dimensions and further processings will be lost on these
parts. If you close the dialogue window with OK instead, the HiCAD will continue using the "old"
ALUCOBOND tray panels, even if you have used the new settings/options in the dialogue window.

Performance
The performance for insertion and processing of element installations could be significantly improved in HiCAD
2019.
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ALUCOBOND® SZ20 sub-structure moved
The ALUCOBOND® SZ20 sub-structure that could be found in the ISD Example catalogue in previous versions has
beenmoved to an own ALUCOBOND catalogue.
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Connection information renamed to Connection parameters
The Connection information function which is required for preparing profiles that are to be used in a connection of
sub-structures and installed elements, has been renamed to Connection parameters.

Nothing has changed concerning the operation of this function.

New auxiliary functions for the creation of user-defined profiles for sub-structures

The new Repeat connection processing function in the Civil Engineering functions docking window
beneath Element installation simplifies the adjustment of parts to enable their connection to a sub-structure or to
an installed element.

After calling the function you can choose the connection parameters to be used and the feature steps to be
repeated. These will then be repeated as desired; Processing plane and Condition will be adjusted accordingly.
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Conditions and error messages in user-defined dialogues
For installation elements you can now assign conditions for the utilized variables. In addition, error messages can
be defined that are displayed if the conditions for the insertion of the element are not fulfilled. In this case the

respective input field or the OK button will be marked with the or symbol. When youmove the cursor over
these symbols, the corresponding error message will be shown.

The conditions and error messages for the variables must be stored in a file the name of whichmust be entered in
the CONDITIONS column.

Example:
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Extensive information on conditions and error messages can be found in the topic Customizing the Dialogue Win-
dow.
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Suspended ALUCOBOND® panels
Level of detail

For suspended ALUCOBOND panels, too, you can now select the Level of detail can now be selected, i.e. you can
choose between Exact or simplified representation (Draft). The representation as draft can be useful if you want to
increase the performance in drawings with very many panels. The representation can be changed back at any time
by processing of the element installation.
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Clearance for condensation

On the Extended settings tab of the dialogue window you can now specify a new Clearance for condensation para-
meter. The default setting is 12mm.

Attics - Fold angle specification

You can now specify a fold angle for attics.
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ALUCOBOND® SZ 20 tray panels
If you choose the option Vertical section - Connection, top: Window connection, parapet when installing
ALUCOBOND SZ 20 tray panels, an additional, angular fixing bracket will now be inserted.

If you connect such an element installation with a sub-structure, the sub-structure will be shortened accordingly
and bores will be applied to the substructure and the fixing bracket.

For Horizontal sections, Connection left/right you can now choose the option Window connection with L-profile.
In this case, an additional L-profile will be inserted. This option replaces the same-named checkbox on the Exten-
ded settings tab.
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ALUCOBOND suspended, sub-structure
A new sub-structure of the type ALUCOBOND suspended, sub-structure is now available. This part can be moun-
ted to element installations of the type ALUCOBOND, suspended by means of the Connection function; recesses
for the suspension will be created automatically in the process.
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Profile Installation

Service Pack 2 2019 (V 2402)

Edge profiles
Edges of profile installations can be finished with Edge profiles. A same-named tab has been added to the Profile
installation dialogue window for this purpose.

Here you can create as many edge profile installations as you want and with different settings. Besides a Maximum
length of the profiles you can define a Rotation and a Shift in lateral and forward direction.
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Visualization for rigid joints
If you use the joint type Rigid joint type for transverse joints, the selected direction and the selected distances will
be visualized directly in the graphic by means of an arrow and cutting lines.

New BRUCHA panels
New BRUCHA panels with different sizes have been added to the HiCAD catalogues and can be used for Profile
Installation. You can find them at Factory standards > Series > Roof wall facade > Room-closing profiles >
Brucha.
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Show dispatch item numbers in ICN
Thanks to configurable user-defined columns in the ICN it is now possible to display the dispatch item numbers dir-
ectly in the ICN.

The file SYS/ICN3D_USER1.HDB already contain entries for the dispatch item number, which only need to be activ-
ated by changing the comment characters as hown below:

What's new? 295 / 386

News Overview



Service Pack 1 2019 (V 2401)

Automatic creation of inserts
You have now the option to automatically place inserts in openings of profile installations.

For this purpose, a new side tab called Inserts has been added to the Profile installation dialogue window, allowing
you to configure the inserts.
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New catalogue: BRUCHA profiles
Profiles of the company BRUCHA have been added to the catalogue.

17 profile series have been added to the catalogue, and the number of default profiles has been increased from 913
to 2253.
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Improved Length optimization function
The Length optimization has been improved to make its operation easier. You have now the option to add all pro-
files of one length to the active selection via the context menu function Add profile(s) to selection.

Also, the number of different profile lengths and the total waste will now be indicated in the middle of the dialogue
window.
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Hatching of unpackaged profiles
Searching for unpackaged profiles with the Packaging function, too, has beenmade easier:At the bottom of the dia-
logue window you can find the Hatch the x unpackaged profiles checkbox, with x being the number of profiles in
the model drawing to which no package has been assigned yet. If you activate this checkbox, all affected profiles
will be hatched.
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Plant Engineering

Service Pack 2 2019 (V 2402)

Performance

Automatic placing of parts on guidelines

The redesigned function for the automatic placing of parts on guidelines comes with a significantly increased per-
formance.

Example 1:

Options: With weld seams, maximum pipe length 700, no connecting parts, part cache active and filled, data
source: HELiOS:

Previously SP2

12sec 2sec, i.e. 16% of former time
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Example 2:

The image below shows a model drawing by the company Certhon Build B.V. (Poeldijk, The Netherlands). The high-
lighted section is to be occupied with parts.

Options: With weld seams, no connecting parts, part cache active and filled, data source: HELiOS:

The parts that are to be placed on the guidelines are also parts made by Certhon, with the utilized pipe class con-
taining the following parts according to EN 10219:

n Pre-insulated elbows

n Pre-insulated reducers

n Pre-insulated pipes

Test Previously SP2

1 Maximum length for straight pipes: 10m. 2min 10sec, i.e. 8% of former time

2 Maximum length for straight pipes: 1m. 17min 15sec, i.e. 0.5% of former time
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Parts

Part insertion

When inserting parts you have now the option to temporarily ignore the pipe class. For this purpose the Ignore pipe
class checkbox has been added in the selection window for pipe parts. The default setting of this checkbox can be
set on the Part selection tab of the Plant Engineering Settings dialogue window.

The choice of the pipe class takes place according to the following principle:

n If the Ignore pipe class checkbox has been activated, no pipe class will be used for the part search.

n If the Ignore pipe class checkbox has been deactivated, the handling of the pipe class depends on the settings
in the Pre-selection area:

1. If no pre-selection has been chosen (None) , no pipe class will be used.

2. If the pre-selection is to be made Via pre-selection mask, only the pipe class from the pre-selectionmask
will be used.
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3. If the pre-selection is to be made Via pipeline, only the pipe class from the pipeline will be used.

4. If the pre-selection is to be made Via pipe class + pre-selection mask, the pipe class from the pre-selec-
tionmask will be used. If no pipeclass has been entered here, the pipe class of the pipeline will be used
instead.

Settings

Plant Engineering Settings - Part selection

New on this tab is the Ignore pipe class checkbox. This checkbox determines whether or not the pipe class is to be
ignored when you insert parts.

Pipeline Tools

Dynamic route change - Grid and improved length control

Changed lengths

Sections the length of which have been changed by a new route will now be represented as dashed lines. Also, you
have now the option to show additional information by activating the corresponding checkboxes beneath Text dis-
play in the Change route dialogue window.

If you want to display the changed lengths as texts, activate the Changed lengths checkbox.
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Relative position in grid

If the Use grid checkbox is active, the grid will be visualized by dotted lines. If the Relative position in grid is also
active, the distance to the start point will be written, along the grid axes, to the auxiliary lines. To distinguish such
distances from the texts for the changed lengths, they will be preceded by a capital Δ (Delta).

Use grid

The dynamic route change is now supported by a grid. This can be useful if you want to move the connecting point
of a pipe by a defined value in the direction of a connection that does not run along one of the axes of the currently
active coordinate systems.

The origin of the grid will always lie in the point to be moved in the process. The orientation will be selected in such
a way that one of the axes of the grid runs in connection direction, and a second axis lies in the XY-plane of the act-
ive coordinate system.

The grid is represented by dotted auxiliary lines, on which the current grid spacing is visualized by means of small
spheres.
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If the Relative position in grid checkbox beneath Text display has been activated in the dialogue window, the dis-
tance to the start point will be written, along the grid axes, to the auxiliary lines. To distinguish such distances from
the texts with changed lengths, they will be preceded by a capital Δ (Delta).

This display is particularly useful if a length change runs along a grid axis. In the image below, for instance, the
short straight pipe at the end of the pipeline is lengthened in downward direction. The new length of the pipe will be
1460, while the end point of the pipeline will be moved downwards by 1400 units:
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Immediately below the Use grid checkbox you can specify the incremental width (spacing) of the grid. Please note
that you can also pick the grid spacing from the drawing when you have chosen Pick distance from the context
menu of the input box. If the selected grid point cannot be reached with the route change, the auxiliary grid lines
and the text boxes will be highlighted in red:

Please note:

n While the grid is active, you can, of course, still snap the target point of the in the drawing. In this case the grid
will be automatically hidden.

n The dropping on a grid point takes place by pressing the middle mouse button, i.e. the behaviour corresponds
to the "free" dropping without grid. This prevents an accidental, unwanted dropping on a grid point when you
actually wanted to select a connecting point, as the dropping at connecting points is still carried out with a left-
click.

308 / 386 What's new?

Plant Engineering



Check for Collisions of Pipelines with Rest of Model Drawing

New in the Assign pull-down menu is the Collision check function. This function checks whether a
pipeline collides with other objects of the model drawing. It does not check whether parts of the pipeline collide
with each other

If a pipeline is active when you call the function, the collision check will be carried out for this pipeline. Otherwise,
HiCAD asks you to choose a pipeline for which the collision check is to be carried out.

If collisions are found, an appropriate message will be displayed and HiCAD will generate so-called "collision parts"
which can be found in the ICN, beneath the part Collision groups name . name is the name of the checked
pipeline.

An example:

In the image below the Pipeline (1) collides with the Cylinder (2) and the Pipeline (3). If you carry out the collision
check, there will be 2 collision parts in the Collision group.
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Guidelines

Revised automatic placing of parts on guidelines

The AutoPlace parts on guidelines function has been fundamentally revised.

Detail representation for a clearer overview

If a part for a particular fitting situation needs to be found during automatic placing of parts, an appropriate search
window will be shown. This search window can belong to a different application, e.g. HELiOS. If such a window is
shown, HiCAD will not allow any inputs, i.e. you cannot navigate in such a situation.

In previous versions the selection of a suitable parts could sometimes be difficult, if the search request referred to
an "invisible" fitting situation. In many of such situations the fitting context of the part was rather unclear.

For the sake of a clearer overview, a second window with an enlarged detail view of the current fitting situation will
be shown. This means that the drawing area is split into two areas during automatic part placing: On the left an over-
view of the complete pipeline is shown; on the right, an enlarged representation of the concrete fitting situation is
shown. In both representations, an arrow pointing at the current fitting situation is displayed. The direction of the
arrow corresponds to the viewing direction in the detail view.

Example:

The following example shows the original drawing, where the automatic placing of parts initially sets a coun-
terflange:

If you now start the automatic placing of parts, the following will be displayed as soon as the search window offers
concrete flanges for selection:

310 / 386 What's new?

Plant Engineering



The vessel will only be displayed in the detail window, as it does not belong to the pipeline. This representation
serves the purpose of a clearer overview, since vessels are normally the larger parts. In the detail view, longer parts,
such as pipes and guidelines, are sometimes only implied: In the present example, a portion of the guideline is
implied by means of a dashed line. This representation, too, servers the purpose of a clearer overview.
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Placing of parts on pipeline sets

From SP2 onwards it is possible to interpret several connected pipelines as one pipeline set and place parts on
them in one step. Use the new Place parts on pipeline set option for this.

Example:

In the image below (left), a new pipeline begins on the single flange.
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If you have chosen the Place parts on pipeline set option, parts will be placed on the pipeline set in such a way, as
if the pipeline set was one single pipeline.
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Reducers on guideline transitions

Automatic placing of parts on guidelines also supports reducers on guideline transitions. The function will then
place reducers in places where there is a transition between guidelines of different nominal widths.

Such a reducer is placedmidway on the transition:

Graphic
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Caps on free ends

This option automatically places caps on vacant guideline ends (i.e. the start or end of a guideline). A guideline end
is vacant if no part is located on the end point, and the end point is not located on the connection of a part that does
not belong to the active pipeline.
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Service Pack 1 2019 (V 2401)

Performance

Delete several parts

The performance for part deletion has been increased significantly. For example, a performance increase by a
factor of 10 could be achieved for the model drawing shown below:

In our test the highlighted part was chosen, and the context menu function (right-click part) Delete several parts

was selected, with the All parts option.

Example drawing (Certhon Build B.V., Poeldijk, The Netherlands)
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Working with guidelines

Inserting parts in flow direction / against flow direction

From HiCAD 2019 SP1 onwards, the flow direction (and no longer the edge direction) will be used for the determ-
ining of the orientation of parts placed onto guidelines. During part insertion, appropriate flow direction arrows will
be displayed.
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Trimming of guidelines

After insertion of a new guideline and during processing of existing guidelines HiCAD will now check whether the rel-
evant pipeline contains a guideline on which the start point and also the end point of the new/processed guideline is
located.

If this is the case, the edges that would be trimmed away will be highlighted. At the same time, an appropriate mes-
sage will be displayed.

n If you confirm the trimming when inserting a new guideline, the already existing guideline will be trimmed and
expanded by the new guideline. This means that no new guideline will be created, but only the existing
guideline will be modified.

n If you confirm the trimming during processing of an already existing guideline, the highlighted edges will be
removed and the two guideline will be merged into one.

Example 1: Insertion of a new guideline

(1) Existing guideline, (2) New guideline , (3) Confirm with Yes, (4) Modified guideline
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Example 2: Processing of an already existing guideline

The image below shows 2 guidelines of a pipeline. The start point of Guideline 2 lies on Guideline 1, but the end
point does not. When inserting this guideline, no Trim option will therefore be offered. But if you not modify
Guideline 2, moving, for example, its end point onto Guideline 1, you can trim. If you confirm the message with Yes,
the highlighted edges will be removed and the two guidelines will be merged into one:

Trimming is not possible if this would remove guidelines that already contain parts.
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Pipeline Tools

Create pipeline - BOM-relevance
New pipelines can be marked as BOM-relevant directly during their creation by activating the new BOM-relevant
checkbox.

Dynamic route change

The Dynamic route change function offers a multitude of options which, however, were only active after selecting a
point to be moved. In model drawings with very many connections, this could sometimes lead to confusion if the
cursor had to move over a multitude of connections on its way to the dialogue window. While the Allow direction
changes option was activated, unwanted route change calculations and their subsequent cancellation were often
the result. The previous behaviour also made a local displacement of valve more difficult, since the fixed point
required for this could only be specified after selecting the point to be moved.

n To improve operability in such cases, HiCAD now offers all dynamic route change options right from the start. In
particular, it is now possible to specify fixed points, connections with fixed angles and fixes lengths sections
before selecting the point to be moved.

n Fixed points, connections with fixed angles and fixes lengths sections can now be chosen in the entire drawing
at any time. If you want to change the routes of several pipelines, you can now define degrees of freedom for all
pipeline first before adjusting their routes.

n In previous versions the selected options were always assigned to the pipeline that was changed. For the next
route change of the same pipeline, these options were then available again. This behaviour does now no longer
make sense, since the options are no longer bound to the pipeline. Instead, the dialogue window will memorize
the last settings, irrespective of the pipeline.
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Also changed has the display of connections with fixed angles. These are normally displayed by a circle with the
special colour Grid (Default: Black). The circle surrounds the axis, about which the rotation would otherwise have
been performed. However, there are situations where this rotation axis will only be determined after selecting the
point to be moved. In such cases, connections with fixed angles will be displayed by means of a circle that lies
always in the projection plane. This situation occurs, for instance, when there are bent guidelines:
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After determining the rotation axis by selecting the point to be moved, the display will be adjusted as follows:
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Pipeline isometry

Spreading isometries over several drawing sheets

In previous versions, when you spreaded an isometry over several sheets, one new drawing was created for each
section of the pipeline (and, if HELiOS is used, a new document master was created). If an isometry was subdivided
several times, things could easily get confusing.

From HiCAD 2019 SP1 onwards, only one drawing will be created for each pipeline. If a pipeline isometry is sub-
divided, the old isometries will be deleted, and the partial isometries will be created in the same drawing. In the pro-
cess, the symbols of the isometries will be arranged into assemblies and one sheet will be created for each part
isometry.

Example:

Take a look at the layout plan and its corresponding isometry shown below:
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If you divide the isometry at the blue point (see red arrow) and then generate it again, the sheet with the current iso-
metry will be deleted, and two new sheets for the partial isometries will be generated.
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Evaluation / Information

Associated pipeline indicated

The pipeline to which a part belongs is now displayed in the Part information as well as in BOMs.

In Plant Engineering BOMs you can now find the new Pipeline (Attribute: %PipeLineName) column that indicates
the pipeline to which the respective part belongs. The default template for plant Engineering BOMs, Anlagenbau_
ohne_DB_SZN.rms (HiCAD sys directory) and the corresponding EXCEL template in the BOMTemplates folder
have been adjusted accordingly.

Parts / Components

Model welding necks as flanges

Since HiCAD 2200 it has been possible to insert welded necks with loose flanges. The logic in older versions inter-
prets the welding neck as a straight pipe to which regular loose flanges are assigned. For a placement of these
loose flanges the variable F1 has been introduced, which determines the distance of the loose flange from con-
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necting point 1 of the welding neck. However, this logic is not optimal if you want to create an isometry of the
pipeline, as the flange symbol of the loose flange will then be slightly displaced.

As of HiCAD 2019 SP1 you have an alternative to model such a combination of welding neck and loose flange.
When using this procedure, the flanging must be of the type "Flange", while the loose flange is an asymmetrical
fastener. The flange connection of the welding neck must have the connection type 20600. The 6 coming in the
third place encodes the asymmetrical fastener with flange connection, i.e. normally a loose flange classified as
fastener. For this procedure the variable F1 will also determine the distance of the loose flange to connecting point
1 of the welding neck. For welding necks, F1 normally equals the wall thickness.

In contrast to welding necks that are modelled as straight pipes, the flange symbol is assigned to the welding neck
here. This ensures that the position of the flange symbol in a generated isometry will not be affected by a possible
moving of the loose flange.

Please note:

If you want to fix the loose flange by a welding point, you should not model it as a fastener, as fasteners do not sup-
port welding points on connecting points 2. In this case you must use genuine loose flanges, i.e. such flanges that
are actually classified as flanges.
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Asymmetrical T-pieces

In previous versions, T-pieces were always symmetrical, i.e. the inserted pipe had always to be located in the
middle between the named points 1 and 2. From now on, you can also insert asymmetrical T-pieces.

If the variable L1 exists in the variant, the insertion length will be the double amount of L1. Otherwise, the insertion
length will be the sum of L1A and L1B.

Old New
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New standard parts

Parts for pipeline planning in the food industry

The standard part inventory has been expanded by the following parts acc. to DIN 11851:

Part type Part Variant

Blank flange Threaded dummy socket N11851_BGS.VAA

Blank flange Tapered dummy socket N11851_BKS.VAA

Sealing gasket O-ring N11851_OR.VAA

Double knee Reversal pipe bend 180° KK N11851_DOUBLEKNEE_KK.VAA

Double knee Pipe bend 180° KK N11851_KNEE180_KK.VAA

Flange Threaded socket N11851_GS.VAA

Flange Tapered socket N11851_KS.VAA

Straight pipe Intermediate piece GK N11851_STR_GK.VAA

Straight pipe Intermediate piece KK N11851_STR_KK.VAA

Straight pipe Intermediate piece GG N11851_STR_GG.VAA

Knie Pipe bend GG N11851_KNEE_GG.VAA

Knee Pipe bend GK N11851_KNEE_GK.VAA

Knee Pipe bend GS N11851_KNEE_GS.VAA

Knee Pipe bend KK N11851_KNEE_KK.VAA

Knee Pipe bend KS N11851_KNEE_KS.VAA

Cross Cross piece GGGG N11851_CROSS_GGGG.VAA

Cross Cross piece KGGG N11851_CROSS_KGGG.VAA

Cross Cross piece KGKG N11851_CROSS_KGKG.VAA

Cross Cross piece KKKG N11851_CROSS_KKKG.VAA

Cross Cross piece KKKK N11851_CROSS_KKKK.VAA

Reducer, symm. Reducer GG N11851_RED_GG.VAA

Reducer, symm. Reducer GK N11851_RED_GK.VAA

Reducer, symm. Reducer KG N11851_RED_KG.VAA

Reducer, symm. Reducer KK N11851_RED_KK.VAA

Reducer, symm. Threaded reducer socket N11851_RGS.VAA

Reducer, symm. Tapered reducer socket N11851_RKS.VAA

Other pipe part Threaded screw-on socket N11851_GAS.VAA

Other pipe part Threaded screw-in socket N11851_GES.VAA

Other pipe part Tapered screw-on socket N11851_KAS.VAA

Other pipe part Tapered screw-in socket N11851_KES.VAA

Other pipe part Compensator GG N11851_KOMP_GG.VAA

Other pipe part Compensator GK N11851_KOMP_GK.VAA

T-piece T-piece GGG N11851_TBEND_GGG.VAA

T-piece T-piece GGG N11851_TEE_GGG.VAA
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Part type Part Variant

T-piece T-piece GGK N11851_TEE_GGK.VAA

T-piece T-piece GKG N11851_TEE_GKG.VAA

T-piece T-piece GKK N11851_TEE_GKK.VAA

T-piece T-piece KKG N11851_TEE_KKG.VAA

T-piece T-piece KKK N11851_TEE_KKK.VAA

T-piece T-piece SGK N11851_TEE_SGK.VAA

Fastener, asymm. Slotted nut N11851_NUT.VAA

For an easy transfer to the database these parts are listed in the foodline11851.lst file in the PlantParts directory.

Also new are the following parts from the catalogue of the company Kieselmann:

Part type Part Variant Standard designation

Blank flange Blind plug - Sheet KM11851_BKB.VAA Kieselmann 11851

Blank flange Tapered dummy socket KM11851_BKS.VAA Kieselmann 11851

Seal Sealing ring KM10357_OR.VAA Kieselmann 10357

Flange S-flange PN10 KM10357_SF_
PN10A.VAA

Kieselmann 10357

Flange Small flange KM10357_SF.VAA Kieselmann 10357

Flange Small flange, slot KM10357_SF_SLOT.VAA Kieselmann 10357

Flange Welding neck, DIN KM10357_WN_DIN.VAA Kieselmann 10357

Flange Threaded socket KM11851_GS_L.VAA Kieselmann 11851

Flange Tapered socket KM11851_KS_L.VAA Kieselmann 11851

Flange Small blank flange KM11853-2_BBF-2.VAA Kieselmann 11853

Flange Small blank flange 1 KM11853-2_BBF.VAA Kieselmann 11853

Flange Clamped welded fusion spigot KM32676_CSS.VAA Kieselmann 32676

Reducer, symm. Reducer, concentric KM11852_RK.VAA Kieselmann 11852

Reducer, asymm. Reducer, excentric KM11852_RE.VAA Kieselmann 11852

Fastener, asymm. Slotted nut KM11851_NUT.VAA Kieselmann 11851

These parts can be found in the list file foodline_kieselmann.lst.
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Welding necks and loose flanges

With the variants KM10357_WN_DIN.VAA and ROFI10357_WN_ISO.VAA, two part families have been added to
the standard part inventory that, although classified as flanges, are in fact welding necks. In total, the following
welding neck variants are available:

Variant Standard designation

KM10357_WN_
DIN.VAA

Kieselmann
10357

ROFI10357_WN_
ISO.VAA

RO-FI 10357 Contains all sub-types of the modelled welding neck

ROFI10357_WN_ISO_
R1.VAA

RO-FI 10357
R1

Each variant contains a portion of the sub-types from
ROFI10357_WN_ISO.VAA

ROFI10357_WN_ISO_
R2.VAA

RO-FI 10357
R2

The variants refer with regard to their connection type to the new loose flanges of the standard DIN 2642, which are
classified as asymmetrical fasteners:

Series Variant Standard designation

1 N2642_LF_R1.VAA N2642 R1

2 N2642_LF_R2.VAA N2642 R2

The loose flanges of Series1 match the Variant ROFI10357_WN_ISO_R1.VAA. The loose flanges of Series 2 match
the Variants ROFI10357_WN_ISO_R2.VAA und KM10357_WN_DIN.VAA.

Attributes for the fourth connection

Previously, the HiCAD standard parts inventory only contained such parts with 4 connections that had identical third
and fourth connections. HiCAD 2019 SP1 offers new cross-pieces ("Crosses") for which this is different. Therefore,
the following system attributes have been added:

CNT4 Connection type 4

DA4 Outer diameter 4

DN4 Nominal diameter 4

DNI4 NPS inch 4

WTH4 Wall thickness 4

The corresponding attributes are available in HELiOS. To assign these attributes to those of the HiCAD catalogue,
the following system files in the HiCAD folder PlantParts/CatSearch have been expanded accordingly:

File Expansion

3110010.CatSearchAtt.txt ANSCHLUSSART2

4300010.CatSearchAtt.txt ANSCHLUSSART2

3300010.CatSearchAtt.txt ANSCHLUSSART2 und ANSCHLUSSART4

4400010.CatSearchAtt.txt ANSCHLUSSART2 und ANSCHLUSSART4
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Expanded database

Attributes for fourth connections

When preparing a HELiOS database for Plant Engineering tasks with the DBPlantDataImport tool, the following addi-
tional attributes will be created for a better support of parts with 4 connections:

n NENNWEITE4 (Nominal diameter 4)

n WANDDICKE4 (Wall thickness 4)

n ANSCHLUSSART4 (Connection type 4)

n N4_INCH

n NPS4_INCH

n D4_AUSSEN (D4 Outer)

Enhanced search masks for Cross and 4-way valve

The new parts acc. to DIN 11851 for food ducts used in the food industry include crosses and valves the connection
types for Connections 3 and 4 differ from each other. From HiCAD 2019 SP1 onwards, the HELiOS search masks
will therefore contain corresponding new input fields, so that separate input fields now exist for deviating con-
nection types for the Connections 2 and 4.
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Other new features

Specify size of marking arrow

For various functions, e.g. the automatic placing of parts onto guidelines or the exchanging of parts on guidelines,
an arrow pointing on the currently processed part or guideline will be displayed. The representation of the marking
arrow has been changed in HiCAD 2019 SP1.
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Also, the size of that arrow can be specified in the Configuration Editor at Plant Engineering > Layout plan. The
value must be between 10 and 300 pixels, the default value is 80.

Changing the part type ID during automatic deriving of variants

From HiCAD 2019 SP1 onwards, you can also change the part type ID, and thus also the classification of a VAA and
a PAA file when automatically deriving variants.

The attribute assignment file (attribute_assignment.csv) supports the pseudo attribute VAREDIT_KEEP_DB_IDS
for this purpose.

If this attribute has the value 1, the previous HELiOS IDs will be preserved during automatic deriving. i.e. no "actual"
deriving takes place. From a HELiOS perspective, the resulting VAA or PAA file refers to the same parts. This is help-
ful for the adjustment of existing VAAs or PAAS, especially in conjunction with VAREDIT_MOVE_ON_SUCCESS.

Also, it is now possible to map the attribute ARTSCHLUESSEL (Type key) to a column in the file customer_list.csv.
In this column the part type ID of the VAA or PAA file must then exist in the format AAAAA_BBBBBBB, with AAAAA
being the coding for the industry according to anbtlken_top.dat and BBBBBBB the ID according to anbtlken.dat.

If the format should not be correct, the message

Classification not in the format AAAAA_BBBBBBB, with A = Industry and B = ID

will be issued in the output column.

PartDataAutoSync with check for part type ID

If you use the PartDataAutoSync.exe tool for part data synchronization with the HELiOS database, you can now
check whether the part type ID of a VAA or PAA file has changed. If this is the case, the classification of the article
masters in HELiOS will be adjusted accordingly.
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Major Release 2019 (V 2400)

Processing of guidelines

Cut off corner

The Cut off corner function has been revised completely. As of HiCAD 2019 the identification of the cut
takes place in 4 steps:

1. Select the guideline.
All corners where a cutting off is possible will be marked.

2. Choose the corner to be cut off.
If there is only one corner, this corner will be selected immediately.

3. Determine the leg start.
The leg start can be located on one of the two edges that converge in the selected corner point.

4. Enter the angle to the leg.

During selection of the corner point or the leg start, respectively, you can go back to the previous selection step via
the corresponding context menu function. When determining the angle, this happens by entering an empty angle.
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Place pipe parts on guidelines

Change insertion direction

In previous versions the insertion direction of pipe parts on guidelines - In edge direction or In opposite edge dir-
ection - needed to be specified during part selection: After part selection the direction could not be changed any
more. As of HiCAD 2019 it is possible to change the insertion direction of a part during its placing in the drawing.

For this purpose the new Reverse orientation function has been added to the Reference point context
menu.

In addition, the part can now also be placed directly at the start or the end of a guideline. For this purpose the pre-
vious option Connection 1 on origin has been replaced with the options

Place at guideline start and

Place at guideline edge

The Reference point menu can be opened with a right-click whenever HiCAD requests the fitting point spe-
cification in the drawing.

The new options are also available during exchanging of parts.
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Rotate parts

Free selection of rotation axis

The dialogue for rotating of parts after their insertion has been revised. Up to HiCAD 2018 you could only select one
connection number here. As of HiCAD 2019 rotation axis and rotation direction will be graphically visualized and the
rotation axis can be freely selected.

This is also true for the rotating and exchanging of parts.
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Extended UNDO

The functionality of the UNDO button in the Rotation angle menu has been enhanced. Previously, the angles had
been added here and then, all rotations were revoked with one UNDO action. In some situations this had led to
errors, e.g. in situations where a part was first rotated, then the connecting point was changed and, finally, the part
was rotated again. As of HiCAD 2019, the UNDO button revokes the rotation about the last selected rotation axis. If
the rotation is 0°, the last change of the rotation axis will be revoked. In this way, it is possible to revoke several axis
changes and several rotations independently from each other.

PAA Editor and VarToCat

Take over attributes for all languages

If you have used the PAA Editor or the VarToCat tool in HiCAD 2018 (or older versions) to change attribute assign-
ments and confirmed them with OK without adjusting the attributes in all languages, the corresponding Editor
issued a warning, and entered the text <text_input> into the concerned input fields.

As of HiCAD 2019, changed attribute assignments can be automatically taken over into the other languages. If
attributes are missing, the following message will be displayed:

If you choose Yes, the attribute from the first language, in which has a value, will be transferred to the cor-
responding fields of the other language, if these are empty; otherwise, the current content of the field will remain
unchanged.

If you choose No, the text <text_input> will be entered in the corresponding fields of the other languages.
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Pipeline Tools

Down-grade Editor

With the new Down-grade Editor you can assign down-grades to individual sections of a pipeline. You find

the Down-grade Editor at Plant Engineering > Pipeline Tools > Change > .... The Down-grade Editor works
according to the following principles:

n The down-grade always refers to the XY-plane of the active coordinate system.

n Down-grades can only be assigned to such sections that run approximately horizontal. "Approximately" here
means: less than 45° or less tan 100% down-grade.

n The routes of sections the down-grades of which exceeds 45°, i.e. especially vertical sections, will not be
changed. Such sections are not selectable either.

n Sections end at elbows and knees.

n Branches and T-pieces are assigned to one section, unless the flow direction changes within a part (see below).

n Existing lengths will be preserved if possible. If this is not possible, the changes will be distributed evenly among
the pipeline.

When you choose the function the Down-grade Editor dialogue window will be displayed:
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Changed menus

The new Down-grade Editor refers to the flow direction when assigning down-grades, i.e. as of HiCAD 2019 the rel-
evance of the flow direction concerns not just isometries. The functions

Edit flow and

Check flow

have therefore been moved from the menu Plant Engineering > Isometry / Pipe Spool Drawing > Ref. > ... to

the menu Plant Engineering > Pipeline Tools > Change > ....

Also, the functions

Start ROHR2 and

Only create NTR file

from the menu Plant Engineering Pipeline Tools > Change > ... have been moved to the menu Plant Engin-

eering > Evaluation > Active > ....
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Flow Editor

In previous versions the Flow Editor could only be used to assign flows to parts. From HiCAD 2019 onwards the Flow
Editor can also be used on guidelines.

Configuration of the HELiOS Databases - DBPlantDataImport.exe

Using existing article masters for automatic deriving of variants

If Plant Engineering variants with existing HELiOS article masters are to be used, you had only the option to enter a
matching HELiOS URL for each sub-type directly during part synchronization. On the one hand, this procedure is
very tiresome, and on the other hand, it requires at least the explicit permission to create article masters in HELiOS.
Especially the latter may be problematic in configurations where HELiOS obtains the article masters downstream
from other ERP systems. To support such cases, the mechanism for automatic variant derivation has been
enhanced.

To transfer VAA files to HELiOS that were generated with the new mechanism, the tool DBPlantDataImport.exe
must be called with the parameter /X. This will enable you to adjust existing article masters in a Plant Engineering
compliant manner.

Further information on this procedure can be found in the Online Help of the Variant Editor, in the topic Automatic
Creation of Derived Variants.

Example: Let us assume that you choose the dialogue type Code for the Plant Engineering attribute 1 and, in the
P+ID, change the Code for a Vessel symbol from B1 to B2. When switching to the 3-D layout plan, the PE attribute
1 will be changed for the affected Vessel from B1 to B2. This will also be confirmed by a corresponding info mes-
sage.
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P+ID

Service Pack 2 2019 (V 2402)

Automatically hide layers for printouts
You have now the option to specify layer-specific printing settings in the P+ID module via the Configuration Editor
(at Plant Engineering > P+ID). For this purpose you can define a list with layers that are to be excluded for printouts.
Click the Add button to expand the list. Beneath Properties you can then enter the number of the layer.
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Configurable space widths for connection interruptions
You have now the option to define the space widths of connection interruptions. For this purpose you can find an
editing box on the Connections tab of the P+ID Settings dialogue window, where you can enter the desired space
width for interruptions in mm.

New procedure for creating new pipelines
The procedure for creating new pipelines has been changed as follows:

1. When a new pipeline is created, no message appears any more.

2. The pipeline symbol is automatically inserted at a particular place.

3. The flow direction is set from start to destination.

4. You have the option to have pipeline numbers generated automatically.
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Automatically assign pipeline numbers

First, open the Connection tab of the P+ID Settings dialogue window and activate the Automatically assign
pipeline number checkbox.

Then, you need to specify various settings in the symbol mask for the pipeline symbol, as the related entry for the
attribute Pipeline number plays a decisive role for the generation. The entry %COUNT(1:0:RL) , for example,
ensures that natural numbers beginning with 1 will be used as pipeline numbers. The entry %PIDAT
(430)%PREPOST(%PIDAT(431):-)%PREPOST(%PIDAT(432):-) for the Code ensures that codes in P+ID are
generated in the way would expect it.

Further useful information about generation instructions can be found in the topic Take Over Database Attributes as
Dialogue Text.
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The mask as shown in the image above is the default mask in the P+ID libraries ISDDINSYM1_GER and
ISDDINSYM1_ENG, respectively.
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Service Pack 1 2019 (V 2401)

Exchanging symbols
You can now choose whether you want to exchange P+ID symbols via a reference symbol (as in previous versions)
or determine a matching symbol via the symbol selection dialogue (new).

The context menu of symbols (right-click) now looks as follows:
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On the toolbar the following editing options are now available:

Exchange,
via ref-
erence -
Individual

Exchange,
via symbol
selection
menu - Indi-
vidual

If the exchange is valid, the selected symbol is replaced.

Exchange,
via ref-
erence - In
rectangle

Exchange,
via symbol
selection
menu - In
rectangle

This option enables you to draw a rectangular box by specifying two points with the
cross-hairs. All symbols within this box matching the selected symbol are replaced.
HiCAD then highlights these symbols. If required, the highlighting can be retained
until the next time the screen content is redrawn.

Exchange,
via ref-
erence -
Sheet

Exchange,
via symbol
selection
menu -
Sheet

This option exchanges all symbols on the current drawing sheet that match the cur-
rently selected symbol. HiCAD tells you how many symbols have been replaced and
then highlights them. If required, the highlighting can be retained until the next time
the screen content is redrawn.
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Edit pipeline symbols from a different sheet
You can now even edit a pipeline symbol that does not exist on the current drawing sheet, but to which pipeline
parts or pipeline info symbols have been subordinated on the current sheet. To do this, edit the subordinated parts.

To do this, activate the Edit pipeline symbol function on the P+ID Ribbon tab and choose a symbol that has
been subordinated to the pipeline symbol.

Then, choose a symbol that is subordinated to the pipeline symbol.

The Edit symbol mask will then be displayed for the pipeline symbol.
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Major Release 2019 (V 2400)

Block symbols
HiCAD P+ID R+I now supports so-called block symbols. These are symbols that represent a P+ID sheet.

In the ISD library ISD_PROCESSFLOW.SZA such a block symbol is already available. Users can create such sym-
bols using the Symbol type 18 = Schema block. After inserting a block symbol, you can call the editing functions
for the block symbol with a right-click on the symbol.

Load
assigned
P+ID
sheet

If a P+ID sheet has been assigned to a block symbol, you can open the assigned
sheet via the context menu of the symbol.

Assign
already
existing
P+ID
sheet

Use this function to open a dialogue window with a list of already existing, selectable
P+ID sheets that have not been assigned to a a block symbol yet. If no P+ID sheets
are available for selection, a corresponding message will be displayed.

Create
new P+ID
sheet

This function opens the knownmaster data dialogue window when creating a new
sheet.

Edit mas-
ter data

Use this function to edit the master data of the assigned P+ID.
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When you right-click on the title block of a sheet and choose Show assigned block symbol , the cor-
responding P+ID sheet containing the block symbol will be loaded, and the block symbol will be highlighted:
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Take over P+ID attributes from P+ID
P+ID dialogue types can be assigned to user-defined attributes can be assigned to on the p+ID attribute assign-

ment tab of the Plant Engineering Settings dialogue window that you open by choosing P+ID > Settings .

When you change one of the assigned dialogue types for a symbol in a P+ID, and then switch to the 3-D layout plan

via P+ID > Link to 3-D > Assigned 3-D layout plan , the new value of the dialogue field will be applied to the
attributes of the part.

Example: Let us assume that you choose the dialogue type Code for the Plant Engineering attribute 1 and, in the
P+ID, change the Code for a Vessel symbol from B1 to B2. When switching to the 3-D layout plan, the PE attribute
1 will be changed for the affected Vessel from B1 to B2. This will also be confirmed by a corresponding info mes-
sage.
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Notes on HELiOS Updates

Service Pack 2 (V 2402)

Important Notes on Updates for Administrators
For updates to Service Pack 2 of HELiOS 2019 a central update of the supplied HELiOS database is required (from
sub-schema 166 to 194).

Since conflict may occur during the update process in case of inconsistent data stocks, you should do the fol-
lowing:

1.) Make a data backup before updating

Make sure that a data backup was made before carrying out the update of your HELiOS database.

For the backup, either use the HELiOS Database Creator (further information can be found in the Installation Notes)
or your SQL Server Application.

In case of any questions, or if you need any help with regard to your customized system architecture , contact the
ISD Hotline.

2.) If required, use the log file for the update

If any conflicts occur during the update, these will be recorded in the log file HeliosDbUpdate.txt (in the system
path%appdata%\ISD Software und Systeme\HeliosDbUpdate\).

Have this file ready when contacting the ISD Hotline in case of an unsuccessful update, so that they can help you
solve the problem andmake a successful update.

News Overview
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HELiOS Desktop

Service Pack 2 (V 2402)

About HELiOS Desktop window: Installed Hotfixes
The About HELiOS Desktop window now also shows, besides the current Version and Build number, the numbers

of installed Hotfixes. To open this window, choose > About HELiOS Desktop at the top right of the
HELiOS Desktop.
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Support request

The new > New support request function takes you directly to the support portal of the ISD Group,
where you can create a support ticket.

After calling the function, use your login data for my-ISD to access the support portal of the ISD. Fill in the form,
attach files if required and click on Create request.

The new ISD support portal will be available for customers in Germany from 1 October 2019. For customers in
other countries, the launch is scheduled for January 2020.

Attribute mapping for file import via Drag & Drop and serial input
On the Import/Export tab of the HELiOS Options dialogue window you can find, beneath Attribute assignments,
setting options for the Transfer to HELiOS, which will apply for file import via Drag & Drop.

The procedure is largely similar to the attribute mapping known from the Multi-CAD interfaces and also allows the
definition of different templates, which can be used, via menu selection, for the import.
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Automatic removing of old sessions
In case of a HELiOS Desktop crash or the crash of a linked application such as HiCAD, it is now ensured that “old”
sessions are automatically removed, and thus unlocked, on the relevant computer system when HELiOS is restar-
ted. This means that you do not have to manually unlock any sessions any more.
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Service Pack 1 (V 2401)

Redesigned user interface
HELiOS 2401 SP1 comes with redesigned and modernized windows and input masks for the HELiOS Desktop and
interfaced applications (CAD programs, Office...). Fields with input options are underlined, currently active fields
are underlined in blue.

Clicking on the symbol at the end of an active input field clears the field (as an alternative to the Delete key).

The Login dialogue, too, has had a redesign.
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The Mask Editor now offers the option to add an Annotation to an attribute field.

Masks that have been adjusted with the Mask Editor will then appear with the new layout in the HELiOS Desktop.
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Where-used lists for documents
Like the Article detail masks, the Document detail masks now have a Use tab that contains a documents where-
used list based on the HELiOS result list technology.

Choose > Use to activate this tab.

Copy number

The new context menu function Copy number enables you to copy the designation of a HELiOS object (Docu-
ment number, Article number, Folder name, Project, Material designation) to the Clipboard, e.g. to paste it from
there to other applications with only a few mouse clicks.
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Major Release 2019 (V 2400)

Support of SQL Server 2019
HELiOS 2019 supports the new SQL Server 2019.

Integrated preview for standard image formats
Image formats such as JPEG, TIF, BMP, PNG, etc. which have been saved as documents to HELiOS can now be
displayed by the new, integrated graphic viewer of HELiOS.

You can zoom into graphics and move the selected detail at any time. This allows an easy representation of neutral
formats and reduces the number of external viewers that may be required.

Workspace
As of HELiOS 2019 the Workspace that you already know from the Multi CAD and Office interfaces will be available
to you in the HELiOS Desktop, too.

Click on the Show workspace icon on the General Ribbon tab to open the HELiOS Workspace dialogue win-
dow.

Here, all documents of the session will be listed. Documents that are opened and/or edited via the HELiOS Desktop
will be stored in the workspace directory.

This will constantly provide you with a clear overview of the corresponding HELiOS objects, so that you can check
them into the database when required. When closing the HELiOS Desktop a question regarding the handling of
objects that are still in the Workspace will be displayed.

In the new Changed, local column the symbol indicates that a document has been changed locally and
saved since its last synchronization with HELiOS.
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New dialogue windows
HELiOS 2019 comes with many modernized dialogue windows.

This concerns in particular the Workflow -related dialogues and sub-functions (e.g. the Check list, the History and
the Sub-workflow) and the range of functions for Links, e.g. the assigning of templates for link classes.
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Revised SmartSearch dialogue window
The dialogue window of the HELiOS SmartSearch has had a redesign and was adjusted to current standards.
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New dialogue for unlocking of HELiOS objects
For unlocking of objects that are currently edited by other instances, the "ReleasedNext" tool was used in previous
versions. This tool has now been replaced with a revised, integrated dialogue window that opens after starting
HELiOS (or HiCAD) if such objects have been found.

The dialogue window can also be called by choosingAdmin Tools > ReleaseNext (Administrator rights required).
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Workflow - Send E-mails with notes
In the action list for Role Workflow steps you can now determine that in the case of certain Workflow steps (e.g.
Request checkup or Release), E-mails are automatically sent to relevant users.

The note commenting on a Workflow status can be sent together with the E-mail in the process.
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In the EDBSETUP action list of the corresponding Workflow step, enter the placeholder <$EDBNOTE> for the into
the comment field of the E-mail action dialogue window that will open when you click on the Send E-mail button.
The note will then appear in the E-mail.
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Option for mandatory project/folder selection
In some cases it makes sense to restrict access to particular projects and/or folders of the HELiOS database for par-
ticular users or user groups - e.g. external suppliers that have been integrated into the system.

This can be achieved by deactivating the new permissions functionWork folder-independent or Work project-inde-
pendent in the Management of the EDBSETUP for particular users.
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Users who do not have that permission will not have the possibility of project-independent or folder-independent
views, searches or inputs any more , since the corresponding buttons or selection options do no longer exist in the
HELiOS user interface.

Please note:

Already existing users and user groups will automatically receive the new permission after an update of the existing
database.
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Changeability of old indices by Administrator
The new database option ( HELiOS Options >  Database > General > Changeability of old indices by
Administrator enables Adminsistrators to edit old indices. This concerns both meta data and the relevant files, and
will also take effect when saving documents in interfaced CAD systems and importing files in the HELiOS Desktop.

368 / 386 What's new?

HELiOS Desktop



HELiOS in HiCAD

Service Pack 2 2019 (V 2402)

New icons for HiCAD file formats
From SP2 onwards, new icons for the different HiCAD file formats e.g. SZA, FGA, KRA, VAA, PAA are available.
These icons will be shown in the HELiOS result lists.

File format File type

.SZA HiCAD model drawing

.KRA HiCAD 3-D part

.FGA HiCAD 2-D part

.VAA HiCAD variant

.PAA HiCAD part archive

.RPA HiCAD P+ID
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Service Pack 1 2019 (V 2401)

Article master sync when saving

The Article master sync when saving that you use to specify which HiCAD part attributes are to be syn-
chronized with which HELiOS article master data has been moved from the Drawing tab to HELiOS PDM at Others
> Link > ....
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Major Release 2019 (V 2400)

Automatic transfer of product structure and article master attributes upon saving
In the Configuration Editor you can specify whether 1.) Changes to the product structure and 2.) HiCAD part attrib-
utes in the HELiOS article master are to be synchronized upon each saving in HiCAD.

1.) Auto-sync product structure upon saving:

Go to PDM > HiCAD-HELiOS interface > Product structure and activate the Synchronize product structure
upon saving checkbox:

After this, any changes to the product structure will be automatically transferred to HELiOS after each saving in
HiCAD. This spares you the additional step of a manual transfer.
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2.) Auto-sync part attributes and article master data:

In the Configuration Editor, go to System settings > HELiOS and activate the Transfer part attributes to HELiOS:

Changes to article master-relevant part attributes, will then be automatically taken over to HELiOS upon each sav-
ing in HiCAD.

Please note:

Choose Drawing > Itemisation/Detailing > Attr. > Article master sync when saving to specify which
part attributes are to be synchronized with which article master data.
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New dialogue for unlocking of HELiOS objects
For unlocking of objects that are currently edited by other instances, the "ReleasedNext" tool was used in previous
versions. This tool has now been replaced with a revised, integrated dialogue window that opens after starting
HELiOS (or HiCAD) if such objects have been found.
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Excel BOM with bar optimisation
Similar to the Excel BOM output from HiCAD, a new BOM template called PRODUCT_ISD_HiCAD is now available,
which allows the output of bar optimisations for BOM exports via product structure.

Pre-mounted assemblies in BOMs
When working with pre-mounted assemblies in practice, you sometimes want only the assemblies, but not their
sub-parts to be shown in BOMs. This can be achieved via the article attribute COMPONENT_PREINSTALLED,
which needs to be assigned to the article master of the pre-mounted assembly.

To ensure that the attribute will be shown in the HELiOS article data mask, you need to adjust the masks in HELiOS
with the Mask Editor accordingly; that is, you need to add the COMPONENT_PREINSTALLED attribute as a new
data field and, in so doing, create a new checkbox. If this checkbox is activated in the article master of an
assembly, this assembly will be regarded as a "pre-mounted" assembly.
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Loading of the current article master of semi-finished products in attached parts
In previous versions, existing article masters of semi-finished products were not transferred to HiCAD when insert-
ing attached parts such as Steel Engineering connections, stairs, railings, element installations, profile installations
etc.

From HiCAD 2019 onwards this behaviour can be changed via a setting in the Configuration Editor: At PDM >
HiCAD-HELiOS Interface you can find the parameter Add semi-finished product article when loading. The ISD
default setting is No, i.e. the article master of semi-finished products will not be transferred.

For example, when transferring article masters of semi-finished products from user-defined catalogues, set the
parameter to Yes.
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HELiOS Spooler

Service Pack 2 (V 2402)

Model area of AutoCAD drawings
When printing AutoCAD drawings (older versions) the model area of the drawing can be printed automatically if the
layout area is empty.

You can configure this behaviour via the configuration file AddIn.AutoCad.Config.xml (this file will be automatically
updated to the new configuration format by the Spooler).

Please also read the information given in the Notes on File Conversion via the Spooler topic.

Configurable restart of CAD application
In previous versions, the appropriate CAD applications were restarted for each print or conversion job. This beha-
viour can now be configured, resulting in shorter processing times and a faster printing of the desired printout or file.
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Service Pack 1 2019 (V 2401)

Combining of different PDFs into one document
The HELiOS Print Client now contains a new option for the Postprocessing of print jobs, which allows you to com-
bine individual PDF pages into one document during automated print job processing.

Pausing the Spooler
You can now pause and continue the Spooler, either interactively via the Admin Tool or via command prompt. New
jobs will also be accepted while the Spooler is pausing (however they will not be processed during that period - their
processing starts as soon as the Spooler is continued again).

The control via command prompt can be used for a time-controlled pausing and continuation of the Spooler, e.g.
via Windows task planning.
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Major Release 2019 (V 2400)

Inventor: Export of image formats and optional database connection
Image formats such as JPEG or BMP can now also be (automatically) output from Autodesk Inventor via the
HELiOS Spooler by means of suitable conversion jobs.

To be able to use the new attribute mapping for the filling in of title blocks in Inventor during the output via Spooler,
you have also the option to configure a database connection for the HELiOS Spooler.
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HELiOS MS Office Interface

Service Pack 2 (V 2402)

Model structure: Display of document structure
If only a document structure instead of a model structure is available for a document, the HELiOS-MS Office /Excel)
interface displays the document structure, according to the document master data, on the Model structure tab.
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Documents in the Workspace
The HELiOS Workspace window is now available in both the HELiOS Desktop and in the CAD or MS Office inter-
faces.

Irrespective of all filter options you can apply, the following rules apply for the display behaviour:

All documents that have been opened/loaded in the active application will be displayed, as well as all non-loaded
documents that have been saved to the application with which the documents were originally created.

This means: As soon as a document is opened in an interfaced application, the corresponding Workspace will mem-
orize this until the document will be removed from the Workspace again. The corresponding document will there-
fore be constantly displayed in the Workspace, also after closing and restarting the application.

When opening a particular document in two different applications (e.g. a DWG file in AutoCAD and Inventor), the
HELiOSWorkspace memorizes both applications and displays the file in the Workspaces of both applications.

Also, the following rule applies: For an Inventor assembly that references an Excel document, both the Inventor doc-
uments and the Excel file will be displayed in the Workspace after opening the assembly in Inventor. If the Excel file
has previously been saved in the Office application (setting the document attribute "Related application" (HEL_
APPLICATION) accordingly), this file will be additionally visible in the Workspace of Excel, even if it has not been
explicitly loaded in this application by the user.

An exception to this rule is the Workspace of the HELiOS Desktop that always displays all documents.
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Service Pack 1 2019 (V 2400)

Office 2019 and support of multiple versions
HELiOS 2019 SP1 supports offers an interface to MS Office 2019.
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